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Important note:
An ARGUS basic package contains at least one VDSL and SHDSL interface, which 
includes a variety of functions and tests. All other interfaces and functions are  
available as options (see datasheet). Therefore, depending on the scope of function  
supplied, individual menu options may be hidden.
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1 Introduction
1 Introduction

The all-in-one instrument 
The ARGUS 166 combines all standard broadband interfaces (G.fast, xDSL, GPON, LTE) 
and fast Gigabit Ethernet interfaces with comprehensive Triple Play test functions in one 
measurement device. Without having to swap modules, the user can select or change the 
interface via the intuitive menu and perform tests at the push of a button. 
The ARGUS 166 supports this with, amongst other things, two SFP slots and a copper-
based Gigabit Ethernet interface. Thanks to the various Gigabit Ethernet SFPs, the tester 
offers the greatest possible compatibility for connection to fiber-based interfaces. It is thus 
possible to carry out Triple Play and performance tests directly on FTTx or GigE 
components via the GigE interface (copper or fiber).

Performance testing 
Using a loop function and a traffic generator, the user can analyze the capacity of Ethernet 
segments or devices at full wire-speed (1 Gbit/s). Throughput tests in accordance with RFC 
2544 are thus also possible. For HTTP and FTP downloads the interfaces can reach 
speeds of mulitple 100 Mbit/s.

Parallel Triple Play tests 
Optionally, Triple Play test functions can be added to the ARGUS 166, too. In this way, 
IPTV quality of service can also be checked by means of STB emulation and VoD testing 
and channel scanning. Data services and VoIP (incl. MOS) can be tested via the xDSL and 
Gigabit Ethernet interfaces. Optionally, several of these IP tests can also be carried out via 
the more powerful IPv6 protocol. 
Additionally, the well-known ARGUS test features are available for testing directly on ISDN 
BRI S/T/U, PRI/E1 and POTS accesses.
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1 Introduction
Overview of key ARGUS functions:

G.fast and xDSL interfaces (ADSL, ADSL2, ADSL2+, VDSL2, VDSL2 profile 35b, 
SHDSL, G.fast)
- Synchronisation with DSLAM (xTU-C) and determination of all relevant 

connection parameters and error counters
- Bridge, router and terminal-device modes, via IPv4 and IPv6
- SHDSL-DSLAM simulation (STU-C)
Ethernet interfaces
- 2 Gigabit Ethernet test interfaces (10/100/1000 Base-T)
- Ethernet tests with up to1 Gbit/s (loop, traffic generator, RFC2544, ...), see 

Gigabit Ethernet manual
LTE extension incl. LTE scanner and data tests
SFP slots
- 2 SFP slots for fiber-based interfaces (Ethernet and FTTx)
IP tests via xDSL and Ethernet
- IP tests

- Ping and traceroute tests (BRAS information, PPP trace, VLAN), via IPv4 and IPv6

- Download tests for measuring throughput (HTTP-download, FTP-up/download)

- FTP server test, up/download from ARGUS to ARGUS

- Parallel testing of multiple services (VoIP, IPTV, Data)

- VoIP test
- VoIP terminal device simulation, including acoustics (var. codecs), via IPv4 and IPv6

- OK/FAIL assessment of VoIP speech quality (QoS) according to: 
- MOSCQE (ITU-T P.800), E-model (ITU-T G.107)

- IPTV tests
- Stream request (STB mode), IPTV channel scan, IPTV passive

- OK/FAIL assessment and display of quality parameters

ISDN functions (PRI/E1 see extra manual)
- U-interface (4B3T or 2B1Q) according to ANSI T1.601

- PRI/E1 interface according to ITU-T I.430/431 in TE and NT operation

- D-channel monitoring via BRI and PRI interface

- Testing of BRI and PRI fixed lines (E1, 2 Mbit/s)

- E1-BERT via all B-channels simultaneously (MegaBERT)

- Automatic service and service-feature tests, and much more
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1 Introduction
Note: 
Detailed explanations regarding Gigabit-Ethernet tests, PRI/E1 and Copper Box 
may be found in the separate documentation for the respective device. 
You should receive these together with your equipment. You can also download 
the latest manuals at http://www.argus.info/en/service/downloads, or simply 
contact our Service Department:

intec Gesellschaft für Informationstechnik mbH
Rahmedestr. 90

D-58507 Lüdenscheid
Tel.: +49 (0) 2351 / 9070-0

Fax: +49 (0) 2351 / 9070-70
www.argus.info/en

support@argus.info

POTS functions
- Fully functional integrated analogue handset (POTS)

- With DTMF and CLIP display, pulse dialling

- High-ohm 2-wire monitor with voltage measurement

Copper test (Cu test) functions
- Line Scope: High-performance realtime Line Scope with display in time and  

frequency range (FFT) up to 35 MHz

- TDR: Time domain reflectometer to measure line lengths and locate faults

Copper Box: expansion of the ARGUS copper test function, see ARGUS Copper Box 
manual

Documentation and Analysis
- Documentation of all parameters recorded to test reports (in device and on PC) via 

automatic access tests

- Transfer of test results via QR code to a smartphone

- Update Tool to carry out FW updates for free 

- WINplus PC software for generating, saving, archiving and printing test reports and for 
configuring the ARGUS®

- WINanalyse PC software for analysis (including WINplus) ISDN D channel clear text 
decoding for protocol analysis

- WLAN extension for transferring test results to systems of an electronic order 
processing system, acces point mode (browsing, download) and remote control via 
smartphone
ARGUS 166 9



2 Safety information
2 Safety information

ARGUS may only be operated using the accessories supplied with the device. The use of 
other accessories can result in faulty measurements or even damage to ARGUS and the 
connected equipment. Only use ARGUS according to the instructions contained in this 
accompanying document. Use in any other manner can cause harm to persons or destroy 
your ARGUS.

- Before connecting ARGUS to an access, make sure that no dangerous 
voltages or voltages for which ARGUS and its accessories are not specified 
are present. Also keep in mind that the voltage can change over the time that 
the device is connected.

- Use ARGUS only according to its intended purpose at all interfaces and local 
loops.

- Voltages over 50 V AC and 120 V DC can cause death.
- Never conduct measurements without the battery pack!
- ARGUS is not waterproof. Therefore, protect ARGUS against water 

penetration.
- Before replacing the battery pack, disconnect the power adapter and all 

measuring leads and power ARGUS down. 
ATTENTION: Never remove the battery pack during operation.

- Remove the power adapter from the mains socket as soon as ARGUS is 
switched off or no longer in use (e.g.after charging the battery pack)!

- ARGUS may only be used by trained personnel.
- ARGUS may only be operated using the power adapter supplied with the 

device. 
- Only manufacturer-approved headsets may be connected to the headset 

socket; any other use of this socket (e.g. connection to a home entertainment 
system) is expressly prohibited.

- Only the Active Probe II, the ARGUS Copper Box and the other 
manufacturer-approved USB devices without mains connection may be 
connected to the USB host interface (USB-A). Any other use (e.g. connection 
to a PC) is expressly prohibited.

- If external USB devices are used on the USB-host interface (USB-A), no 
warranty is assumed for occurrences outside the mechanical wear of normal 
plug-in.

- In battery power mode, always cover the ARGUS power socket with the 
supplied rubber protective cap labelled "Power".

- Only use the SFP slots for SFP types explicitly approved by intec GmbH. 
Never insert other objects or SFP modules into the SFP slots.

- When the SFP slots are not in use, always make sure that they are sealed 
using the supplied protective covers.
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2 Safety information
- When using the SFP slots and SFP modules, always be sure to observe 
normal cleanliness.

- When using SFP modules, always be sure to observe the module 
manufacturer's safety information and use them only for their intended 
purpose.

- The most common SFP modules approved for ARGUS are class-1 laser 
products.  
Generally, the use of class-1 laser products does not require any special 
protection measures. 
However, for your own safety please note the following: 
 - Always cover the ends of the glass fibers or the SFP module when  
   disconnecting. 
 - Always avoid direct eye contact with the emitted laser light. Vision aids and  
   long exposure times can make even low light doses extremely dangerous. 
 - The equipment may only be used by trained personnel.

- The electromagnetic compatibility (EMC) has been tested according to the 
regulations specified in our conformity declaration. 
ARGUS is a class A device. This device can cause radio interference in 
residential areas. In this case, the user may be required to implement 
appropriate measures.

- Active charging of the battery pack and automatic charging (on by default) 
may only be carried out in a temperature range of 0 °C to +40 °C.

- The device may not be used during thunderstorms.
- If ARGUS is operated under extreme conditions, it can be set to energy-

saving mode to protect the device and the user; this can interrupt the running 
test and drop the connection.  
To ensure dependable extended operation of ARGUS, always make sure that 
it is optimally protected against high temperatures.

- The device may not be opened.
- Please observe the following safety and transport information when using the 

lithium-ion battery pack.
- Before starting a test or synchronising on an interface, determine how you 

want to supply power to ARGUS (battery pack or power adapter). The car 
adapter is only for charging the device. When ARGUS is connected to this 
adapter, you should not run any tests or synchronise on a DSL interface.

- ARGUS contains extremely sensitive electronic components. Depending on 
the operating mode selected, an electronic discharge from the user can, in 
rare cases, result in impairment of device function. The user may need to 
restart the impaired test or function.
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2 Safety information
Return and environmentally compatible disposal
Currently applicable environmental legislation restricts the use of certain hazardous 
substances in electrical and electronic devices, particularly the concentration respectively 
use of lead (Pb), cadmium (Cd), mercury (Hg), hexavalent chromium [Cr(VI)], 
polybrominated biphenyls (PBB) and polybrominated diphenyl ethers (PBDE). 
 
We hereby affirm on the basis of the assurances, designations and documentation of our 
suppliers that all our ARGUS-brand measurement technology products are free of 
substances in concentrations, preparations or applications whose market release is 
prohibited pursuant to the applicable requirements of the RoHS Directive 2011/65/EU of the 
European Parliament and Council dated 8 June 2011. Our EAR registration number is: 
WEEE reg. no. DE 92829367. 
 
Since October 2005, we have been marking all our measuring devices with this symbol, in 
compliance with WEEE 2002/96/EC and the corresponding German statute ElektroG: 

 ( (DIN EN 50419). 

In other words, ARGUS and its accessories, may not be disposed of as household waste. 
Please consult with our Service department with respect to the return of old devices. 
12 ARGUS 166



2 Safety information
2.1 Safety and transport information for the battery pack

Transport
The battery pack has been tested according to the UN directive(ST/SG/AC.10/11/Rev. 4, 
part III., subchapter 38.3). Protective functions have been implemented to guard against 
short-circuit, destruction and dangerous reverse currents. As the battery pack contains a 
lithium quantity below current thresholds, it is not subject to international regulations  
governing hazardous materials either as an individual part or mounted in ARGUS. When 
transporting multiple battery packs, however, you may also need to observe this safety 
information. Further information is available on request. 

Failure to observe the following danger and warning information can impair 
the protective functions of the battery pack. This can cause extremely high 
voltages and currents which can in turn result in abnormal chemical 
reactions, acid leaks, overheating, smoke, explosion and/or fire. Additionally, 
failure to observe this information can negatively impact both the 
performance capacity and the performance duration.
 

Hazard information and warnings
1. Do not disassemble or short-circuit the battery pack.
2. Do not through the battery pack into fire or overheat it (> 60 °C).
3. The battery pack must not become wet or damp.
4. Active charging of the battery pack and automatic charging (on by default) may 

only be carried out in a temperature range of 0 °C to +40 °C.  
To maximise battery life, do not store the battery long-term at temperatures above 
+50 °C.

5. The battery pack may only be charged using the corresponding ARGUS device or 
an approved charger.

6. Do not puncture the battery pack with a sharp object.
7. Do not throw the battery pack or expose it to shocks. 
8. Do not use battery packs that have become damaged or deformed.
9. The battery pack contacts have a specific polarity and may not be inserted in 

ARGUS or a charging device with reverse polarity. 
10. Only connect the battery pack to the corresponding ARGUS or charger in the 

intended manner.
11. The battery pack may not be directly connected to electrical outputs such as 

power adapters, car adapters etc.
12. Only use the battery pack with ARGUS.
13. Do not attach, transport or store the battery pack together with metallic objects.
14. Do not expose the battery pack to electrostatic charges.
15. The battery pack may not be charged or discharged together with primary 

batteries or other battery packs.
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2 Safety information
16. If the battery pack fails to charge by the end of the charging time, it can no longer 
be recharged.

17. Do not expose the battery pack to excessive pressure.
18. If the battery pack emits odours or heat, becomes discoloured or deformed or 

otherwise appears different from normal during operation, charging or storage, 
immediately remove the battery pack from the device and never use it again.

19. In the event that acid leaks and comes in contact with eyes or skin, wash 
immediately with clean water. Do not rub. In both cases, seek medical attention 
immediately. Otherwise, permanent injury may occur.

20. Keep the battery pack away from children.
21. Read this manual and the corresponding safety information carefully before using 

the battery pack.
22. If odours, rust or other abnormalities are detected before the first use, contact 

intec GmbH to clarify the next steps.
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3 General technical data
3 General technical data

ARGUS user safety tested according to  EN60950-1
RoHS conformity pursuant to the WEEE directive
The electromagnetic compatibility (EMC) was tested according 
to the regulations specified in our declaration of conformity.
CE marking
ARGUS 166 complies with EC directives 2004/108/EC and 
2009/C197/03. We will be happy to provide a detailed 
declaration of conformity on request

Device specifications

Dimensions/weight Inputs/outputs

Height: 254 mm  
Width: 99 mm  
Depth: 73 mm 
Weight: approx. 920 g 
(2.03 lbs) 
(incl. battery pack) 

- RJ-45 (BRI/PRI/E1) for BRI and PRI  
- RJ-45 (Line) for xDSL, POTS, U-interface and  
  Copper tests 
- 2x Ethernet 10/100/1000 Base-T 
- 2x USB-A socket, USB-host interface 
- 2x SFP slots 
- USB-B socket, USB client interface 
- Headset input

Control panel

25 keys

LCD display Temperature range

LCD colour display with 
switchable background 
illumination 320 x 240 
pixels

Temperature range for charging battery pack: 0 °C to +40 °C 
Operating temperature (in battery mode): -10 °C to +50 °C 
Operating temperature (with power/car adapter): 0 °C to +40 °C 
Storage temperature: -20 °C to +60 °C 
Humidity: up to 95 % rel. humidity, non-condensing

Power supply

Lithium ion battery pack with 7.2 V rated voltage (observe the 
safety information) or 12 V/1.5 A ARGUS power adapter

Miscellaneous
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3 General technical data
Supported standards

8a, 8b, 8c, 8d, 12a, 12b, 17a, 30a, 35b 
ITU-T G.998.4 (G.INP, Retransmission)

G.fast (Line):
ITU-T G.9700/9701 (Profil 106a)

ADSL (Line): 
ITU-T G.992.1, Annex A (ADSL) 
ITU-T G.992.2, Annex A (G.lite) 
ITU-T G.992.3, Annex A (ADSL2) 
ITU-T G.992.5, Annex A (ADSL2+) 
ITU-T G.992.1, Annex B (ADSL) 
ITU-T G.992.3, Annex B (ADSL2) 
ITU-T G.992.5, Annex B (ADSL2+) 
ITU-T G.992.5, Annex J (ADSL2+)
ITU-T G.992.3, Annex L  
 (RE-ADSL2 via analogue) 
ITU-T G.992.3, Annex L  
 (RE-Narrow PSD ADSL2 via POTS) 
ITU-T G.992.3, Annex M (ADSL2) 
ITU-T G.992.5, Annex M (ADSL2+)

VDSL (Line): 
ITU-T G.993.2 (VDSL2) 
ITU-T G.993.5, G.vector (vectoring)
ITU-T G.998.2, G.bond (Bonding)
ITU-T G.993.2, Annex Q (Super Vectoring)
Profiles

ISDN-BRI/PRI (BRI/PRI/E1): 
ITU-T I.430 
ITU-T I.431 
ITU-T G.821 
ITU-T X.31 

ISDN U-interface (Line): 
ANSI T1.601

 
Dielectric strength: 
 

 
Line:
DC: max. +200 V
AC: max. +100 Vpp (Copper tests only)
DC: max. +200 V (xDSL) 
DC: max. +130 V (for POTS) 
DC: max. +145 V (for U-interface) 

BRI/PRI/E1:
DC: max. +48 V

DC voltage measurements:
- Accuracy:  ±2 %

SHDSL (Line): 
ITU-T G.991.2, Annex A (G.SHDSL) 
ITU-T G.991.2, Annex B (G.SHDSL) 
ITU-T G.991.2, Annex F (G.SHDSL.bis) 
ITU-T G.991.2, Annex G (G.SHDSL.bis) 
ETSI TS 101 524 V 1.2.1 (ETSI SDSL) 
ETSI TS 101 524 V 1.2.2 (E.SDSL.bis) 
IEEE 802.3.ah (EFM) 
ITU-T G.994.1 (G.hs)

Ethernet (LAN/SFP): 
IEEE 802.3   
- 10 Base-T  
- 100 Base-T
- 1000 Base-T 
- SFP (MSA)
Autonegotiation
Auto-MDI(X)
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4 Quick-start guide
4 Quick-start guide

LEDs

Softkeys

Cursor keys

Enter key

Level key

 

Telephony: Answer/hang up

Power

Microphone Belt clip

Number block

LC display

Back key

Shift key

Loudspeaker

Power key

- 
- 
- 
 
 
- 
 
- 

Switches on ARGUS 
Reactivation after power-down (adjustable, see page 306) 
Switches on display illumination (also possible with any other key). In 
battery mode, the display illumination switches off automatically after an 
interval that can be set in ARGUS (see page 306). 
You can open the ARGUS Manager from any point in the menu (press 
briefly). Return from the ARGUS Manager to the original menu. 
Switches off ARGUS (key must be held down): after an adjustable 
interval (e.g. after 10 minutes), ARGUS automatically shuts down in 
battery mode (see page 306). 

Enter key

- 
- 
- 
-

Opens menu 
Switches to next display 
Starts/opens test 
Accepts setting
ARGUS 166 17



4 Quick-start guide
Back key

- 
 
- 
- 
-

Switches ARGUS back to the previous display without saving current 
entries, e.g. changes in a configuration parameter 
Cancels tests 
Exits graphic displays 
Switches to main menu after powering up

Cursor keys

- 
- 
- 
 
- 
- 
- 
-

Browses display lines page by page (vertical cursor keys) 
Cursor movement within a display line (horizontal cursor keys) 
Within selection lists or statistics, the horizontal cursor keys can be used 
to scroll through pages 
Select a menu, a function or a test 
Set wire types during the TDR 
Move display cursor in graphic displays 
Select functions in graphic status screen

Telephony

ISDN and POTS

- 
-

Answers and hangs up 
Simplified single call: press the handset key twice (ISDN only) 

G.fast, xDSL (access mode xTU-R, xTU-R Router) and Ethernet 

- Starts VoIP telephony

 Level key

- 
- 
 
- 
- 
-

Opens the graphic status screen 
BRI, PRI, U-interface access: starts single-layer measurement (level/
voltage) 
G.fast and xDSL access: displays results 
Ethernet: opens results 
Start/stop function for realtime analyses (Line Scope / TDR)

Number block

- 
- 
 
 
 

Entry of numerals 0 through 9, letters and special characters 
Direct function call, depending on the selected access (hot key), e.g. 
page 315 et seq. 
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4 Quick-start guide
ARGUS is mainly controlled using the four cursor keys, the Enter key , the Back key 

, the Level key  and the three softkeys. 

The bottom line of the display shows the current softkey assignments. 

In the following pages of this manual, only the respective currently valid softkey function is 

displayed in angle brackets < > , e.g. <Menu>. The softkey < > performs the same  

function as the Enter key  .

Softkeys

- 
 
 
 

- 

The function of the three softkeys depends on the respective situation. 
The currently assigned function appears in the bottom line of the display 
in the form of three blue fields with white letters, e.g.: 
<Menu>: opens main menu 
<Start>: establishes a connection or starts a test 
 
Other softkeys are described in the corresponding chapters of this 
manual.

Shift key

In some menus, a green "S" in a green circle appears in the top line of the 
display. 
In these menus, the softkeys are assigned two functions. The Shift key 
toggles the softkey assignment (see example page 209).

Example:
Press Shift to change  
the softkey assignment.
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4 Quick-start guide
Top connections 
PWR
For external power adapter. 
When the external power adapter is connected, 
ARGUS switches off the battery power supply.  

USB-A or USB-A 1/2
USB-host interface  
(Active Probe II, Copper Box, WLAN, LTE)

ARGUS checks regularly if there are 
any USB devices connected. 

USB-B (mini-USB)
USB-client interface (PC connection)

  Headset socket

Using the ARGUS socket cover with the rubber protective sleeve

 First fit the rubber protective sleeve, then 
insert the socket cover in the two 
recesses in the sleeve provided for that 
purpose.  
The socket cover does not completely 
protect ARGUS against water or dirt 
penetration. 
 
Open or remove the cover when using 
the device continuously over longer 
periods to prevent internal heat build-up. 
 
Disconnect all connected devices before 
using the socket cover.
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Bottom connections
 
Yellow Link/Data LED: 
signals physical connection with another 
Ethernet port
- LED steadily illuminated:  

connecting
- Flashing LED: transmitting/

receiving 

 
BRI/PRI/E1
Access BRI  
Access PRI 

Pin assignment: 3/6, 4/51 

Pin assignment: 1/8, 2/71

Line
Access POTS  
Access U-interface  
Access G.fast 
Access xDSL  
SHDSL n-wire 
 
Access Copper 

Pin assignment: 4/5 
Pin assignment: 4/51 

Pin assignment: 4/5 
Pin assignment: 4/5 
Pin assignment: fixed 4/5  
variable 3/6, 1/2, 7/8 
Pin assignment: 4/5 

LAN1 and LAN2 
Connection to a PC network card. 
Connection to the Ethernet interface of an xDSL 
modem, router (IAD) or hub/switch or another 
Ethernet interface (access: Ethernet). 

SFP1 and SFP2
Connection of selected SFP modules from various 
manufacturers, for accessing fiber-based interfaces 
(Ethernet, FTTx/GPON). 
 
SFP2 is optional and must be enabled separately. 
Therefore, always use SFP1 for single-port 
applications.

The green Speed LED and yellow Link/
Data LED indicate transmission speed 
- LED on: 10/100 Base-T 

Green Speed LED indicates transmission 
speed
- LED on: 10/100/1000 Base-T
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Charging the battery in initial operation

The battery pack compartment is on the rear of the device. Attach the battery back by 
placing it against the retaining points at the top end and then screwing down the knurled 
screw. Use only the battery pack supplied with the device. Observe the safety information 
given on page 13. Now connect your (switched-off) ARGUS to the external power supply 
supplied with the device. 

Switch on ARGUS using the  key. The following display appears (you may first need to 

acknowledge warnings or messages with <Continue>):

 

You must first change the battery pack supplied with the device completely (see page 313 
Status) before full capacity is reached.

Current assignment of the softkeys.

 Press

ARGUS indicates in the display when 
the battery is completely charged. 

 Press: ends charging.

The Accesses display can vary 
depending on the configuration.

Selected 
menu option 

Menu name
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Power-saving mode

In battery mode, ARGUS automatically switches off after five minutes of no activity 
(interval adjustable, see page 306). ARGUS does not switch off during a test e.g.  
(Loopbox) or in trace mode.

The device can alternatively be operated using the supplied external adapter. When the 
adapter is connected, power supply via the battery is automatically switched off. ARGUS 
must always be operated with the battery, regardless of the power supply type. This 
ensures e.g. uninterrupted operation of the real-time clock.

Unplug the adapter from the mains as soon as ARGUS is switched off and 

no longer in use (battery charging).
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5 Configuring accesses
5 Configuring accesses

 Switch on ARGUS.

Continued on 
next page

After powering up, ARGUS displays all 
configured accesses (up to 100). By 
default, one access is preconfigured for 
every interface type (ADSL, VDSL, ...). 
When changing accesses, the last access 
used is indicated on the display with .
ARGUS additionally displays a preview of 
the selected access settings, see also 
page 30. The preview window opens after 

2 seconds.
<New>

<Edit>

With the <Filter> softkey, ARGUS lets 
you filter all pre-configured accesses 
according to access type (xDSL, ADSL, 
VDSL, ...) and displays this group. 

In this example, VDSL is selected.

All relevant accesses are displayed in 
which VDSL is specified in the confi- 
guration.

The status line (above the softkey)  
displays either the date, time, version and 
battery level after power-up, or the access 
“still” selected after changing accesses..

<All>

<Edit>

Creates an access, see 
page 26, Fig. 2.

Edits an access, see page 26, 
Fig. 1.

Toggles softkey assignment, 
see page 34.

Switches to main menu.

Display of all possible accesses, 
see Fig. 1.

Edits the selected access profile.
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5.1 Access wizard

Continued on 
next page

ARGUS switches to the "Accesses" main 
menu.

You can now configure the selected 
access, here VDSL TE VLAN 7/8, using 
the access wizard.

The query parameters of the access  
wizard depend on the selected access 
(ADSL, VDSL, ...), see page 30.

Selection of physical interface (here 
VDSL).
- For xDSL and G.fast, see page 41.
- For Ethernet, see page 90 and Gigabit- 
  Ethernet Manual. 
- For BRI, see BRI Manual.
- For POTS, see page 246.
- For Copper tests, see page 252 and  
  ARGUS Copper Box Manual.

Selection of number of wire pairs. 
For normal VDSL accesses, a 2-wire  
connection (copper twisted pair) is used, 
for VDSL bonding accesses, a 4-wire 
access is used.
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Continued on 
next page

ARGUS switches directly to the access 
mode settings.

Selection of  access mode (here VDSL 
VTU-R terminal) device).
- For xTU-R TE, see page 56.
- For xTU-R bridge, see page 85.
- For xTU-R router, see page 87. 
- For 2 port access, see GigE Manual.
- For STU-C, see page 89.

You can now link your configured 
access settings with one of 20 profiles. 
These profiles link the access settings 
with the access and test parameters. You 
can define service, virtual line and other 
parameters. 
The selected profile is highlighted in the 
display in blue. The default profile is  
indicated with a  in the display.
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Continued on 
next page

Once you have selected the profile, 
ARGUS suggests an access name, based 
on the settings you made previously (here 
VDSL TE VLAN 7/8). You can enter up  
to 24 characters (in this example 16/24 
characters). 

ARGUS displays a summary of the  
configuration.

<Delete> Deletes access name.

 
Clears mark and returns cursor 
keys to the start.

 
Clears mark and returns cursor 
keys to the end.

<Ab>AB> Entry begins with upper-case 
letters and continues in lower-
case.

<AB>12> Entry of upper-case letters.

<12>ab> Entry of numbers.

<ab>AB> Entry of lower-case letters.

Entry of special characters, 
e.g. @, /, -, ., *, ?, %, =, &, ! 
etc.

Entry of special characters  
e.g. _, :, +, # etc.

<Phys. 
param.>

Edits the physical 
parameters, see page 43.

<Notice> Entry of notices, see 
page 37.

Save and exit the wizard.

Go back one level.
28 ARGUS 166



5 Configuring accesses
2x

ARGUS returns to the editing overview of 
the selected access (here VDSL TE VLAN 
7/8).
To configure the services or test para-
meters, select "Profile"; see also page 35.
You need to exit the access wizard before 

ARGUS can use the configured access.

Press OK to confirm the selected access, 
here VDSL.

ARGUS switches to the ARGUS status 
display.  

Exit the access wizard.

Select access.

<Status> Switches to status screen.

<Menu> Switches to main menu.

<Start> Starts the VDSL connection.
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ARGUS access wizard
The access wizard prompts for different information depending on the access/interface. 
Each parameter queried depends on the respective previous parameters (from left to right).

Access/
interface

Sync 
sequence

Line 
(PIN, 

only LTE)

Mode Access mode L2 
mode

Ether-
net 

interface

Pro-
file

xDSL 1. VDSL
2.ADSL

- Annex A
Annex B

xTU-R TE
xTU-R bridge
xTU-R router
2 port access

- LAN 1,2
SFP 1

Profile

ADSL - - Annex A
Annex B

...

ATU-R TE,
ATU-R bridge,
ATU-R router,
2 port access

- LAN 1,2 
SFP 1

Profile

VDSL - 2-wire
4-wire

(P1 + P2)

- VTU-R TE,
VTU-R bridge,
VTU-R router,
2 port access

- LAN 1,2 
SFP 1

Profile

SHDSL - 2-, 4-, 
6-, 8-wire

ATM,EFM,
TDM, ITC,

HDLC, 
ATM/EFM 
automatic

STU-R, STU-C,
STU-R bridge,
STU-R router,
STU-C bridge, 
2 port access

- LAN 1,2 
SFP 1

Profile

G.fast - - - FTU-R TE
FTU-R bridge
FTU-R router

- - Profile

Ethernet - LAN 1, 2
SFP 1

- IP based,
Cable test*2,

2 port access*2

- - Profile

LTE - PIN - - - - Profile
BRI - - - TE, NT, 

Leased line,
Monitor

Auto.*1,
P-P, 

P-MP

- -

U-interface - - - TE, 
Leased line

Auto.*1,
P-P, 

P-MP

- -

PRI - - - TE, NT, 
Leased line, 

Monitor

- - -

POTS - - - Terminal,
Monitor

- - -

Copper 
tests

- - - - - - -

*1 =only for BRI-TE, U-interface-TE    *2 = only for LAN1
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xDSL automatic detection 
For xDSL access, you are prompted for sync sequence. 

 

ADSL mode

For ADSL access, you are prompted for ADSL mode:

Description

Creating a new xDSL access enables to adjust the sync sequence of VDSL and 
ADSL for xDSL automatic detection. 

 
<> The selected access is 
moved down one place in the 
list. 
<> The selected access is 
moved up one place in the list..

Default:  
1. VDSL  
2. ADSL 

Description

Different ASDL modes can be set depending on the variant. The set 
ADSL mode must be compatible with the ATU-C (network side). When 
ADSL auto-modes "Annex A/M auto, Annex B/J auto, Annex A auto, 
Annex B auto and Annex M auto" are selected, ARGUS automatically 
detects and matches the configuration on DSLAM.   
Default: Annex A/M auto
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TC sublayer for SHDSL 
A TC sublayer is queried for the SHDSL access. ARGUS supports the following TC (trans-
mission convergence) sublayers:

Description

ATM Like ADSL, asynchronous transfer mode (ATM) is based on asynchronous time 
multiplexing. The sender and receiver can run at different clock rates so as to 
serve both packet-switched (IP) and circuit-switched data traffic with a single 
transmission technology. ATM enables this by means of an intermediate layer 
with cells of a fixed size (precisely 53 bytes) between the network and data link 
layers. These ATM cells are filled with the incoming data and prioritised with the 
help of the ATM adaptation layer (AAL). Data are transported in AAL5 and speech 
in AAL1 or 2. This ensures that speech is not delayed. Type, duration and other 
transmission information are stored in a 5-byte header, which reduces the 
payload of a cell to 48 bytes. This technology offers a range of advantages thanks 
to its various OAM management functions and AAL adaptation capabilities. 
However, this consumes an overhead. Still, this technology, which enables a 
bandwidth of up to 2.304 Mbit/s via a twisted pair, remains in wide use, though no 
longer rolled out as frequently. It is mainly used for speech and data transmission. 
Default: ATM

EFM Ethernet first mile (EFM) helps to reduce the ATM overhead and results in a 
higher net data rate. EFM allows Ethernet frames to be transmitted directly 
without being bundled in ATM cells, and is specified in IEEE 802.3ah. This 
process exploits the fact that the IP packets received from the network are simply 
passed through along the last mile and distributed to the terminal devices at the 
local loop. EFM forwards the Ethernet frames directly from DSLAM, without 
packing them in smaller ATM cells. This reduces the overhead entailed in 
additionally transmitting headers and in packing and unpacking the frames in ATM 
cells for every data exchange. As the packet-switched data portion is becoming 
ever greater and IP-based speech transmission (VoIP) has reached a high quality 
level, EFM is being increasingly expanded. The main area of application is thus in 
transmission of IP packages and therefore primarily data.

TDM Time division multiplex (TDM)  
If only a single digital permanent circuit, such as an E1 access, must be replaced, 
TDM technology is a natural choice. This time division multiplex process enables 
the available bandwidth to be divided into 64 kbit timeslots, thus providing up to 
36 B-channels simultaneously for telephony. This results from the maximum 
bandwidth of 2.304 Mbit/s that SHDSL can provide. It thus offers four B-channels 
more than a conventional E1 access, without the need for a complete twisted pair. 
The telephony quality via the B-channels is equivalent to that of ISDN. Its main 
area of application is thus speech transmission. TDM is still widely used.
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ITC Independent transmission convergence (ITC) is the name of a special ARGUS 
mode. In this mode, ARGUS attempts to establish a synchronisation – if only 
briefly – independently of the TC sublayer used (ATM, EFM or TDM) by means of 
special commands. Its main purpose is to test whether a specific access is an 
SHDSL access. This mode is not intended for permanent connections or data 
transmission.

HDLC High-level data link control (HDLC) is a unique ARGUS mode that enables 
synchronisation with remote stations (e.g. net-to-net type) of specific 
manufacturers. This mode is not intended for permanent connections or data 
transmission.

ATM/

EFM 

auto-

matic

When ATM/EFM automatic is selected, ARGUS first establishes a 2-wire 
connection and then determines the TC sublayer used with the aid of the received 
signals. Once the TC sublayer is identified, the remaining configured wire pairs 
are connected.
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Sorting the accesses in the access overview

In order to keep frequently used accesses 
readily available, ARGUS allows you to 
arrange the configured accesses in any 
order. 

Switches to softkey assignment.

<Delete>

5.2 Phys. parameters

Edits the physical parameters of the 
selected access (here VDSL TE VLAN  
7/8, see page 43).

The physical parameters can also be 
opened and edited directly when the 
access wizard is finished (see page 30  
Fig. 1).

Press one after 
another 

 and  

Shortcut to access 
selection menu.

<> The selected access is 
moved down one place in 
the list.

<> The selected access is 
moved up one place in the 
list.

Deletes the highlighted 
access.
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5.3 Profile

Continued on 
next page

 
The preconfigured accesses can be linked 
to up to 20 profiles.
These profiles link the access settings 
with the access and test parameters. You 
can set various parameters here including 
those for service and virtual line. 

Select a profile.

ARGUS enables configuration of up to 20 

profiles.

Services page 124 et seq. 
Bridge/router, see page 85. 
Profile name: Enter the name of the 
access, see page 28.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display.

 
Select e.g. Services or Test 
parameters.
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Test parameter settings are 
described starting on page 134.
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5 Configuring accesses

 

5.4 Notices

In the preview, ARGUS shows not only the 
selected access, the xDSL mode and the 
access mode but also a freely editable 
notice (see Fig. 1 page 37).
This note can be up to 49 characters long.

In this example, the note "Using VLAN" is 

selected.

Press OK to save the entered notice.

You can subsequently edit the access 
name as described for the access  
assistant, see page 28.

<Delete> Deletes notice.

 
Clears mark and returns cursor 
keys to the start.

 
Clears mark and returns cursor 
keys to the end.

<Ab>AB> Entry begins with upper-case 
letters and continues in lower-
case.

<AB>12> Entry of upper-case letters.

<12>ab> Entry of numbers.

<ab>AB> Entry of lower-case letters.

Entry of special characters, e.g.
@, /, -, ., *, ?, %, =, &, ! etc.

Entry of special characters  
such as _, :, +, # etc.
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The saved notice is linked with the access 
and is displayed in the preview. 
The preview appears approx. 2 seconds 
after the access is selected.

<Filter>

<New>

<Edit>

Selects access
Switches to ARGUS status, see page 30.

<Status>

<Menu>

<Start>

ARGUS switches to the Filter 
menu, see page 25.

Creates a new access.

Edits access.

Switches to status screen.

Switches to main menu.

Starts the VDSL connection.
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6 Physical layer

The physical layer (layer 1) is shown in the status screen (Fig. 2) with its own graphical 
element (here VDSL). The other elements in the status screen are initially only named.  
This is explained in more detail on page 100 (Virtual Lines) and page 124 (Services).  
The physical layers for the G.fast, ADSL, SHDSL and Ethernet interfaces are presented in 
the same way as for VDSL. The selection of the VDSL access and the access mode  
VTU-R are directly adopted in the status screen. If the defaults are correct, layer 1 
(synchronisation on VDSL) can be established directly on <Start>. The most important 
information such as voltage (U) and modem states (power down) are displayed in the layer-
1 box (blue). To change the VDSL configuration directly, press <Edit>. To change the 
access type directly in the status screen (Fig. 2), press the softkey <Access> or the key 

combination  plus .

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

See page 126 for tests that can be run via layer 1.

Services,  
see 
page 124

Layer 1

Router/bridge  
(only for xTU-R bridge 
and xTU-R router)

Virtual lines 
see 
page 100.

Profile name

Current 
access and 
softkey 
assignment

Press Level key or <Status>

See page 43 See page 25 See page 57

Fig. 2 (example VTU-R router):

Fig. 1

<Edit> Modify VDSL 
configuration

<Access> Access selection
<Start> Synchronise



7 Operation on G.fast and xDSL accesses
7 Operation on G.fast and xDSL accesses

ARGUS supports G.fast and the following DSL interfaces: ADSL, VDSL, SHDSL

ARGUS supports the following access modes: 

The individual DSL tests record and store data (e.g. traces of IP data). It is the 
user's responsibility to comply with the applicable legal requirements.

The line may not carry a DC voltage greater than 200 V DC and should be free of 
AC voltage components.

In principle, the operating temperature range set out in "Technical data" (see 
page 15) applies for SHDSL operation. For ambient temperatures just below  
+50 °C, extended operation in high-performance modes can trigger the 
temperature dependent ARGUS protection functions described in the safety 
information (see page 10).

xTU-R Terminal device mode (Fast/xDSL transceiver unit) see page 56. 
ARGUS is connected to the xDSL access (in front of or behind the 
splitter). ARGUS replaces the modem and PC. 

xTU-R bridge Bridge mode (Fast/xDSL transceiver unit bridge) see page 85. 
ARGUS is connected to the xDSL access and the PC.  
ARGUS replaces the xDSL modem (for SHDSL only ATM and EFM). 

xTU-R router Router mode (Fast/xDSL transceiver unit router) see page 87. 
ARGUS is connected to the xDSL access and the PC. 
ARGUS replaces the xDSL modem and router (for SHDSL only ATM 
and EFM). 

STU-C (STU-C: SHDSL Transceiver Unit-Central Office). 
ARGUS simulates the central office side (DSLAM).
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7.1 Configuring the G.fast and xDSL interface

ARGUS status screen:
Layer-1 box (blue in display) selected.

<Edit> Opens settings

Status screen

Status screen:

Display (from top to bottom)

- Access mode (in this example: VTU-R)

- Previous profile (in this example: profile 1)

- Modem state (in this example: power down)

- DC voltage on the interface

VDSL test not yet started:

Meaning of LED image in display:

Red LED: No test started

Yellow LED: Test started

Green LED: Connected

<Menu> Switches to main menu, see 
menu tree

<Status> Switches to status screen

see page 57

Main menu, see menu tree

Note: accessing functions via number keys/key combinations 
You can call important functions/tests directly using the keys of the ARGUS keypad. You 
can find an overview of these key combinations on page 126.
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7.2 G.fast and xDSL settings
ARGUS stores all relevant settings (e.g. set and limit values) for a test with the accesses. 
Only the relevant settings are applied, depending on the test situation. You can restore the 
default settings at any time (see page 309): 

Setting Description
Phys. parameters:

ADSL:

Rated / 

threshold 

value

Setting  
Bitrate

Entry of the comparison value for the upstream and 
downstream ATM bitrate [kbit/s] using the number keys.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current bitrate is above the set value for an 
active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK".  
Default: d: 0 and u: 0

CRC limit 
value

Sets the max. CRC (cyclic redundancy check) value.   
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Range: 0 to 999,999,999 
Default: far: * and near: * (*=off)

FEC limit value Determines the maximum FEC (forward error correction) 
value.   
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Range: 0 to 999,999,999 
Default: far: * and near: * (*=off)

HEC limit value Determines the maximum HEC (header error correction) 
value.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Range: 0 to 999,999,999 
Default: far: * and near: * (*=off)
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INP/SNRM Determines whether preference is to be given to INP (inpulse noise 
protection) or SNRM (signal-to-noise- ratio margin) when an ADSL 
connection is established. 
Default: Favour DS SNRM

Retrans-

mission 

(G.INP)

When retransmission (G.INP, G.998.4) is used, the downstream of ADSL 
links is protected against pulse noise on layer 1. Delays and packet losses 
are minimised; however, this increases the interleave delay for 
downstream. 
Default: Down- & upstream

 
 

When Retransmission (G.INP) is active, ARGUS shows in the status line a 
„R“ for Retransmission.

 
 

When Retransmission (G.INP) is unlocked but not active, ARGUS shows in 
the status line a „R“ for Retransmission.
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MAC address (line)  
(not available using the access wizard)

Display and selection of the line MAC addresses.  
The first two MAC addresses cannot be manually edited.

1. When the standard MAC address is selected, ARGUS uses its own 
MAC address. 

    Default: Standard MAC address
2. When you select the dynamic MAC address, a different MAC address 

is used each time the device synchronises.
3. You can enter a third MAC address:  

Mark the line and then press <Edit>. 
<Edit> Entry of new MAC address. 

The address is entered in hexadecimal form using the 
number keys and key combinations: *1=A, *2=B,*3=C, 

*4=D, *5=E, *6=F and confirmed with .  

No group MAC addresses may be used. 
Default: 00:00:00:00:00:00
Accepting the address. 
The new address is temporarily saved, and is no longer 
available after powering down.

Press one after 
another 

 and 

Display of ARGUS MAC addresses: 
Line, LAN, SFP, ETH, see also page 315 and following.

The setting “Dynamic MAC address” is active across all interfaces. For 
instance, if the setting for ADSL is changed, this also affects the MAC 
address for VDSL, SHDSL or Ethernet. Dynamic MAC addresses are used 
here as well. The setting “Dynamic MAC address” is saved. 
Every service (see page 124) is connected to the physical layer (see 
page 40) via its own virtual line (see page 100) uses its own MAC address.  
If the setting “Standard MAC address” is used, this is made up as follows: 
Voreinstellung: 00:12:A8:EX:XX:XX 
The first three blocks (00:12:A8) do not change, as these stand for intec 
GmbH. The fourth block (EX) changes depending on the selected interface 
and service, provided that this uses its own virtual line. The final two blocks 
(XX:XX) depend on the device type and serial number.
00:12:A8:E0:XX:XX Data service via Ethernet or GPON 

interface. 
00:12:A8:E1:XX:XX Data service via G.fast or a xDSL 

interface (ADSL, VDSL, SHDSL). 
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00:12:A8:E3:XX:XX VoIP service via Ethernet or G.fast/xDSL 
interface. 

00:12:A8:E4:XX:XX IPTV service via Ethernet or G.fast/xDSL 
interface.

00:12:A8:E5:XX:XX VoD service via Ethernet or G.fast/xDSL 
interface. 

Gratuitous 

ARP

Determines whether Gratuitous ARP (Address Resolution Protocol) is to be 
used.  
When this is set to “on“, ARGUS transmits one ARP message every 60 
seconds unrequested to communicate its MAC address.  
Default: Off

VDSL:

Rated / 

threshold 

value

Setting bitrate Entry of the comparison value for the upstream and 
downstream bitrate [kbit/s] using the number keys.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current bitrate is above the set value for an 
active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Default: d: 0 and u: 0

CRC limit 
value

Sets the max. CRC (cyclic redundancy check) value.   
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Range: 0 to 999,999,999 
Default: far: * and near: * (*=off)

FEC limit value Determines the maximum FEC (forward error correction) 
value.   
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active DSL connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Range: 0 to 999,999,999 
Default: far: * and near: * (*=off)

Firmware Selects the firmware (FW) in the VDSL chipset. 
You can choose between version A, version B and version C. 
Further information is available on request. 
Default: B
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Carrier set The carrier set determines the carrier frequencies that ARGUS uses to  
signal to DSLAM that it is ready to synchronise (ITU G.997.1).  
The carrier generally specifies which sets are to be used.  
You can select the following sets with corresponding upstream tones (inter-
val between tones 4.3125 kHz) in ARGUS:  
 
- A43, tones: 9, 17, 25  
- B43, tones: 37, 45, 53  
- V43, tones: 944, 972, 999  
Default: A43, B43, V43 
 
When multiple sets are selected, ARGUS cyclically transmits the tones of 
the selected sets in parallel.

Vectoring 

mode

Vectoring mode defines how ARGUS behaves when synchronising with 
DSLAM:  
- Non-vectoring (off)  
This is standard VDSL2 with non-vectoring-capable DSL access 
multiplexers (DSLAMs) and modems. However, it can also be used for 
mixed operation with non-vectoring-capable modems on vectoring-capable 
DSLAMs. In such a case, the simulated modem is throttled to the ADSL2+ 
bandwidth (max. 16 Mbit/s). 
- Full vectoring 
Full vectoring operation requires vectoring-capable DSLAMs and modems. 
VDSL2 vectoring is supported when this technology is present at both ends 
of the bundle. 
Default: Full vectoring

Retrans-

mission 

(G.INP)

When retransmission (G.INP, G.998.4) is used, the downstream of VDSL2 
links is protected against pulse noise on layer 1. Delays and packet losses 
are minimised; however, this increases the interleave delay for 
downstream. 
Default: Down- & upstream

 
 

When VDSL Vectoring or Retransmission (G.INP) are active, ARGUS 
shows in the status line a blue highlighted „V“ for Vectoring or „R“ for 
Retransmission. A flashing „R“ signals that retransmissions are occuring.

 
 

When VDSL Vectoring or Retransmission (G.INP=) are unlocked but not 
active, ARGUS shows in the status line a grey highlighted „V“ for Vectoring 
and „R“ for Retransmission.
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Suppress 

profile 30a

Determines whether profile 30a is to be suppressed or not. 
Default: No

MAC address, see page 45.

G.fast:

Rated / 

threshold 

value

Setting  
bitrate

Entry of the comparison value for the upstream and 
downstream bitrate [kbit/s] using the number keys.  
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current bitrate is above the set value for an 
active G.fast connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Default: d: 0 and u: 0

CRC limit 
value

Sets the max. CRC (cyclic redundancy check) value.   
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active G.fast connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Range: 0 to 999,999,999 
Default: far: * and near: * (*=off)

FEC limit value Determines the maximum FEC (forward error correction) 
value.   
ARGUS displays a large green "OK" in the ARGUS status 
screen if the current value is below the set limit value for 
an active G.fast connection and an "OK" for connection 
parameters below the target, otherwise "NOK". 
Range: 0 to 999,999,999 
Default: far: * and near: * (*=off)

MAC-Adresse (see page 45)
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SHDSL:

Spectrum For region 1 (e.g. North America): 
Annex A/F Auto, Annex A SHDSL, Annex F SHDSL.bis (5.7 Mbit/s) 
For region 2 (e.g. Europe): 
Annex B/G Auto, Annex B SHDSL, Annex G SHDSL.bis (5.7 Mbit/s)  
Automatic selection of modulation modes:  
- TC-PAM 16 (SHDSL)  
- TC-PAM 32 (SHDSL.bis) 
Default: Annex B/G auto

Clock/  

framing 

(not for 

ATM + EFM)

The timing relates to the receiving and transmitting directions of a  
connection. The reception and transmission timing are identical for  
synchronous timing and different for plesiochronous timing. Timing  
differences are compensated by means of bit stuffing.  
 - Synchronous  
 - Plesiochronous (for TDM only) 
 - Plesiochronous (NTR) (for TDM only) 
   (the SHDSL timing is derived from the network timing reference) 
Default: plesiochronous

Channel 
selection 

(not for 

ATM + EFM)

Selection of the B and Z channels via the number keys. You can select up 
to 36 B channels and up to 7 Z channels. When you enter * (for the B and Z 
channels), ARGUS automatically detects the channel allocation. 
Maximum selection: 
36 B channels and 1 Z channel 
35 B channels and 7 Z channels 
Minimum selection: 
- 3 B channels 
- 0 Z channels 
Default: * (automatic) 
If an auto mode is selected under Spectrum (see page 49), channel 
selection is also automatic regardless of the settings made here.

Data rate 

(only for 

ATM + EFM)

Sets the data rate in kbit/s 
For SHDSL 
- Range: 192 kbit/s to 2.3 Mbit/s 
- Default: * (automatic) 
For SHDSL.bis (ESHDSL): 
- Range: 768 kbit/s to 5.7 Mbit/s 
- Default: * (automatic) 
If an auto mode is selected under Spectrum (see page 49), data rate 
selection is also automatic regardless of the settings made here.
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Power  
back off

Reduces the transmitting power of the remote station. The set value 
corresponds to the maximum transmitting power. 
Range: 0 dB to 30 dB 
Default: 0 dB

EOC usage The embedded operations channel (EOC) is used to exchange connection-
related and other information.
off: No queries or responses are sent to the remote station.
on (passive): No parameters are displayed at the remote station, as 

only queries are responded to.
on (active): The own performance parameters and those of the 

remote station are displayed, provided that the remote 
station also supports own queries.

Default: on (passive) 
Sync word The sync word identifies the SHDSL frame.  

(cf. ITU-T G.991.2 Chapter: PMS-TC layer functional characteristics). 
To enter the sync word, use the number keys and key combinations *1=A, 

*2=B,*3=C, *4=D, *5=E, *6=F and then confirm with . 

Default: 3F 16 1F 03 3C 0C
Message 

mode

Selects the message mode. The message mode determines initiation of 
the handshake on the STU-R side resp. the response on the part of the 
STU-C (cf. ITU-T G.994.1 Chapter: Transactions, entry in the capability 
list). 
Range: GHS Mode A to GHS Mode D 
Default: GHS mode C

Vendor info 

field

Entry of vendor information in the corresponding transmission field. This 
information is entered in hexadecimal form, see "Sync word". 
Default: 15 35
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Wire pairs 
 

For 2-wire SHDSL, ARGUS always uses the wire pair 4/5 (line 1); for 
SHDSL n-wire, ARGUS always uses the wire pair 4/5 (line 1) plus a further 
wire pair (line) from the list.  
You can change the order of the wire pairs. 
- 2nd wire pair (line 2) for 4-wire  
- 3rd wire pair (line 3) for 6-wire 
- 4th wire pair (line 4) for 8-wire  
Wire pair 4/5 (line 1) is always reserved as the master. 
 

You can mark the 2nd, 3rd and 4th wire pairs (lines 2-4) and move them 
down one slot the list using the left softkey <> or up one slot in the list 

using the right softkey <>. Confirm your entry with .  

The following default is common:  
Line 1: wire pair 4-5 (fixed) 
Line 2: wire pair 3-6 
Line 3: wire pair 1-2 
Line 4: wire pair 7-8

Line  
probing 

(PMMS)

When a connection is being established, line probing (power measurement 
modulation session) can occur; this is standardised according to ITU-T 
G.991.2. This function enables determination of a variety of line parameters 
to identify the possible data rate before the actual synchronisation process 
with the remote station.
Rate-adaptive 
mode

This determines what interference is taken into account in 
the PMM session.  
 - Current SNR DS: current line interference in down 
   stream is taken into account.  
 - Worst case G.991.2 SNR DS: reference line interfer- 
   ence from G.991.2 in downstream is taken into account.  
 - Current SNR US: current line interference in upstream  
   is taken into account. 
 - Worst case G.991.2 SNR US: reference line inter- 
   ference from G.991.2in upstream is taken into account.  
Default: none

<Add> A display with the available modes opens. Any mode 

marked with  in this window is inserted in the list 
(above the mode marked in the list).
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<Delete> Deletes the marked mode from the list
 
Adopts the mode priorities.

Targets SNRm  
in dB 

Destination SNR margins can be set for the above line 
interference.
 - Current up: 0  
 - Current down: 0  
 - Worst-case up: 0  
 - Worst-case down: 0  
Range: -10 dB to 21 dB 
Default: zero for all

Interop 

bits

Line probing The PMM session supports the following remote stations: 
- G.991.2 
- Globespan 
Default: G.991.2

Multiwire  
(only for ATM + 
TDM)

The synchronisation behaviour is matched to the following 
remote stations: 
 - Auto (automatic) 
 - Globespan  
 - G.991.2 
Default: Auto
52 ARGUS 166



7 Operation on G.fast and xDSL accesses
EFM Aggregation Select this setting when ARGUS in  
STU-C mode and the modem in STU-R 
mode do not support the discovery 
operation of the expanded G.hs 
according to IEEE 802.3ah section 4.

Discovery and 
agg.

Select this setting when the discovery 
operation of the expanded G.hs 
according to IEEE 802.3ah section 4 is 
supported.

Default: Discovery and agg.
SRU 
(EFM and 
Independent  
ITC only)

Supports the regeneration unit (SRU) functions of the 
following remote stations: 
 - Off 
 - Elcon Coco10M (only EFM) 
 - Elcon International (only EFM) 
 - Albis BSRU (only for 4-wire Independent TC) 
Default: Off

EOC 
error counter

Depending on the setting here, errors are transmitted 
using the EOC, summed by ARGUS ("absolute") and 
displayed or determined over the corresponding request 
interval ("delta") and displayed. 
Default: Absolute

QD2Lite Determines wheter the protocol uses QD2Lite in EO 
channel or not. 
Default: off

MAC address, see page 45.
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ARGUS in Status screen, in this example 
VDSL router mode is selected. 

<Edit> Open settings

Profiles (<Edit> edit profiles)

Bridge/Router

IP version 

(Bridge + 

Router)

Determines which IP version is to be used.
IPv4: 
IPv6: 
Dual Stack 
IPv4/IPv6: 

Internet Protocol version 4 acc. to RFC 791  
Internet Protocol version 6 acc. to RFC 2460 
If IPv6 is available, this protocol is preferred; if not, 
ARGUS switches to IPv4. 
Default: IPv4

IPv4 

(Bridge + 

Router)

Definition of IP address assignment 
 IP mode: Static IP:  

DHCP server:
Fixed IP address 
Assignment of IP address by ARGUS 
Default: DHCP server 

Own IP  
Address:

Range: Range 0.0.0.0. to 255.255.255.255 
Default: 192.168.10.1 (assignment see RFC 3330)

IP netmask: Range: Range 0.0.0.0. to 255.255.255.255 
Default: 255.255.255.0 (assignment see RFC 3330)  

DHCP server: 
(Bridge + 
Router) 

Settings for the DHCP server: 
- Starting and ending IP address 
  Range: Range 0.0.0.0. to 255.255.255.255 
  Default: (assignment see RFC 3330) 
  Start: 192.168.10.30 
  End: 192.168.10.40 
Domain name 
- Duration of reservation for IP addresses 
  Range: 1 - 99999 seconds 
  Default: 240

Status screen:
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See chapter „9.4 Virtual line settings“ (see page 110) for further configurations.

NAT (only 
Router)

NAT (network address translation) on or off. 
The NAT service automatically and transparently replaces 
address information (e.g. IP addresses of the LAN) with 
other address information (e.g. IP addresses of the WAN). 
Default: NAT on

SIP port (only 
Router)

Port used for incoming SIP signalling.  
Range: 0 to 65535  
Default: 5060

IPv6 (only 

Router)

Firewall Determines whether ARGUS uses a firewall in router 
mode. 
Default: on

Discard prefix Specifies whether ARGUS rejects or uses the address 
prefix (first 64 bits of the IPv6 address, customer/provider-
specific). 
Default: on

VLAN (only 

Bridge)

VLAN  
handling

When VLAN tagging is used, a VLAN tag is attached to 
every outgoing Ethernet frame (from the WAN). The tag is 
removed from every incoming Ethernet frame. In 
transparent VLAN, the Ethernet frames are passed on 
unchanged.  
Default: Transparent

VLAN ID Identifier for the VLAN to which the frame belongs. Every 
VLAN is assigned a unique number, the VLAN ID. A 
device that belongs to the VLAN with ID = 2 can 
communicate with every other device in the same VLAN 
but not with devices in other VLANs. 
Range: from 0 to 4095 
Default: 2

Data log 

(Bridge + 

Router)

Data log on or off  
This function must be set to "on" so that a trace file can be sent to the PC; 
see page 82. After terminating a virtual line (VL) via the corresponding 
service or the physical layer, ARGUS queries whether the trace file should 
be sent to the PC. The mini-USB port must also be connected to the PC.  
For example, when the data log is activated for VL 1, only VL 1 is recorded. 
When one VL is configured for multiple services and the data log is active, 
all data of this VL are recorded. 
Default: off
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7.3 ARGUS in access mode xTU-R

Determining the G.fast and xDSL connection parameters using VDSL as an 
example (procedures also apply for ADSL and SHDSL connections)
ARGUS is connected directly to the VDSL access via the supplied xDSL lead and the 
ARGUS socket line (either in front of or behind the splitter). In this case, ARGUS replaces 
the modem and PC. ARGUS establishes a VDSL connection and determines all relevant 
VDSL connection parameters. ARGUS displays the VDSL connection parameters and, if 
desired, saves them when the link is disconnected.

Use only the patch cable supplied with the device. 

In this example, VDSL VTU-R mode is configured and selected as described in chapter „5 
Configuring accesses“ (see page 25).

 

socket 
Line

VDSL access 
VTU-C (DSLAM)

xDSL cable or patch cable 

The VDSL test has not yet been 
started: red LED in the display! 

Meaning of LED image in display: 
Red LED: no test started

Yellow LED: test started

Green LED: connected

All further functions and 
procedures are explained using 
this status screen.
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Establishing the G.fast and xDSL connection using VDSL as an example
Profile configuration:
ARGUS uses the settings (see page 31) and limit values (see page 43) stored in the 
respective profile for establishing a VDSL connection.

ARGUS in status screen. 
 
 
 
ARGUS uses the default profile (PPP 
VLAN 7/8 in the example) to establish the 
VDSL connection.

Establishing a VDSL connection

ARGUS synchronises with DSLAM (LED 
"Sync/L1" flashes, display shows element 
on yellow background). 
ARGUS displays the current connection 
status (in this example "Initialize") in the 
layer-1 box (blue). 
 
 
While connecting: 
Display: 

<Edit> Edits the VDSL settings and 
MAC address.

<Access> Selects a new access.

- Current connection status

- Time elapsed since start of 
synchronisation in h:min:s.

<Diagnostic> This function is available  
on request. 

Continued on next 
page

or
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y)
 
Display of commands 

 
 
 
 
 
Display timestamp 
 
 
 
 
ARGUS shows the time (internal clock, 
see page 305) at which the commands 
are received. 
 

 

Display the graphical xDSL trace.

Display: 

See page 60 for an explanation of the 
colour code.

< = Command sent by ARGUS

> = Command sent by DSLAM

- = Connection status

Switches to the previous 
display and the status screen.

- Synchronising 

- CRC error in downstream

- CRC error in upstream (ADSL/VDSL onl

- SNR in downstream

- SNR in upstream (ADSL/VDSL only)

- Bitswap events (ADSL/VDSL only)
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The colour code in the xDSL trace can be 
interpreted as follows (see SHDSL, 
page 81).

Legend and explanations:

Recording time Resolution Leap factor

16 min. 1 sec. -

32 min. 2 sec. 2

64 min. (1 h 4 min.) 4 sec. 2

128 min. (2 h 8 min.) 8 sec. 2

256 min. (4 h 16 min.) 16 sec. 2

512 min. (8 h 32 min.) 32 sec. 2

1024 min. (17 h 4 min.) 64 sec. (1 min. 4sec.) 2

2048 min. (1 d 10 h 8 min.) 128 sec. (2 min. 8 sec.) 2

4096 min. (2d 20 h 16 min.) 256 sec. (4 min. 16 sec.) 2

8192 min. (5 d 16 h 32 min.) 512 sec. ( 8 min. 32 sec. ) 2

You can show and hide the label for 
the xDSL trace using the number 
key. 

The function of the cursor is 
described on page 64.
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Meaning of the modem states:

See page 81 for an explanation of SHDSL.

Colour Short form Explanation

red No-load

light 

blue

ARGUS transmits handshake tones (silence 
on the DSLAM side).

yellow A handshake (G.hs) signal from the remote 
station was detected.

orange Start of the training phase following  
successful handshake.

green Showtime achieved. The TC sublayer is  
established. ARGUS is ready for operation.
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.

 the 

rors 
and 

.
rors 
ly.
Connected
As soon as the connection is established, (LED "Sync/L1" continuously illuminated and 
green tick mark in layer 1 box), ARGUS determines the VDSL connection parameters. After 
synchronising, ARGUS must remain connected to the VDSL access for at least 20 
seconds. Only then can ARGUS save all VDSL connection parameters.

ARGUS in status screen. 
Display (layer-1 box)

Display of VDSL connection parameters in  
overview:  
- d/n: downstream/near 
- u/f: upstream/far

- Access and access mode
- VDSL profile (8,12,17,30 or 35 MHz)
- d: Downstream data rate 

u: Upstream data rate
- Number of CRC errors in  

downstream/upstream
- DC voltage at interface

<Info> Displays the VDSL connection 
parameters.

<Stop> Disconnects the VDSL connection

Signals of CRC/FEC error counters:
Symbol Colours 

left and 
right

Explanations

green / 
green

No CRC errors occurred in
final second.

red / red In the final second, FEC er
occurred in both upstream 
downstream.

green / 
red

No upstream CRC errors 
occurred in the final second

red / 
green

In the final second, FEC er
occurred in downstream on

 
Browse connection  
parameters

<Trace> Displays trace data, see 
page 58.

<Graph> Displays the graph, see 
page 63.

Continued on next page

or
61ARGUS 166 



7 Operation on G.fast and xDSL accesses
Displays the connection parameters in 
long form for downstream (d) and 
upstream (u), see table page 70. 
 

 
Display of xDSL parameters as QR code.

n/a not available 

n/u not used 

n/r not received 

Browse parameter display

<Reset> Resets the error counters.

Generates QR code.

Exits the QR code menu.

G.fast and VDSL (EFM) - Ethernet statistics
Frames Displays the received (Rx) and 

transmitted (Tx) Ethernet 
frames.

Bytes Displays the received (Rx) and 
transmitted (Tx) Ethernet bytes.

SHDSL ATM statistics
ATM cells Number of ATM cells.

OAM cells Number of OAM cells.

User VCCs Number of user-side VCCs

AAL5 PDUs Number of AAL5 PDUs

Unmapped 
cells

Unmapped cells received (Rx)

Unmapped 
VPI/VCI

Unmapped VPI and VPI 
received (Rx)Continued on 

next page
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 tog-
. 
ed 

 

raph 
 for 

ing 
 
 

Displays the bit distribution  
i.e. transported bits per tone (channel) 
Y-axis: bits 
X-axis: tones (channels) 
Line interference sources can be identified 
on the basis of the bit distribution  
(e.g. due to HDSL, RF, DPBO etc.). 

Graph functions: 
The graph functions such as zoom, cursor 
and setting of the x-axis enable detailed 
analysis of the graphs:

The following graphs and graph 
functions are only available for 
ADSL and VDSL.

ARGUS switches to the 
previous display.

<Continue> Switches to next graph.

Exits the menu without changing.

You can also use this number key to
gle the zoom function within a graph
The function of the cursor is describ
on page 65.
Toggles the x-axis from tone to  
frequency is described on page 66.
Toggles the min/max is described on
page 66.
Switches automatically to the next g
with the view and adopts all settings
this graph. 

 
and 

 

 
Saves the result without disconnect
the connection.

Continued on 
next page

See page 68
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The magnifying glass shown in the display 
rests on a white background.  
It has not yet been zoomed. 

The magnifying glass shown in the display 
rests on a dark background, indicating that 
it has been zoomed.

 

 toggles the softkey assignment. 
ARGUS switches from x-axis zoom to  
y-axis zoom

<Zoom(x)++> Magnifies the middle section of 
the graph (100%).

<Zoom(x)--> Reverses <Zoom(x)++> and 
resets magnification.

Use the cursor keys to  
horizontally scroll through 
the zoomed range.

<Zoom(x)++> Magnifies the middle section of
the graph (100%).

<Zoom(y)--> Reverses <Zoom(y)++> and 
resets magnification.

Continued on 
next page
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 to 
he 
ing 
 
ph. 
n, 
 
er.
 
 
The magnifying glass shown in the display 
rests on a dark background, indicating that 
it has been zoomed.

 

The cursor functions enables precise 
determinations on the graphs.

When the Cursor function is started, a 
green cursor line appears in the middle of 
the graph.

The values of the graph for the position 
under the cursor are displayed in the graph 
as follows:

 
You can use the cursor keys to 
scroll vertically through the 
zoomed range.

Activates the cursor directly. 

<Cursor> You can toggle the cursor on and 
off as needed using the Cursor 
softkey after activating it in the 
menu.

x:  2168. Tone

y:  7 bits

Use the left and right cursor keys
move the cursor to any point on t
graph to measure it. Briefly press
a cursor key causes the cursor to
jump to by one position in the gra
When the cursor key is held dow
the steps the cursor covers in the
graph become progressively larg

Continued on next 
page
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By toggling the x-axis you can change its 
labelling from tone to frequency.

Available options:

 
 
 
 

 

 
 

The zoom function and the cursor function 
can also be combined.  
However, the starting position of the cursor 
can vary. The graph functions can be used 
for all graphs. 

Tone: Displays the values of the 
x-axis as tones.

Frequency: Displays the values of the  
x-axis as frequencies.

Direct setting of x-axis.

You can use the left and right 
cursor to scroll through the 
range (in this example 
frequency).

Continued on 
next page

Graphic functions
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.

With the Min/Max setting, the bits/tone 
and SNR/tone graphs display the 
minimum and maximum values. 

 

Displays the maximum value (pink)
 

Displays the minimum value (blue).

<Min/Max off> Hide min/max values.
<Min/Max rst.> Reset min/max values.

Displays the min/max softkeys.

Continued on next page
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Display of signal-to-noise ratio (SNR) for 
each tone 
y-axis: SNR in dB 
x-axis: tones (channels) 
 
This enables interference sources for 
individual tones (channels) to be detected, 
in this example downstream power backoff 
(DPBO). 
 

 
Display of quiet line noise (QLN) for each 
tone. The QLN represents the quiet line 
noise of the twisted pair as a function of 
the frequency. 
y-axis: QLN in dBm/Hz 
x-axis: tones (channels) 
 
The QLN enables detection of narrow-
band interference sources due to e.g. 
coupling of medium-wave emission 
sources or defective switching 
components. These interference sources 
are represented as narrow peaks. This 
example shows a line with interference 
from a power supply.

<Menu> Opens the graph functions (see 
page 64).

<Menu> Opens the graph functions (see 
page 64).

Continued on next 
page

Additional result graphs
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Displays the amplitude component of the 
transmission function (HLOG) for each 
tone. HLOG shows the attenuation of a 
connection as a function of the frequency. 
Y-axis: Hlog in dB 
X-axis: tones (channels)

On a nominally functioning line, the values 
drop off as the frequency increases; this 
function is virtually horizontal on short 
lines. This example shows a short line. 

In the HLOG graphs, a shift can occur in 
calculating the upstream and downstream 
values from DSLAM compared to the 
downstream values from ARGUS. It can 
also happen that DSLAMs do not transmit 
the HLOG upstream values or send 
falsified values.

DSL connections are often possible even 
though one of the two cores is high-ohm 
or even interrupted (only capacitive 
coupling). This results in dropped 
connections and data losses. Such 
problems can be due to oxidized lines, 
poor contacts in the telephone sockets, 
loose terminals or improperly insulated 
lines. In connections like this, lower 
frequencies are attenuated much more 
than higher frequencies. This is 
recognisable as an atypical relationship 
between upstream and downstream 
attenuation, as well as in the HLOG curve. 
In the event of a problem on one of the 
wires, the values for the low frequencies 
are often less than for the higher 
frequencies.

<Menu> Opens the graph functions, see
page 64. 

<Continue> ARGUS returns to the bits/tone
graph.

Example: Mismatch + poor contact  
on ADSL
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The example at left shows a sink. It can 
indicate a stub line (bridge tap). 
With the rule of thumb: 
L[m] = 50 / f [MHz], 
you can estimate the length of a stub line 
if you know the frequency in MHz (in this 
example 0.535 MHz): 
 
L [m] = 50 / 0,535 MHz = 93 m  
 
There is a stub line approx. 93 m long.

In this example, given a frequency of 
approx. 3.85 MHz, the stub line is approx. 
13 m long.  

ARGUS determines the following ADSL connection parameters:

ADSL connection parameters:
Net data rate Actually usable ATM bitrate in kbit/s.
Attainable data rate Theoretically attainable ATM bitrate in kbit/s.
Relative capacity Line capacity utilisation in percent.
Latency mode ARGUS shows "interleaved" or "fast", depending on the 

DSLAM configuration.
Attenuation Attenuation on a line over the entire length and bandwidth in 

dB. From a specific attenuation on, certain access types are no 
longer recommended. However, it is better to compare 
individually calculated attenuation values that are 
recommended for specific access types with the dB value in the 
HLOG graph, at 300 kHz (cursor).

Output power Output power in dBm with reference to 1 mW.

Example: Bridge tap on ADSL

Example: Bridge tap on VDSL
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SNR margin Signal-to-noise ratio margin in dB. The SNR margin is a 
measure of how much additional noise the transmission can 

stand and still maintain a bit error rate (BER) of 10-7. This value 
is considered a reserve against interference signals.  
Rule of thumb: The SNR margin in downstream should - 
doubled - be at least equal to or greater than the SNR margin in 
upstream.

Inpulse noise prot. INP describes the quality of the protection against pulse 
interference. The number of consecutive DMT symbols that can 
be completely distorted without causing errors in higher layers.

Interleave delay The delay (in ms) due to interleaving of data blocks.
FEC Forward error correction 

Number of transmission errors corrected using the checkbytes 
of a codeword.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks. 
CRC Cyclic redundancy check 

The checksum of the superframes transmitted by the remote 
station does not agree with the locally calculated figure. 
Possible cause: line interference.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks.
HEC Header error checksum 

Number of ATM cells with incorrect header checksums.
f (far): Errors that DSLAM detects and passes to ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks.
ES Errored seconds 

Number of seconds containing one or more erroneous sync 
words and/or one or more CRC anomalies.

SES Severely errored seconds 
Number of seconds containing one or more erroneous sync 
words or at least 50 CRC anomalies. 

LOSS Loss of signal seconds 
Shows the number of LOS errors in one second. 
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ARGUS determines the following VDSL connection parameters

UAS Unavailable seconds 
Number of seconds in which the ADSL link was unavailable. 
The connection is considered unavailable at 10 consecutive 
SESs at the latest. The 10 SESs are added to the time that the 
connection is unavailable. Once the connection is unavailable, 
it only becomes available when no SESs occur in 10 
consecutive seconds. The 10 SES-free seconds are added to 
the time that the connection is unavailable.

Reset Indicates how often the user resets the error counters using the 
<Reset> softkey.

Resync Number of resyncs by ARGUS.
Bitswap events Shows how much data is diverted from a faulty transmission 

channel (up- and downstream) to other channels.
Retranmission 
(G.INP)

This parameter shows whether retransmission is activated for 
down- and/or upstream in DSLAM. When retransmission is 
activated, faulty data transmission units (DTUs) caused by 
transmission problems are requested and transmitted again. 
The following additional parameters are shown when 
retransmission is activated: 

The blue  in the ARGUS status line signals that 

retransmission is activated in DSLAM. 

 = Retransmission configured or not active (grey) 

 = Retransmission active (blue) 

 = Retransmission working (red)

Vendor far ATU-C vendor.
Version Vendor-specific information, contains the software version of 

the ATU-C side (DSLAM).
Vendor near Manufacturer of the ARGUS chipset (ATU-R).
Version Vendor-specific information, contains the software version of 

ARGUS.

VDSL connection parameters:
Net data rate Actually usable ATM bitrate in kbit/s.
Attainable data 
rate

Theoretically attainable ATM bitrate in kbit/s.

Relative capacity Line capacity utilisation in percent.
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.

 

SNR margin Signal-to-noise ratio in the bands used in dB. 
The SNR margin is a measure of how much additional noise the 
transmission can stand and still maintain a bit error rate (BER)  
of 10-7. The value is considered a reserve against interference 
signals. 
Bands not used are indicated with n/u.

Loop attenuation Attenuation on a line over the entire length and bandwidth in dB. 
From a specific attenuation on, certain access types are no longer 
recommended. However, it is better to compare individually 
calculated attenuation values that are recommended for specific 
access types with the dB value in the HLOG graph, at 1 MHz 
(cursor). Bands not used are indicated with n/u.

Signal attenuation Attenuation of the signal in dB in the corresponding bands. 
Bands not used are indicated with n/u.

Output power Output power in dBm with reference to 1 mW.
Interleave delay The delay (in ms) due to interleaving of data blocks.
Inpulse noise prot. INP describes the quality of the protection against pulse 

interference. The number of consecutive DMT symbols that can be 
completely distorted without causing errors in higher layers.

FEC Forward error correction 
Number of transmission errors corrected using the checkbytes of a 
codeword.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks. 
CRC Cyclic Redundancy Check 

The checksum of the superframes transmitted by the remote station
does not agree with the locally calculated figure. Possible causes: 
line interference.
f (far): Errors that DSLAM detects and passes to ARGUS
n (near): Errors that ARGUS detects in the transmitted 

blocks. 
ES Errored seconds 

Number of seconds containing one or more erroneous sync words 
and/or one or more CRC anomalies.

SES Severely errored seconds 
Number of seconds containing one or more erroneous sync words or
at least 50 CRC anomalies. 

LOSS Loss of signal seconds 
Shows the number of LOS errors in one second. 
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UAS Unavailable seconds 
Number of seconds in which the VDSL link was unavailable. The 
connection is considered unavailable at 10 consecutive SESs at the
latest. The 10 SESs are added to the time that the connection is 
unavailable. Once the connection is unavailable, it only becomes 
available when no SESs occur in 10 consecutive seconds. The 10 
SES-free seconds are added to the time that the connection is 
unavailable.

Reset Indicates how often the user resets the error counters using the
<Reset> softkey.

Resync Number of resyncs by ARGUS.
Showtime no sync Shows how often the connection status "showtime" was achieved 

without a long-term stable connection.
Bitswap events Shows how much data is diverted from a faulty transmission channel

(up- and downstream) to other channels.
Vectoring The vectoring mode shows whether this remote station supports 

VDSL2 vectoring (ITU-T G.993.5). 
- Display shows "off" for non-vectoring. 
- ARGUS displays "Vectoring friendly" or "Full Vectoring" when 
vectoring is supported.  
See page 47 for more information.

SRA (Seamless 
rate adaption)

This parameter shows whether SRA is activated for down- and/or 
upstream in DSLAM. Seamless rate adaption (SRA) is a seamless 
adaption of the data rate during a DSL connection. In SRA, the data
rate is adapted depending on the SNR margin during a connection.

Retranmission 
(G.INP)

This parameter shows whether retransmission is activated for down-
and/or upstream in DSLAM. When retransmission is activated, faulty
data transmission units (DTUs) caused by transmission problems 
are requested and transmitted again. 
The following additional parameters are shown when retransmission
is activated: 

The blue  in the ARGUS status line signals that retransmission is
activated in DSLAM. 

 = Retransmission configured or not active (grey) 

 = Retransmission active (blue) 

 = Retransmission working (red)
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Data 
transmission 
units (DTU) 

Retransmission is performed before the CRC 
mechanism. As long as the retransmission 
mechanism requests and and transmits the 
erroneous DTUs in corrected form, no CRC errors
(data losses) occur. If the retransmission 
mechanism cannot correct faulty transmissions, 
e.g. due to sustained interference, CRC errors 
(data losses) occur.  
- Retransmi. Multiple retransmitted DTUs due to a
transmission problem. Is also displayed in the 
overview page 61 as "Retransmi". 
- Correct: Successful retransmission of a DTU 
- Uncorrect: Unsuccessful retransmission of a DTU

INP REIN In ARGUS, interference immunity (DSLAM setting)
is displayed with respect to REIN INP. This 
describes the quality of the protection against 
pulse interference. REIN (Repetitive electrical 
impulse noise) describes periodic interference 
pulses, usually caused by 230 V AC voltage from 
the supply mains. The value indicates the number
of consecutive DMT symbols that can be 
completely distorted without causing errors in 
higher layers (1 DMT symbol = ~250 µs). 

INP SHINE In ARGUS, interference immunity (DSLAM setting)
is displayed with respect to SHINE INP. This 
describes the quality of the protection against 
pulse interference.SHINE (single high impulse 
noise event) describes random, unpredictable,  
non-periodic interference pulses. The value 
indicates the number of consecutive DMT symbols
that can be completely distorted without causing 
errors in higher layers (1 DMT symbol = ~250 µs).

ETR The expected throughput rate (ETR) in kBit/s is the
minimum data rate that can be provided through 
complete error correction through retransmission.

Elec.length@1MHz Indication of the electrical length for a frequency of 1 MHz in dB. 
R: VTU-R side 
C: VTU-C side

Vendor far VTU-C vendor.
Version Vendor-specific information, contains the software version of the 

VTU-C side (DSLAM).
Vendor near Manufacturer of the ARGUS chipset (VTU-R).
Version Vendor-specific information, contains the software version of 

ARGUS.
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ARGUS determines the following G.fast connection parameters:
G.fast connection parameters:
Net data rate Actually usable bitrate in kbit/s.
Attainable data 
rate

Theoretically attainable bitrate in kbit/s.

Relative capacity Line capacity utilisation in percent.
SNR margin Signal-to-noise ratio in the bands used in dB. 

The SNR margin is a measure of how much additional noise the 
transmission can stand and still maintain a bit error rate (BER) 

of 10-7. The value is considered a reserve against interference 
signals. 
Bands not used are indicated with n/u.

Signal attenuation Attenuation of the signal in dB in the corresponding bands. 
Bands not used are indicated with n/u.

Output power Output power in dBm with reference to 1 mW.
Interleave delay The delay (in ms) due to interleaving of data blocks.
Impulse noise prot. INP describes the quality of the protection against pulse 

interference. The number of consecutive DMT symbols that can 
be completely distorted without causing errors in higher layers.

FEC Forward error correction 
Number of transmission errors corrected using the checkbytes 
of a codeword.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks.
CRC Cyclic Redundancy Check 

The checksum of the superframes transmitted by the remote 
station does not agree with the locally calculated figure. 
Possible causes: line interference.
f (far): Errors that the DSLAM detects and passes to 

ARGUS.
n (near): Errors that ARGUS detects in the transmitted 

blocks.
ES Errored seconds 

Number of seconds containing one or more erroneous sync 
words and/or one or more CRC anomalies.

SES Severely errored seconds 
Number of seconds containing one or more erroneous sync 
words or at least 50 CRC anomalies. 
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LOSS Loss of signal seconds 
Shows the number of LOS errors in one second. 

UAS Unavailable seconds 
Number of seconds in which the VDSL link was unavailable. 
The connection is considered unavailable at 10 consecutive 
SESs at the latest. The 10 SESs are added to the time that the 
connection is unavailable. Once the connection is unavailable, it 
only becomes available when no SESs occur in 10 consecutive 
seconds. The 10 SES-free seconds are added to the time that 
the connection is unavailable.

Reset Indicates how often the user resets the error counters using the 
<Reset> softkey.

Resync Number of resyncs by ARGUS.
Showtime no sync Shows how often the connection status "showtime" was 

achieved without a long-term stable connection.
Bitswap Events Shows how much data is diverted from a faulty transmission 

channel (up- and downstream) to other channels.
SRA (Seamless 
Rate Adaption)

This parameter shows whether SRA is activated for down- and/
or upstream in DSLAM. Seamless rate adaption (SRA) is a 
seamless adaption of the data rate during a DSL connection. In 
SRA, the data rate is adapted depending on the SNR margin 
during a connection.

Retranmission 
(G.INP)

This parameter shows whether retransmission is activated for 
down- and/or upstream in DSLAM. When retransmission is 
activated, faulty data transmission units (DTUs) caused by 
transmission problems are requested and transmitted again.
The following additional parameters are shown when 
retransmission is activated: 

The blue  in the ARGUS status line signals that 

retransmission is activated in DSLAM. 

 = Retransmission configured or not active (grey) 

 = Retransmission active (blue) 

 = Retransmission working (red)
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Data 
transmission 
units (DTU)

Retransmission is performed before the CRC 
mechanism. As long as the retransmission 
mechanism requests and and transmits the 
erroneous DTUs in corrected form, no CRC 
errors (data losses) occur. If the 
retransmission mechanism cannot correct 
faulty transmissions, e.g. due to sustained 
interference, CRC errors (data losses) occur.  
- Retransmi. Multiple retransmitted DTUs due 
to a transmission problem. Is also displayed 
in the overview page 61 as "Retransmi". 
- Correct: Successful retransmission of a DTU 
- Uncorrect: Unsuccessful retransmission of a 
DTU

INP REIN In ARGUS, interference immunity (DSLAM 
setting) is displayed with respect to REIN INP. 
This describes the quality of the protection 
against pulse interference. REIN (Repetitive 
electrical impulse noise) describes periodic 
interference pulses, usually caused by 230 V 
AC voltage from the supply mains. The value 
indicates the number of consecutive DMT 
symbols that can be completely distorted 
without causing errors in higher layers (1 
DMT symbol = ~250 µs).

INP SHINE In ARGUS, interference immunity (DSLAM 
setting) is displayed with respect to SHINE 
INP. This describes the quality of the 
protection against pulse interference.SHINE 
(single high impulse noise event) describes 
random, unpredictable,  
non-periodic interference pulses. The value 
indicates the number of consecutive DMT 
symbols that can be completely distorted 
without causing errors in higher layers (1 
DMT symbol = ~250 µs).

ETR The expected throughput rate (ETR) in kBit/s 
is the minimum data rate that can be provided 
through complete error correction through 
retransmission.

Elec.length@1MHz Indication of the electrical length for a frequency of 1 MHz in dB. 
R: FTU-R side 
C: FTU-C side

Vendor far Manufacturer of the ARGUS chipset (FTU-R).
Version Vendor-specific information, contains the software version of the 

FTU-C side (DSLAM).
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System information for transmission to the ADSL/VDSL remote station
When a modem is synchronised with a DSLAM, the vendor and device type of the 
modem is generally displayed in the control system of the DSLAM. For ADSL and 
VDSL, this occurs according to ITU-T G.997.1. When an ARGUS device 
synchronises with a DSLAM, the latter reports to the control system the following 
information, depending on the DSLAM.

Vendor near Manufacturer of the ARGUS chipset (FTU-R)
Version Vendor-specific information, contains the software version of 

ARGUS.

Information Display in DSLAM Meaning
System vendor ID 0x04, 0x00 (hex) Country code: Germany

INGE or 
0x49, 0x4E, 0x47, 0x45 (hex)

Provider code: 
intec Germany

0x20, 1x01(hex) System FW version: 1.01.0
Version number R1.01 U_ Device FW version: 1.01.0
Serial number ARGUS166-9999-R1.01.0U_ Device type: 

ARGUS 166 / device serial 
number 9999
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ARGUS determines the following SHDSL connection parameters:

SHDSL connection parameters:

SNR margin Signal-to-noise ratio margin in dB. The SNR margin is a measure of 
how much additional noise the transmission can stand and still 

maintain a bit error rate (BER) of 10-7. This value is considered a 
reserve against interference signals.

SNR Signal-to-noise ratio in dB.

Attenuation (dB) Attenuation on a line over the entire length in dB.

Output Power Output power in dBm with reference to 1 mW.

CRC Cyclic Redundancy Check 
Number of CRC anomalies (CRC6 checksum errors), also known as 
code violations (CV). The sums of the one-second periods are 
totalled by ARGUS.

LOSWS Loss of sync word seconds 
Number of seconds containing one or more erroneous sync words.

ES Errored seconds 
Number of seconds containing one or more erroneous sync words 
and/or one or more CRC anomalies.

SES Severely errored seconds 
Number of seconds containing one or more erroneous sync words 
or at least 50 CRC anomalies.

US Unavailable seconds 
Number of seconds in which the SHDSL link was unavailable. The 
connection is considered unavailable at 10 consecutive SESs at the 
latest. The 10 SESs are added to the time that the connection is 
unavailable. If the connection is unavailable, it only becomes 
available when no SESs occur in 10 consecutive seconds. The 10 
SES-free seconds are added to the time that the connection is 
unavailable.
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System information for transmission to the SHDSL remote station 
When a modem synchronises with DSLAM, the vendor and device type of this 
modem are generally displayed in the DSLAM's control system. In SHDSL, this is 
carried out according to “ITU-T G.991.2 table 9-10". When an ARGUS device  
synchronises with a DSLAM, the latter reports to the control system the following:

Info: Entry: Example ARGUS:

Vendor ID intec-Name "intec"

Version model Device type "Argus166"

Vendor serial Serial number "9999"

Other vendor information Device SW "R1.01.0 U_"

Meaning of the running EFM states (from the STU-R perspective)

Power down STU-R / STU-C in idle state.

Initialization red Initialisation - "power on".

GHS startup light 
blue

Handshake according to ITU-T 
G.994.1, G.hs is started.

GHS transfer yellow Replacement of the capability list 
completed.

Discovery Start of the discovery phase.

Discovery 
accepted

Discovery probe accepted.

Discovery 
finished

Discovery phase finished.

Aggregation 
accepted

Aggregation probe accepted.

Aggregation 
finished

Aggregation phase finished.

GHS finished orange Handshake (G.hs) successfully 
completed.

Data green Data mode achieved, showtime.

Data Error An error, e.g. loss of sync. has 
occurred.
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Disconnecting the G.fast and xDSL connection and saving the results 

 
ARGUS in status screen. 
 
 
 
 
 
 
 
 
 
Disconnecting the VDSL connection. 
 

 
 
 
 
 
 
 
 

 
ARGUS saves the VDSL connection 
parameters together with the trace data 
in the first free slot. You can enter a user-
definable name when saving (see 
page 285). ARGUS automatically 
suggests a save name, which is 
composed of: 
- the device type (in this example A166) 
- the serial number (in this example 
40380) 
- the configured date (in this example 
20th december 2017) 
- the configured time (in this example 
11:23 h) 
If all slots are occupied, you need to 
manually select a slot to overwrite.

<No> Results are rejected.
<Back> Results are not saved. ARGUS 

returns to the status display.
<Yes> Saving the result.

Continued on 
next page

Saving the 
result
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After saving, ARGUS returns to the status 
display or ARGUS status. 
You can initialise a new sync attempt 
directly using <Start>.

Saving the results without disconnecting the G.fast and xDSL connection

ARGUS in status screen.

ARGUS automatically suggests a save 
name. 

 and  Saves the result without 
disconnecting the 
connections.

<Last name> The last name used is 
suggested.

<Delete> Deletes the suggestion.
<Ab>AB> Entry of upper- and lower-

case letters and @, /, -, .
Results accepted with  
the storage name shown.
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Displaying stored test results

ARGUS in Main Menu
 
In ARGUS status, press <Menu>. 
 
When ARGUS is in the selection list for 
preconfigured accesses, you can switch to 

the abbreviated main menu with . 
 
 
 
Marked the stored test result. 
 
 
 
 
 
 
 
 
 
 
 
Displays the test results: 
ARGUS shows whether the downstream 
and upstream values are within the limits. 
 

 

 
Browse VDSL connection 
parameters.

<Continue> Displays the signal-to-noise 
ratio per tone (SNR/tone), 
QLN/tone, HLOG/tone and 
the trace data. 

Exits results.

View

Test results
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7.4 ARGUS in access mode xTU-R bridge

Connect ARGUS to the PC using the patch cable and to the VDSL access using the xDSL 
cable. In bridge mode, ARGUS acts as a VDSL modem, i.e. ARGUS passively hands on all 
packets from the Ethernet to VDSL (and vice versa). In this case, the PC is responsible for 
establishing the connection.

Patch cablexDSL cable

Socket LAN 1/2 / SFP 1Socket Line

Ethernet VDSL 

VDSL 
access

PCProtocol, e.g. PPP

 

ARGUS in access mode xTU-R bridge
In this example, VDSL VTU-R bridge mode is configured and selected as described in 
chapter „5 Configuring accesses“ (see page 25).

 
Test not yet started:  
red LED in display 
Meaning of LED image in display: 

Display: 

Red LED: no test started

Yellow LED: test started

Green LED: connected

- Access mode

- Default profile, see page 43

- Current status

- DC voltage at interface

<Edit> VDSL settings.
<Access> Edits an access.
<Start> Starts VDSL. 

Switch to bridge mode using 
the cursor keys, see 
page 101.

Establishing a VDSL connection
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The VDSL connection is established 
(green tick mark in layer-1 box).

The bridge can also be activated directly. If 
layer 1 has not yet been established, this is 
automatically started as well.

 

 
Switches to the layer-1 box and other 
elements, see page 101 for explanation. 

<Edit> Bridge/router parameter settings.

<Stop> Deactivates bridge mode.

<Info> Displays the activity of bridge 
mode.

When the physical layer is active (only 
ADSL), you can run the following tests 
using the softkey <Test>, see page 126.

No tests are available when 
bridge mode is active.

Displays the connection 
parameters.

<Info> 
 or 

Displays the VDSL 
connection parameters, 
see page 61.

<Stop> Disconnects the VDSL 
connection and automatically 
deactivates the bridge.

Establishing the VDSL bridge
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7.5 ARGUS in access mode xTU-R router

Connect ARGUS to the PC using the patch cable and to the VDSL access using the xDSL 
cable. 
In router mode, ARGUS replaces both the modem and the router, so that multiple PCs can 
access a network connection (via a hub/switch). The IP addresses of the network are either 
issued statically or ARGUS is designated the DHCP server and assigns IP addresses to 
the connected PCs.

Bridge/router settings, see page 54.

xDSL settings, see page 43 and following.

Settings in access mode xTU-R bridge
In this example, VDSL VTU-R router mode is configured and selected as described in 
chapter „5 Configuring accesses“ (see page 25).

Test not yet started:  
red LED in display 
Meaning of LED image in display: 

Display: 

Red LED: no test started

Yellow LED: test started

Green LED: connected

- Access mode

- Default profile (profile 1)

- Current status

- DC voltage at interface

Ethernet 

VDSL 

Ethernet 

Hub/switch

Ethernet 
LAN 1/2, 
SFP 1 

VDSL 
access

 
ARGUS does not have a 
firewall!

PC 

PC 

e.g. PPP IP
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Establishing the VDSL connection

Virtual line selected. 
 

 
 
 
Router selected. 
 
 
 
 
The router can also be activated directly. If 
layer 1 has not yet been established, this 
is automatically started as well. 
 

 

<Edit> VDSL settings.
<Access> Edits an access.
<Start> Starts VDSL. 

Switch to router mode using 
the cursor keys, see 
page 101.

When the physical layer is active (only 
ADSL), you can run the following tests 
using the softkey <Test>, see page 126.

No tests are available when 
router mode is active.

<Edit> Edits the parameters, see 
chapter „9 Virtual lines (VL)“ 
(see page 100).

<Edit> Bridge/router parameter 
settings, see page 54.

Establishing the VDSL router. 
The VDSL connection is active. 
 
See page 85 for bridge mode display and 
operation.

Switch to Router using 
the cursor keys, see 
page 101.
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7.6 ARGUS in access mode STU-C

Determining the SHDSL connection parameters
ARGUS is connected to the SHDSL modem directly using the supplied xDSL, patch, 
SHDSL 4-wire or SHDSL 8-wire banana cable. In this case, ARGUS replaces the DSLAM 
(STU-C). ARGUS establishes an SHDSL connection and determines all relevant SHDSL 
connection parameters. ARGUS displays the SHDSL connection parameters and, if 
desired, saves them when the link is disconnected. 
The procedure is the same for SHDSL 2-wire ATM, SHDSL 4, 6 and 8-wire connections 
and for EFM.

 
Use only the patch cable supplied with the device. 
 

 

Configuring access mode STU-C:
SHDSL STU-C mode is explained in chapter „5 Configuring accesses“ (see page 25), 
including configuration and selection. 

Connecting SHDSL on the STU-C side:

Connect STU-C and display the connection parameters (see page 80) via <Info> as for 
VTU-R, see page 57.

When the SHDSL physical layer is active, you can run the following tests using the softkey 
<Test>, see page 126.

SHDSL modem or another 
ARGUS (STU-R) 

Socket 
Line

e.g. xDSL cable or patch cable 
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8 Operation with Ethernet accesses

ARGUS supports the following access modes in Ethernet operation: 

The individual tests acquire and store data. It is the user's responsibility to comply 
with the applicable legal requirements.
 

 

Patch cable

Socket LAN 1/ 2, SFP 1

Ethernet e.g. xDSL or G.fast 

Connecting to a modem:

Modem

e.g. xDSL 
access

 

 

Patch cable

Socket LAN 1/ 2, SFP 1

Ethernet e.g. xDSL or G.fast

Connecting to a router modem:

Router 
modem

e.g. xDSL 
Access

Patch cable

Socket LAN 1/ 2, SFP 1

Ethernet e.g. xDSL or G.fast

Connecting to a PPTP router modem:

PPTP 
(router) 
modem

e.g. xDSL 
Access
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8.1 Configuring the Ethernet interface

Please refer to chapter „5 Configuring accesses“ (see page 25) for instructions on  
configuring the Ethernet interface.

Note: accessing functions via number keys/key combinations 
You can call important functions/tests directly using the keys of the ARGUS keypad. You 
can find an overview of these key combinations on page 126.

Socket LAN 1/ 2, SFP 1

Ethernet 

Connecting to a PC via IP

PC
Patch cable

Socket LAN 1/ 2, SFP 1

Connecting to an IP network:

Ethernet 

Hub/switch

Patch cable PC

PC
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8 Operation with Ethernet accesses
8.2 Ethernet settings
You can modify the Ethernet settings as described for VDSL, see page 43.

Autonego-

tiation

Gratu-

itous ARP

LACP

 

See chapter „9.4 Virtual line settings“ (see page 110) for further configurations. 

Setting Description
Preconfigured accesses

Phys. parameters:

Ethernet:

Switches on or off 
When autonegotiation is switched on, network cards can automatically 
detect the correct transmission speed and duplex method of the Ethernet 
port to which they are connected and configure themselves accordingly. In 
Ethernet, autonegotiation is based on layer 1 of the OSI model (according 
to IEEE standard 802.3u).  
Default: on 
To set this to off, see the following section below.

MAC address, see page 45.

Determines whether Gratuitous ARP (Address Resolution Protocol) is to 
be used.  
When this is set to “on“, ARGUS transmits one ARP message every 60 
seconds unrequested to communicate its MAC address.  
Default: Off

Determines whether the LACP (Link Aggregation Control Protocol) 
information is to be displayed. 
Default: off
92 ARGUS 166
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Autonegotiation/Ethernet link parameters
Ethernet link autonegotiation is supported by default!
Setting: autonegotiation "on"
When negotiating the link parameters, ARGUS informs the remote station that the following 
is supported (these settings are fixed and cannot be configured):
- 10, 100 or 1000 Mbit/s
- Half or full duplex
- Flow control on/off (for on: symmetric and asymmetric pause) 

Manually configuring the Ethernet link parameters
Setting: autonegotiation "off"
When autonegotiation is deactivated, the speed, duplex and flow control ("pause" method) 
can be configured in the profile (see above). 
- 10, 100 or 1000 Mbit/s, default: 100 Mbit/s
- Half or full duplex, default: full
- Flow control on/off ("Flow control off" is only useful in full duplex mode)

Default: on

Unilateral autonegotiation
When a terminal device with autonegotiation "on" encounters a device without 
autonegotiation, no information is transmitted by the remote station. Even without 

autonegotiation, the speed is determined using the pulse method/idle pattern (parallel 
detection). In this case, the terminal device with autodetection generally drops back to half 
duplex (duplex mismatch possible), which can result in a duplex mode conflict with "poor 
throughput".
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.

8.3 Establishing an Ethernet connection

Establishing an Ethernet  
connection

or

ARGUS in the status screen. 

ARGUS uses the default profile (profile 1 
in the example) to establish an Ethernet 
connection.

Meaning of the arrow in the layer-1 box

Gray arrow

Yellow arrow

Green check 
mark

The test has not yet started!

no test started

test started

connected 
 
 
 
 
 
 
 

<Info> Displays Ethernet connection 
parameters.

<Stop> Stops the Ethernet connection

 

 
Display:

- Autonegotiation setting 

- Autoneg. at remote station 

- Negotiated speed 

- Type of duplex mode 

- Flow control setting 

<Statistic> Opens Ethernet statistics
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er 
te 
 

ire 
s. <Statistic> page 94

Continued on next page

Displays polling and offset between wires 

Statistic display 

<LACP>  LACP s. page 96. 

Displayanzeige LLDP: 

- Wire allocation:

Left column ARGUS wire allocation

Right column ARGUS wire allocation aft
autonegotiation with remo
terminal. When the display
shows "OK", the remote 
station has inverted the w
allocation.

- Polling

- Skew in ns

- Received (Rx) and transmitted (Tx) 
internet frames

- Received (Rx) and transmitted (Tx) 
bytes

- Number of errors on the receiver (Rx) 
and transmitter (Tx) side

- Number of collisions

- Displays the MAC address of 
neighbour devices.
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8 Operation with Ethernet accesses
Display of LACP information

Display LLDP: 

Display LACP:

Disconnecting from the Ethernet connection and saving the results
You can disconnect and save the results from an Ethernet connection as described for 
VDSL, see page 82.

Saving the results without disconnecting from the Ethernet connection
You can save your results for an Ethernet connection without disconnecting in the same 
way as for VDSL, see page 83.

- Port description

- System name

- System description

- Chassis ID

- Port ID

- Management address

- Features

- Actor key

- Partner key

- Aggregation ID

- LACP partner MAC address
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8.4 DDM test (SFF 8472)

With the Digital Diagnostic Mode (DDM) test according to SFF 8472, ARGUS detects 
various optical and electrical line parameters, such as link speed, transmission level or the 
remote station currently in use.

Starting the DDM test (access mode: Ethernet SFP1)
ARGUS in status screen. 
 

or

 
The profile shown in the display (profile 1 
in this example) is used for the DDM test. 

 

 
It is not necessary to establish a link with 
the remote station.

 

 

Continued on next page

<Start> Activates Ethernet.

<Info> Displays Ethernet connection 
parameters.

<Test> Displays the available tests.

<Stop> Stops the Ethernet connection.

Display:

- Autonegotiation setting 

- Autoneg. at other end 

- Negotiated speed 

- Type of duplex mode 

- Flow control setting

<Statistic> Opens Ethernet statistics.
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s

Display: 

 

Display: 

 

Display: 

 

Displays system information on the SFP 
mode used

- Name of manufacturer

- Manufacturer number (OUI)

- Part number

- Revision

- Serial number (S/N)

- Date of manufacture

Display of access-specific information such a

- Wavelength (where appropriate)

- SFP type (transmitter) used

- Coding used

- Transmission type used (optical or 
electrical)

- Link speed

Display of diagnostic parameters (power 
meter)
- Received (Rx) and transmitted (Tx) 

power in mW
- Received (Rx) and transmitted (Tx) 

level in dBm
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Display: 

Display: 

Disconnecting the Ethernet connection and saving the results
You can disconnect and save the results from an Ethernet connection as described for 
VDSL, see page 82.

Saving the results without disconnecting the Ethernet connection
You can save your results for an Ethernet connection without disconnecting in the same 
way as for VDSL, see page 83.

Display of measured connection 
parameters
- Temperature in °C
- Supply voltage in mV
- Transmit quiescent current in mA in 

operation

Displays the maximum possible line  
lengths in m
- Copper or single-mode glass fibers or for
- Multimode glass fibers in omni-modes  

1 through 4
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9 Virtual lines (VL)

Virtual lines (VL) compile the configurations of  layer 2 and  layer 3 into profiles, called the 
VL profiles. These profiles contain e.g. information on protocols, VPI/VCIs, VLANs and 
PPP data (stored in their own subordinate PPP profiles). Virtual lines can be used to  
conduct tests across multiple VPI/VCIs or VLANs and across different protocols.  
ARGUS allows you to define up to 20 such VL profiles. In a VL profile, you can edit e.g. the 
protocol configuration. The VL profiles can be assigned to one or more services independ-
ently of the state of the physical layer (layer 1).  
Thus, a data test (e.g. IP ping and a VoIP test (e.g. VoIP call) can be performed on a single 
active access without having to re-establish layer 1 (G.fast, DSL, Ethernet) in spite of  
differing protocols.

9.1 Virtual lines in the status screen

The virtual lines in the status screen are explained using the access VDSL VTU-R  
router:

Services 
see page 124

Layer 1

Router/bridge  
(only for xTU-R bridge 
and xTU-R router)

Virtual lines

Profile name

Current access

Virtual line for 
bridge/router,  
configuration  
see page 54.

Softkey assign-
ment, see 
page 315.
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9 Virtual lines (VL)
The status screen is divided into three levels that can be individually selected using the  
cursor keys of the ARGUS keypad.
The status screen is described in greater detail using three display examples.

Cursor up

Cursor up

<Edit>

<Access>

<Start>

Level 1: physical layer (see page 40)

 
 
 
 
 
 
Level 2: virtual lines

<Edit>

Configuration options: 
 - Protocol (IP, PPP, PPTP) 
 - ATM, see page 110
 - VLAN, see page 111
 - PPP (PPP profiles) 
 - PPTP, see page 112
 - IP version (IPv4, IPv6, dual) 
 - IPv4, see page 113 
 - IPv6, see page 115 
 - BGP, see page 120 
 - Data log (for this VL)
 - Profile name, see page 116

<Profile>

 

Level 3: services (see page 124)

<Edit>

<Profile>

<Start>

 

The virtual line and the physical layer start 
automatically when you press the softkey  
<Start>.

Configures physical layer.

Selects access.

Establishes physical layer of 
the selected access.

Configures virtual line, see 
page 105.

Configures the profile.

Assigns a VL to a service 
and configures it.

Configures the profile.

Starts the service.
ARGUS 166 101



9 Virtual lines (VL)
Depending on the state of the physical layer, the virtual lines or the services, ARGUS  
displays a variety of symbols in the status screen.

 
This service has not yet been assigned to a virtual line.
 
This service, VL or physical layer is idle.
 
This service is not available (bridge mode only). 
 
Preparing activation of physical layer, VL or service. 
 
Activating the physical layer, VL or service. 
 
Physical layer, VL or service deactivated due to an unexpected occurrence. 
 
Deactivating.
 
Synchronisation achieved (physical layer) or a VL or service was activated  
successfully without errors. 
 
A test is currently running in this service.

An error occurred here. Reset with <Reset> to continue with the VL/service.

9.2 Virtual line profiles (VL profiles)
The various profile types are explained below:

Profiles (1 - 20), see page 35:

-

-

-

VL profiles (virtual lines 1 - 20 )

-

-

-

-

PPP profiles (1 - 20)

-

-

-

These contain the assignments of the services (Data, VoIP, IPTV, VoD) to one or more 
virtual lines.

In addition to the services, the settings for the bridge/router and the test parameters can 
be found here as well.

Every profile can be assigned an individual profile name.

These contain the layer 2/3 settings.

VL profiles are assigned to services.

One VL can be assigned to multiple services.

The VL profiles can be assigned to PPP profiles.

These contain all relevant data for dialling.

PPP profiles are assigned to VL profiles.

One PPP profile can be assigned to multiple VL profiles.
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0

Relationships between profile types
When all configurations are reset (see page 309), a VL profile (1-20) is only assigned to the 
service data in each profile (1-20). One PPP profile is assigned to each VL profile (1-20). 
All other services (such as VoIP, IPTV and Opt.) are initially not assigned a VL profile or a 
PPP profile.  
The assignment further VL and PPP profiles to services is described starting on page 105.

Default configuration:

Profile 1

Service Data => VL profile 1 => PPP 
profile 1

Service VoIP ... ...

Service IPTV ... ...

Service Opt. ... ...

 
 
 
 

Profile 20

Service data => VL profile 20 => PPP 
profile 2

Service VoIP ... ...

Service IPTV ... ...

Service Opt. ... ...
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9.3 Activating a virtual line
A service or test must be started in order to activate a virtual line. To enable a test to be 
started, a service must be configured, and a virtual line assigned to it. In this example, the 
service Data is configured and assigned ot a virtual line. 

9.3.1 Starting a service

Continued on 
next page

The VDSL access is active.
 
 
 
 
 
 
 
 
 

 
 

<Start>

 

The physical layer (VDSL), the virtual line 
and the service Data are now active. This 
is indicated by a green check mark.

<Info>

<Stop>

 

See page 124 for explanations of the  
services.

 

Use the cursor keys to switch from 
the layer-1 box over the virtual line to 
the service Data.

If the physical layer is not yet 
active, this is started automatically 
with the service or test.

Starts the service.

Displays information on the 
service Data (e.g. duration 
of activity).

Stops the service Data.
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The tests that can be run using the service 
Data are displayed. 

<Setting>

9.3.2 Assigning additional virtual lines

ARGUS can use multiple services concurrently (e.g. Data and VoIP) via a single virtual line. 
In this example, VDSL is active. The service Data is selected. The following explains how 
multiple services can be connected via a single virtual line.

Continued on next page

 

 
 

 
 

<Edit>

Configures the respective 
test (in this example IP ping). 
A detailed description is 
provided in the chapter Test, 
see page 141. 

To configure a virtual line (in this 
example for the service Data) for 
other services, you must first 
stop the service. 
The physical layer remains 
active.

 
The service VoIP is greyed out 
when the VoIP option is not set. 

 

Using the cursor keys, 
select the service VoIP.

Opens the configuration of the 
selected service (in this 
example VoIP).
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Continued on 
next page

Select "Virtual line" 
 
 
 
 
 
 
 
 
 
 
 
 

<Edit>

 

Edit the selected VL profile.

 

The configuration options are described 
starting on page 112. 
 
Opens PPP profile selection 

Select the virtual profile you wish 
to edit. The selected profile is 
highlighted in blue in the display. 

Elements not available are 
grayed out, for instance when 
they are currently active.

The configuration options are 
described starting on page 110.

 
e.g. select PPP
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3x

Continued on 
next page

 
 
 

 
Up to 20 PPP profiles can be  

configured.

<Edit>

The configuration options are described 
starting on page 112. 
 
 

 
e.g. select PPP profile 1

Edits the selected PPP 
profile, see page 112.

 
The desired profile has not yet 
been selected.
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Select Data using the 
cursor keys and press 
<Start> to activate the 
service.

 
ARGUS switches to the status screen or 
the Settings menu (depending on whether 
you accessed the profiles using the main 
menu or the status screen).

The services Data and VoIP are now  
connected to the physical layer (VDSL 
access) via a virtual line. 

<Start>

 

 
 
The service VoIP is now active.  
You can now run a variety of tests via the 
service VoIP. 
 

In the next step, you can now activate a 
further service.

Starts the service VoIP.
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The services Data and VoIP are active. 
You can now run a variety of tests via the 
services Data and VoIP.
 
 
 
 
 
 
 
 
 

The display and operation for IPTV and VoD (video on demand) are the same as for VoIP.

Further examples of different virtual line assignments:

Example 1:

Example 2:

 
 
One virtual line is connected with the  
service Data and another with the service 
VoIP. 
The virtual line for VoIP can thus be used 
for different protocol data than the virtual 
line for Data. 
 
 
 
 
 
 
 
 
 
One virtual line was configured for the 
services Data, VoIP, IPTV und VoD.  
In this example, the services IPTV and 
VoD are active.  
 

Up to four virtual lines can be 
established for the service IPTV. 
However, ARGUS only displays 
these as a single composite virtual 
line. 
A detailed description is provided in 
the chapter IPTV, see page 203.
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Example 3:  
 
 
 
In this example, each service was 
assigned a virtual line.  
As ARGUS is in bridge mode, these  
services cannot be executed. 
 

9.4 Virtual line settings

Setting Description

Virt. profile 1 to 20

Protocol Selection of transmission profile that ARGUS uses for the test 
(e.g. for the IP tests). 
Default: PPP

Protocol ATM: Interfaces:

ATM with 
ETH

ADSL VDSL G.fast SHDSL 
ATM

SHDSL  
EFM

ETH

IP no EoA
IP

EoA
IP

IP no IPoA    -

PPP yes PPPoE
PPPoE

PPPoE
PPPoE

PPP no PPPoA    -

PPTP    -    -    -    -    - PPTP

You can choose between the protocol "ATM with Ethernet" or "ATM without Ethernet" using 
the ATM menu option.

ATM: Settings for asynchronous transfer mode

VPI/VCI VPI: 
VCI:

Enter the virtual path identifier 
Enter the virtual channel identifier 
Ranges VPI: 0 to 255, VCI: 32 to 65535 
Default: VPI: 1 and VCI: 32

Encapsulation Encapsulation of the transmitted packets: LLC or VC-MUX 
Default: LLC
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ATM with  
Ethernet

Determines whether Ethernet is used via ATM or not, see table 
above. 
Options:  
 - No (PPPoA, IPoA) 
 - Yes (PPPoE, EoA) 
Default: yes (PPPoE, EoA)

VLAN: VLAN (Virtual Local Area Network)

VLAN VLAN 
mode

Determines whether VLAN may be used. Up to two 
VLANs can be used concurrently (2 VLAN tags (Q in 
Q)). 
Default: no VLAN

1. VLAN tag (C-VLAN), 2. VLAN tag (S-VLAN) (Q in Q)

ID: Identifier for the VLAN to which the frame belongs. 
Every VLAN is assigned a unique number, the VLAN 
ID. A device that belongs to the VLAN with ID = 2 can 
communicate with every other device in the same 
VLAN but not with devices in other VLANs. 
Range: from 0 to 4095 
Default: 
1. VLAN: 7 
2. VLAN: 2

The IDs 0, 1 and 4095 are reserved for management 
purposes and should preferably not be used.

Priority: User priority information: 
One of eight (3-bit) priorities can be specified for each 
frame. This makes it possible e.g. to give priority to 
transmitting speech data while treating HTTP data 
with lower priority. 
Range: 0 to 7 
Default (1. and 2. VLAN): 0
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TPID: Tag Protocol Identifier 
The TPID is a 16-bit sub-field within the 4-byte VLAN 
data field. This field contains the tag information 
defined by IEEE 802.1q. 
Default: 
VLAN 1: 8100 hexadecimal 
VLAN 2: 88A8 hexadecimal

Note: When using two VLANS with layer 3 (IP) or layer 4, 
both are to be set to 8100.

PPP profile:

User name           Entry of the user name (max. 100 characters) assigned by the 
carrier. The user name is entered using the number keys. 
Pressing the right softkey changes the meaning and thus 
influences the input via the number keys (letters (upper and lower 
case) and numbers).

Password                                          Entry of a password (max. 55 characters) assigned by the carrier; 
see "User name" for an explanation. 
During entry, the characters of the password are visible until 
Enter is pressed once. The characters are subsequently only 
displayed encrypted with "*".

Set IP When "yes" is set, the IP address defined under IP/own IP 
address (see below) is used for connecting. 
Default: no

Current delay Once a PPP connection has been established, the test is only 
started after the preset delay time has elapsed. 
Range: 2 - 10 seconds 
Default: 2

Profile name Enter the name of the PPP profile.

PPTP PPP settings (Point-to-Point Tunnelling Protocol)

Own server IP address 
Range 0.0.0.0. to 255.255.255.255 
Default: 0.0.0.0
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APN APN settings (Access Point Name) 
<Edit> Edit the APN profile

Access point           Access point name (APN), gateway between mobile telephony 
network and data network. 
Default: */*

Dial-up name Dial-up name: enter the dial-up number of the access point here.   
Default: *99#

Profile name Enter the name of the APN profile. 

IP version: Internet Protocol version

Determines which IP version is to be used.

only IPv4: 
 
only IPv6: 
 
Dual Stack IPv4/
IPv6:  
 
 
Dual Stack Lite:

Internet Protocol version 4 acc. to  
RFC 791  
Internet Protocol version 6 acc. to  
RFC 2460 
If IPv6 is available, this protocol is 
preferred for a test.If not, ARGUS switches 
automatically to IPv4. 
Assigning a globally routable IPv6 
address. 
Default: IPv4

IPv4: Internet Protocol version 4 configuration

IP mode Definition of IP address assignment 

Static IP:  
DHCP client:  
 
DHCP server: 
 
DHCP auto: 

Fixed IP address 
Assignment of IP address by server 
(remote side) 
Assignment of IP address by ARGUS 
ARGUS checks for the presence of a 
DHCP server in the network. If a server is 
present, it assigns the IP address; if not, 
ARGUS does this. 
Default: DHCP client 

Own IP address Own ARGUS IP address 
Range: Range 0.0.0.0. to 255.255.255.255 
Default: 0.0.0.0 (assignment see RFC 3330)
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IP netmask IP netmask  
Range: Range 0.0.0.0. to 255.255.255.255 
Default: 255.255.255.0 (assignment see RFC 3330)  

Gateway IP Gateway IP address 
Range: Range 0.0.0.0. to 255.255.255.255 
Default: 0.0.0.0 (assignment see RFC 3330)

DNS Server DNS server 1  
DNS server 2 
Entry of DNS server IP address 
(DNS = Domain Name System) 
Range: Range 0.0.0.0. to 255.255.255.255 
Default: 0.0.0.0 (assignment see RFC 3330)

DHCP client DHCP timeout: 
Range: 1 - 9999 seconds 
Default: 20 

DHCP Vendor ID: 
- Format: choose format: ASCII or hexadecimal 
ASCII data: Entry of DHCP vendor ID in ASCII format 
  Default: ARGUS, for details see "User name", page 112 
- HEX data: entry of DHCP vendor ID in hexadecimal format, see  
  MAC address page 92

DHCP vendor info: 
- Format: choose format: ASCII or hexadecimal 
- ASCII data: Entry of DHCP vendor information in ASCII format, 
  default: ARGUS, for details see "User name", page 112 
- HEX data: entry of DHCP vendor information in hexadecimal 
  format, see MAC address page 92

DHCP user class information 
- Format: choose format: ASCII or hexadecimal 
- ASCII data: entry of DHCP user class info in ASCII format 
  Default: ARGUS, for details see "User name", page 112 
- HEX data: entry of DHCP user class information in hexadecimal  
  format, see MAC address page 92
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DHCP user-defined option (generate a custom DHCP option) 
- Option number 
  Range: 0 to 255 
  Default: 255 = off 
- Format: choose format: ASCII or hexadecimal 
- ASCII data: entry of DHCP user-defined option in ASCII format 
  Default: ARGUS, for details see "User name", page 112 
- HEX data Entry of DHCP user-defined option in hexadecimal  
  format, see MAC address page 92

DHCP server Settings for the DHCP server: 
- Starting and ending IP address 
  Range: Range 0.0.0.0. to 255.255.255.255 
  Default: (assignment see RFC 3330) 
  Start: 192.168.10.30 
  End: 192.168.10.40 
- Domain name, see "User name" page 112 for details 
- Duration of reservation for IP addresses 
  Range: 1 - 99999 seconds 
  Default: 240

IPv6: Internet Protocol Version 6 settings

AFTR AFTR mode Determines whether Address Family 
Transition Router (AFTR) mode is set 
automatically or statically. 
Default: Automatic

AFTR address Entry of the AFTR address. 

DHCP client DHCP mode Determines whether DHCPv6 is selected 
automatically or whether the Router 
Advertisement (RA) server is ignored. 
Default: Automatic

DHCP options Determines whether the DHCPv6 options 
are automatically selected or all options 
requested.  
Default: Automatic

Enterprise Number 
(PEN)

Entry of PEN (Private Enterprise Number). 
Range: 0 to 65535 
Default: 46443
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BGP: Border Gateway Protocol

Modus Determines whether BGP is to be used. 
Default: off

AS number Defines the AS number (Autonomes System). 
Range: 1 to 65534 
Default: 1

IP address  
adjacent router

Determines whether the router´s IPv4 or IPv6 address is to be 
used. 
Default: IPv4 (0.0.0.0)

AS number  
neighbour router

Determines the AS (autonomous system) number from the 
neighbour router. 
Range: 1 to 65534 
Default: 1

TTL Maximum number of hops over which the path to the destination 
address node is tracked. 
Range: 1 to 255 
Default: 1

Connect Timeout Maximum wait time for the response of a network node. 
Range: 1 to 300 seconds 
Default: 10 seconds

Data log Data log on or off  
This function must be set to "on" so that a trace file can be sent to 
the PC; see page 82.  
After terminating a VL via the corresponding service or the 
physical layer, ARGUS queries whether the trace file should be 
sent to the PC. 
For example, when the data log is activated for VL 1, only VL 1 is 
recorded. When one VL is configured for multiple services and 
the data log is active, all data of this VL are recorded. 
Default: off

Profile name Enter the name of the VL profile. Enter the name as for the 
access name, see page 28.
116 ARGUS 166



9 Virtual lines (VL)
9.5 Displaying protocol statistics

Continued on 
next page

Depending on the access mode and the protocol, ARGUS displays BRAS, IP, PPP  or 
Ethernet statistics.

 
 
The physical layer, virtual line and  
service data are active.  
 

 
 
 

 
 
 
BRAS information: 
For PPP protocol only, ARGUS displays 
the Broadband Access Server (BRAS) 
information: 
- AC (access server): name of server  
- Service name name of service 
- Session ID: number of the connection

<Info> Displays G.fast and DSL 
results.

<Stop> Deactivates physical layer, VL 
and Data service.

Switch to the virtual line (VL) using 
the cursor keys.

Press one after 
another 

 and 

Display of ARGUS MAC 
addresses: 
Line, LAN, SFP, ETH, 
see also page 315 and 
following.

<IPv4> Displays the configuration 
assigned by the server.
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PPP information: 
ARGUS displays the received (Rx) and 
transmitted (Tx) PPP packets and the 
bytes. 
 
 
 
 
 
 
 
 
 
 
 
 
Ethernet information: 
ARGUS displays the received (Rx) and 
transmitted (Tx) Ethernet frames and 
bytes.
 
 
 
 
 
 
 

Command display 

 
 

 

<PPP> The softkey <PPP> opens a PPP 
trace, which displays the PPP login 
process.

< = Command sent by ARGUS

> = Command sent by DSLAM

<Time> The <Time> softkey assigns the 
individual messages to times 
according to the ARGUS system 
clock.

Continued on 
next page
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Abbreviation meaning:

- PADI: 
PPPoE Active Discovery Initiation

- PADO:
PPPoE Active Discovery Offer

- PADR:
PPPoE Active Discovery Request

- PADS:
PPPoE Active Discovery Session 
Confirmation

- PADT: 
PPPoE Active Discovery Termination

- IPv6 CP: 
IPv6 Control Protocol

- LCP:
Link Control Protocol

- IPCP:
Internet Protocol Control Protocol

- PAP:
Password Authentication Protocol

Abbreviation Meaning

ack. acknowledge

auth. authentication

conf. configuration

nak. not acknowledge

prot. protocol

rec. received

rep. reply

req. request

rej. rejected
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BGP information
 

Continued on 
next page

<IPv4> Configuration assigned by the 
server is displayed, see 
page 122.

<PPP> PPP information is displayed. 

Switches to softkey assignment.

<BGP> BGP information is displayed. 
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9 Virtual lines (VL)

 

 

ARGUS displays the first 10 out of a  
maximum of 4000 routes for the connec-
tion (in this example 10 through 75). 

Display BGP info:

The display /24 refers to the netmask. This 
corresponds to the netmask 
255.255.255.0.

Display BGP info:

- IP addresses of the routes 

<Detail> Displays the BGP information of the
selected route.

- Current route (in this example 192.168.150.
0/24)

- Next hop (in this example 10.0.1.99)
ARGUS 166 121



9 Virtual lines (VL)
 
IP version-dependent.
In this example IPv6:

Assigned configuration: 
ARGUS displays the IP configuration  
assigned by the server: 
- Global Unicast Address 
- Link Local Address 
- DNS server address

 
 
 
 
Assigned configuration: 
ARGUS displays the IP configuration  
assigned by the server: 
- Received IP address 
- Gateway IP address 
- Available DNS servers

<IPv6> IPv6 information is displayed.

<IPv4> IPv4 information is displayed 
(Softkey not visible in this 
example, as IPv6 was used).

Use the cursor keys to display 
further information.

Exits results.

Exits results.

IP information

<IPv4>
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10 Services + Tests
10 Services + Tests

The status screen (see explanation page 100) shows four services. 
Each service can be used to conduct an entire suite of IP tests (see list below). It is also 
possible to start and stop each service independently of the others.

Example screen with the possible services

 

The meaning of the symbols, s. 
page 102.

Once a service is activated, a variety of tests can be started using <Test>. 

Possible tests that can be executed using the various services.

<Edit> Assigns the service a VL 
profile and configures the 
service.

<Profile> Configures the profile.
<Start> Activates the service. If 

virtual lines and the physical 
layer are not active, they are 
also automatically started as 
well.

Services:

- IP ping - IP ping - IP ping - IP ping

- Traceroute - Traceroute - Traceroute - Traceroute

- HTTP download - VoIP call - IPTV - HTTP download

- FTP download - VoIP wait - IPTV scan - FTP download

- FTP upload - VoIP call generator - IPTV passive - FTP upload

- FTP server - FTP server

- Textbrowser - Textbrowser

- Network scan*1 - Network scan*1

- Video on demand

*1 only Ethernet
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10 Services + Tests
10.1 Displaying service statistics

 
ARGUS in the status screen. 
The physical layer, VL and service are 
active. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 

 
Switch to a service (in this example 
Data) using the cursor keys.

<Info> Displays the duration of activity 
of the selected service.

In the service VoIP, the VoIP 
call parameters are displayed 
here, see page 193.

Exit the display and return to the 
status screen.
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11 Overview of tests andhotkey assignment
11 Overview of tests andhotkey assignment
Overview of tests 
Display of possible tests at the G.fast, xDSL and Ethernet interface:

          Interface 
Test 

ATU-R 
VTU-R 
FTU-R

STU-R  
(only 
ATM + 
EMF)

STU-C 
(only 
ATM + 
EMF)

ATU-R BR 
VTU-R BR 
STU-R BR 
FTU-R BR

ATU-R RT 
VTU-R RT 
STU-R RT 
FTU-R RT

ETH

xDSL 
and 
Ether-
net 2 
port 
access

LTE

Copper Box x*6 - - x*6 x*6 - - -

Loop s. page 134 x*5 x x - x*3 x - -

GigE loop - - - - - x*4 - -

GigE traffic  
generator x*5 - - - - x*4 - -

RFC2544 test x*5 - - - - x*4 - -

RFC2544  
2 port test

- - - - - - x -

LTE scan - - - - - - - x

IP ping  
see page 141

x x x - x x - x

Traceroute 
see page 147 x x - - x x - x

HTTP download 
see page 151 x x - - x x - x

FTP download 
see page 156 x x - - x x - x

FTP upload  
see page 160 x x - - x x - x

FTP server  
see page 164 x x x*1 - x x - -

Text browser x x x*1 - x x - x

Network scan - - - - - x x -

VoIP call/wait 
see page 180 x x - - x x - -
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11 Overview of tests andhotkey assignment
A virtual line must be configured first before ARGUS can execute these texts (exceptions: 
loop, traffic generator, RFC2544 2 port test). Configuration is described in the chapter "Vir-
tual line", see page 100.

Interface 
Test 

ATU-R 
VTU-R STU-R STU-C

ATU-R BR 
VTU-R BR 
STU-R BR 
STU-C BR

ATU-R RT 
VTU-R RT 
STU-R RT

ETH

xDSL- 
and 
Ether-
net 2 
port 
access

LTE

IPTV s. page 203 x x - - x x - -

IPTV scan 
see page 217 x x - - x x - -

IPTV passive  
see page 224 - - - x*1 x x - -

VoD s. page 228 x x - x x*2 x - -

*1 = EFM only   *2 = not for VDSL/G.fast   *3 = only for SHDSL    
*4 = via LAN2, SFP1, SFP2 only   *5 = only for VDSL/G.fast    
*6 = only for ADSL, VDSL and G.fast
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12 LTE
12 LTE

With the LTE function and an approved USB stick (including SIM card), ARGUS can scan 
all available networks (LTE scan) and determine their connection parameters. This also 
permits data tests to be carried out.

12.1 LTE Settings

Please refer to page 43 for instructions on configuring the LTE interface.

Frequency 

band

PIN

 

See chapter 9 Virtual lines (VL) page 100 for further configurations. 
See page 113 for APN configurations. 

With the LTE function and an approved USB stick (including SIM card), 
ARGUS can scan all available networks (LTE scan) and determine their 
connection parameters. This also permits data tests to be carried out.
Insert a valid SIM card before using (not included in scope of supply). 
Attention: Be aware of any restriction on your data volume (particularly in 
download tests, data cut-offs can be reached quickly). 
Do not use any other LTE stick with your ARGUS instrument other than the 
listed LTE sticks with the corresponding firmware version. Observe the  
manufacturer’s operating and safety instructions. 
Only operate your LTE stick within the specified parameters. Never store or 
transport your ARGUS instrument with the LTE stick plugged in (risk of 
destruction). 
Do not use continuously on your ARGUS instrument. Use only antennas 
approved by the manufacturer. 

Settings Description
Preconfigured accesses

Phys. parameters:

LTE (USB):

Sets the frequency band to be used for the LTE connection (800 MHz, 
1600 MHz, 2600 MHz).  
Default: Automatic

Entry of PIN (personal identification number) for the inserted SIM card. Up 
to eight characters are possible. 
Default: ****

The PPP protocol must be selected in order to establish a virtual line.
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12 LTE

 

12.2 Establishing LTE connection

Establishing a LTE connection

  or

ARGUS in status screen. 

ARGUS uses the default profile (PPP 
VLAN 7/ in the example) to establish a 
LTE connection.

Meaning of arrow in the layer-1 box:

Gray arrow

Yellow arrow

Green check 
mark

The test has not yet started! 

no test started

Test started

Connected

Display:

- Provider

- Current LTE parameters 

- Current Cell ID (GCID)

<Info> Display LTE connections 
paramertes 

<Test> Displays the available tests.

<Stop> Stops the LTE connection 

Display:

- Provider

- Used frequency (down- and upstream)
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12 LTE
Open LTE signal information:

The maximum determined for the 
parameter is indicated by a marker. 

For establishing virtual lines and displaying and controlling data tests, e.g. IP ping on page 
 100 und page  141.

Disconnect from the LTE connection and saving test restults
You can disconnect and save the results from an LTE connection as described for
VDSL, see page  82

Saving test results without terminating the LTE connection 
You can save your results of the LTE connection without disconnecting in the same way as 
for VDSL, see page  83

Display:

- Used frequency band

- EARFC (down-/upload) 

- Current signal strength in dBm (RSRP)

- Current signal quality in dB (RSRQ)

- Current signal attenuation in dB (SINR)

- Codecs in IDs

Display:

- Current signal strength in dBm (RSRP)

- Current signal quality in dB (RSRQ)

- Current Signal to noise ratio in dB (SINR)

<Reset> Resets the maximum marker. 
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12 LTE
Meaning of the displayed colours of the LTE parameters: 

RSRP Signal strength Colour scheme

0 bars < -125 dBm red

1 bars -125 dBm up to -105 dBm red

2 bars -105 dBm up to -95 dBm yellow

3 bars -95 dBm up to -80 dBm yellow

4 bars -80 dBm up to -65 dBm green

5 bars >-65 dBm green

RSRQ Signal quality Colour scheme

0 bars < -15 dB red

1 bars -15 dB up to -11 dB red

2 bars -11 dB up to -8 dB yellow

3 bars -8 dB up to -5 dB yellow

4 bars -5 dB up to -3 dB green

5 bars >-3 dB green

SINR Signal to noise ratio Colour scheme

-12 dB up to -5 dB red

-5 dB up to -1 dB red

-1 dB up to 4 dB yellow

4 dB up to 9 dB yellow

9 dB up to 19 dB green

19 dB up to 40 dB green
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12 LTE
12.3 LTE Scan

The LTE scan scans all available carriers and frequency bands. 

12.3.1 LTE-Scan starten

ARGUS status screen. 
 

Continued on 
next page

Establising LTE connection. 
 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

 

<Start> Activates LTE

<Info> Displays the LTE connection 
parameters, see page  129.

<Test> Displays the available tests.

<Stopp> Stops LTE connection.
132 ARGUS 166



12 LTE
 

Save results?

The LTE scan executes. 
This can take a few seconds. The scan is 
completed when the hourglass disap-
pears from the status display.

ARGUS displays all available carriers and 
frequency bands.

The detail information such as signal 
strength, signal quality and signal-to-noise 
ratio can only be displayed for the carriers 
enabled for that SIM card.

For details and evaluation of the connec-
tion parameters, see page  129 and the 
following. 

Exits results. 

 
Saves the LTE scan results (see also IP ping on page  146).
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13 Loop
13 Loop

A loop can be created on an SHDSL line (in EFM or ATM mode), VDSL or G.fast line and 
on Ethernet. See the separate GigE manual for high-performance GigE loop. 
In a loop, all incoming Ethernet frames on layer 1 (L1) are returned to the sender 
unchanged.  
In a loop on layer 2 (L2) of the OSI model, ARGUS swaps the source MAC address for the 
destination MAC address and then returns all Ethernet frames.

The loop requires the following parameters:
 
Protocol-independent parameters
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 35.

Setting Description

Test parameter:

Loop

Layer This setting determines what layer of the OSI model the loop runs on.  
 - L1: all incoming Ethernet frames on a loop on layer 1 (L1) are returned to  
   the sender unaltered. 
 - L2: on a loop on layer 2 of the OSI model, ARGUS exchanges the source  
   MAC address with the destination MAC address and returns all incoming  
   Ethernet frames. 
- L3: on a loop on layer 3 (L3) of the OSI model, ARGUS exchanges the  
  destination and own IP address as well as the MAC addresses and then  
  returns all incoming Ethernet frames. 
Default: L2
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13 Loop
Layer 2 MAC mode You can use the loop MAC mode to determine what gets looped. 
 - For own MAC only (promiscuous mode off) 
  L1: only packets for the own MAC address and broadcast 
  packets are looped.  
  L2: only packets for the own MAC address are looped.  
  Broadcasts are rejected. 
  L3: only packets for the own MAC address and own IP address 
  are looped. Broadcasts are rejected.  
 - Loop everything (promiscuous mode on) 
  L1: all packets (including broadcast) are looped. 
  L2: all packets - except broadcasts - are looped. Broadcasts 
  are rejected. 
  L3: all packets for which the IP address has been recognised are 
looped. 
Default: for own MAC only

own VPI/
VCI

Determines whether the loop (SHDSL-ATM only) is to be executed 
using a separate VPI/VCI pair.

own VLAN Determines whether the loop is to be executed using a separate 
VLAN.

VLAN 
mode

Determines whether VLAN may be used. Up to two 
VLANs can be used concurrently. 
Default: no VLAN

1. VLAN 
(C-VLAN)

ID Identifier for the VLAN to which the frame 
belongs. Every VLAN is assigned a unique 
number, the VLAN ID. A device that belongs 
to the VLAN with ID = 2 can communicate 
with every other device in the same VLAN 
but not with devices in other VLANs. 
Range: from 0 to 4095 
Default: 2

The IDs 0, 1 and 4095 are reserved for 
management purposes and should 
preferably not be used.
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Priority User priority information: 
One of eight (3-bit) priorities can be specified 
for each frame. This makes it possible e.g. to 
give priority to transmitting speech data while 
treating HTTP data with lower priority. 
Range: 0 to 7 
Default: 0

TPID 8100 
Hex

The VLAN TPID 8100 hex is a 16-bit 
field that identifies frames according 
to IEEE 802.1Q (VLAN-tagged 
frame). It also makes it possible to 
use all network paths actively accord-
ing to IEEE 802.aq (shortest path 
bridging, SPB).

88A8 
Hex

VLAN TPID 88A8 supports provider 
bridging according to IEEE 802.ad. It 
also makes it possible to use all 
network paths actively according to 
IEEE 802.aq (shortest path bridging, 
SPB).

Default: 8100 Hex

2. VLAN 
(S-VLAN)

ID Identifier for the VLAN to which the frame 
belongs. Every VLAN is assigned a unique 
number, the VLAN ID. A device that belongs 
to the VLAN with ID = 2 can communicate 
with every other device in the same VLAN 
but not with devices in other VLANs. 
Range: from 0 to 4095 
Default: 2

The IDs 0, 1 and 4095 are reserved for 
management purposes and should 
preferably not be used.
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13 Loop
Priority User priority information: 
One of eight (3-bit) priorities can be specified 
for each frame. This makes it possible e.g. to 
give priority to transmitting speech data while 
treating HTTP data with lower priority. 
Range: 0 to 7 
Default: 0

TPID 8100 
Hex

The VLAN TPID 8100 hex is a 16-bit 
field that identifies frames according 
to IEEE 802.1Q (VLAN-tagged 
frame). It also makes it possible to 
use all network paths actively accord-
ing to IEEE 802.aq (shortest path 
bridging, SPB).

88A8 
Hex

VLAN TPID 88A8 supports provider 
bridging according to IEEE 802.ad. It 
also makes it possible to use all net-
work paths actively according to IEEE 
802.aq (shortest path bridging, SPB).

Default: 88A8 Hex

Layer 3 IP version Determines which IP version is to be used. 
IPv4: Internet Protocol version 4 acc. to RFC 791 
IPv6: Internet Protocol version 6 acc. to RFC 2460 
Default: IPv4

Own IP 
mode

For IP address assignment, this determines whether a static IP 
address is to be used or whether a server (remote station) issues 
the IP address (DHCP client). 
Default: Static IP

Own IP 
address

Own ARGUS IP address 
Range: Range 0.0.0.0. to 255.255.255.255 
Default: 0.0.0.0 (assignment see RFC 3330)

The layer-2 settings are also relevant when conducting a layer-3 
loop. Even if only layer 3 is selected, you may need to configure 
layer-2 settings.
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13 Loop
Contains received Ethernet packets:

VLAN mode no VLAN one VLAN two VLANs

No VLAN x x x

1. VLAN tag 

(C-VLAN)

- ARGUS loops when the 
VLAN IDs and TPIDs 
contained in Ethernet 
packets agree with the 
VLAN 1 settings.

ARGUS loops when the first VLAN ID 
(also called outer or service ID) and 
TPID contained in Ethernet packets 
agree with the VLAN 1 settings.

1. VLAN tag 

(C-VLAN) 

and 2. VLAN 

tag  

(S-VLAN)

- - ARGUS loops when the first VLAN ID 
(also called outer or service ID) and 
TPID contained in Ethernet packets 
agree with the VLAN 2 settings and 
the second VLAN ID (also called the 
inner or customer ID) and TPID agree 
with the VLAN 1 settings.

- = ARGUS does not loop. 

x = ARGUS loops regardless of whether the received Ethernet packets contain VLANs.

Notes for the use of VLANs
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13 Loop
Starting the loop (access mode: SHDSL STU-R ATM)
ARGUS in status screen. 
 

Continued on 
next page

Establishing the SHDSL connection 
 
The profile shown in the display (profile 1 
in this example) is used for the loop. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

<Setting>

 

<Start> Activates SHDSL.

<Info> Displays SHDSL connection 
parameters.

<Test> Displays the available tests.

<Stop> Stops SHDSL connection.

Changes loop parameters, 
see page 134.
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13 Loop
 
The loop is started: 

 
Saving the results
You can save the results for the loop test in the same way as for VDSL, see page 82.

 

Duration Current duration of test

Looped Number of packets looped 
so far

Looped 

in 1s

Number of packets looped 
in the current second

Loop 

rate

Displays the current data 
rate per second.

MAC 

address

Own MAC address of 
looping device (e.g. for entry 
in the traffic generator).

<Status> Displays status screen without 
ending the test.

Duration Overall duration of test.

Looped Number of looped packets.

avg. Number of looped packets per 
second.

<Status> Display of status screen.

Connection statistics are not recorded during the loop tests (in SHDSL access). 
ARGUS resumes saving of these statistics when the test is ended.

Connection statistics are not recorded during the loop tests (in SHDSL access). 
ARGUS resumes saving of these statistics when the test is ended.
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14 IP tests
14 IP tests

14.1 IP ping

In IP ping, ARGUS tests whether a connection exists via Ethernet, G.fast or xDSL using a 
DSLAM and whether the ATM/IP network to the internet service provider (ISP) or another 
computer or server address is possible. ARGUS sends a test packet to a specified IP 
address (remote station) and waits for a response packet. On the basis of the received 
response packet, is it possible to draw conclusions as to the availability and delay of the 
ATM/IP network. It is also possible to measure the maximum data packet size of the path. 
 
The IP ping the following parameters:

Protocol-independent parameters
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 35. 

Setting Description
Test parameters:

IP ping:

IP address Address of remote station. ARGUS can store up to 10 IP addresses. 
The stored IP addresses are available in all profiles.

 
ARGUS displays the ten available slots for  
IP addresses. Mark the line with the IP 
address you wish to edit using the cursor 
keys (in this example the first slot is marked 
(1/10)).

as name, IPv4 or IPv6 
number

Continued on next 
page

 

 
 
The address can be saved in the form of 
an IPv4 number, IPv6 number or a 
name. 
Default: www.argus.info

<Edit> Edits the selected IP 
address.
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14 IP tests
Enter the IPv4 or IPv6 address as a 
number. The editable area is highlighted in 
blue. Enter the address using the number 
keys.

<Delete> Deletes the place in front of 
the cursor.

 

to  

When entering an IPv6 
address, the letters A-F are 
available using these key 
combinations.

Adopts the marked IP 
address as the default.

Toggle entry using the softkey (right 
softkey changes the meaning when 
pressed). Enters the address as name, 
see user name page 112.

<Ab>AB> Entry begins with upper-
case letters and continues 
in lower-case.

<AB>12> Entry of upper-case letters.
<12>ab> Numerical entry.
<ab>AB> Entry of lower-case letters.

or

 
Entry of special characters, 
e.g. @, /, -, . or 
_, :, ~, +, ...

Moves the cursor in the 
display line

Number of pings Enter the number of pings that ARGUS sends to the IP address. 
When 0 is set ARGUS sends continuously until the test is cancelled 
manually. Range: 1 to 99999 
Default: 10 

Pause Defines a pause between two test packets. 
Range: 0.1 - 9.9 seconds 
Default: 1 second  

Packet size Sets the size of the test packet. 
You can determine the maximum packet size and the response time 
as as function of size by varying the packet size. 
Range: 36 to 55,555 bytes 
Default: 84 bytes

IP address as IPv4 number

IP address as IPv6 number

You can use square brackets to 
include port information with IPv6 
addresses in "IP address as 
name".
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14 IP tests
Starting IP ping (example access mode VTU-R, already active):
Establishing the service 
 
The profile shown in the display  
(profile 1 in this example) is used for the 
IP ping. 

If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (see page 57).

The service Data and the VDSL 
connection are active. 
 

Continued on next page

Fragmentation Sets the fragmentation 
Default: on

on Test packets may be fragmented into multiple packets 
depending on the network (or router).

off Fragmentation prohibited, i.e. the test packets may be 
rejected by the network (or routers) (ARGUS does not 
receive a response packet).

auto ARGUS determines the maximum packet size of the 
path to the destination address (path MTU) and 
fragments the test packets so that the packets are 
transmitted with minimum delay (no fragmentation by 
the network/router necessary).

<Edit> A virtual line is allocated to the 
service Data. 

<Info> Duration of activation.

<Test> Opens test selection.

<Stop> Deactivates the service.
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14 IP tests

g 
 

s 

.

 
 
 

 
 
ARGUS displays the addresses stored in 
the protocol. 

 

The IP ping starts automatically. 
 
Display during the IP ping test: 

 
e.g. select IP ping

<Setting> Changes IP ping 
parameters, see page 141.

Select the address for the ping; 
the default is indicated with .

<Edit> Edits the address, see 
page 141.

In this example a ping test is 
conducted with IP version IPv4.  
Use with IPv6 is analogous.

- Number of test packets sent

- Number of response packets

- Minimum time in ms

- Maximum time in ms

- Average time in ms

<Desti-
nation 
address>

Display of URL and IP address.

<Test 
status>

Displays test status without endin
the test or starting a new test, see
page 236.

Cancels test 
ARGUS displays the test results 
acquired up to this point and offer
you the option of saving them 
(automatic prompt); see page 146

Initialisation

IP ping
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14 IP tests
ARGUS displays the results when the test 
is finished:

 

Display of test status: 
You can observe the running test or start a 
new test here, see page 236.

- Number of packets sent

- Number of packets received

- Number of packets repeated

- Checksum errors

- Number of packets received with error

- Minimum packet response time in ms

- Maximum packet response time in ms

- Average packet response time in ms

<Desti-
nation 
address>

Displays the URL and the IP 
address.

<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 236.

<New> Starts a new IP ping test.

<New> Selects a new single test.
<Stop> Stops the IP ping test.

Press shift:

<Stop all> Stops all active tests. 
<Finish all> Finishes all test.

Continued on 
next page

IP ping result

2x 
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14 IP tests
 
 
 
 
 

Sends trace file to PC, see page 116
 
 
 
A new test can be started as needed. The 
xDSL link and the service are still 
connected (the connection can be 
disconnected in the status screen with 
<Stop>).

Error messages in IP ping
ARGUS displays an error message as 
soon as an error occurs.

 
 

For a description of error messages, see 
the Appendix, page 322 ff.

<Yes> ARGUS saves the result of the 
IP ping test to the first free 
storage slot in internal memory 
(see page 285).

<Back> ARGUS returns to the test result 
without saving results.

<No> ARGUS returns to the last 
selection menu without saving 
results.

<Test status> Display of status screen.
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14.2 Traceroute

In IP traceroute, ARGUS sends test packets and displays all hops and their response times 
on the way to the destination address. This data enables precise localisation of possible 
delays in the network. 
The following parameters must be saved in the profile for the IP traceroute:

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 35.

Setting Description

Test parameters:

Traceroute:

IP address The IP address of a destination node can be entered as either an IP 
number or a name (URL), see IP ping/IP address for instructions, 
page 142. 
Default: www.argus.info

Maximum hops Maximum number of hops over which the path to the destination 
address node is tracked. 
Range: 1 to 25 
Default: 25

Probes Number of attempts to address a network node. 
Range: 1 to 10 
Default: 3 

Timeout Maximum wait time for the response of a network node. 
Range: 0.05 - 9.9 seconds 
Default: 3 seconds
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14 IP tests
Starting traceroute  

(Example: access mode VTU-R, already active)

Connecting the service. 
 
 
 
The profile shown in the display  
(profile 1 in this example) is used for the 
traceroute test. 

 
If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (see page 57). 
 
The service Data and the VDSL 
connection are active. 
  

 

 

 

<Edit> A virtual line is assigned to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

 
e.g. select Trace route

<Setting> Changes traceroute 
parameters, see 
page 147.

Continued on next 
page
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te 
.

 

t 

 

g 
 

 

ARGUS displays the IP addresses or 
URLs saved in the protocol. 

The traceroute test starts automatically. 
 
Display during the traceroute test:  

Display of test status: 
You can observe the running test or start a 
new test here, see page 236.

Select the address for the tracerou
test; the default is indicated with 

<Edit> Edits the address,  
see page 141 for instructions.

In this example a traceroute test is 
conducted with IP version IPv4.  
Use with IPv6 is analogous.

- Current hop and attempt ("probe"), in this
example: 
3 - 3: i.e. 3 hops and 3rd attempt.

- Response time of hop for current attemp
(0.015 seconds).

- IP address of current hop, in this 
example 192.168.111.1 with name where
applicable.

<Desti-
nat.>

Display of URL and IP address.

<Test 
status>

Displays test status without endin
the test or starting a new test, see
page 236.

Cancels test 
Displays the test results up to this
point, with possibility of saving 
(automatic prompt).

<New> Selects a new single test.
<Stop> Stops the traceroute test.
<Stop all> Stops all active tests. 
<Finish all> Finishes all test.

Initialisation

Traceroute
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f 
 

Display after end of traceroute:
  

 

Exits results. 

 
Saves the traceroute results (see also IP ping, page 146).  
Sends trace file to PC, see page 116.

- All hops and their response times are 
displayed.

<Detail> Displays the name of the IP 
address of the hop (if possible).
The details of the hop at the top o
the list are displayed (in this 
example hop 1).

<> Switches to next hop, in this 
example hop 2.

<> Switches to previous hop.

Save result?

Traceroute result
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14.3 HTTP download

In HTTP download, ARGUS downloads the data of a website or file. ARGUS displays the 
current "net download rate", the usable data of the IP packets, and following conclusion of 
HTTP download the average speed (for multiple download attempts). 
The following parameters must be saved in the profile for the HTTP download:

It is not possible to obtain meaningful speed values for download tests with a 
duration of less than 10 seconds; therefore you should download as large a file as 
you can (depending on the access speed). If the duration of the test is less than 
10 seconds, ARGUS does not display any data rate or time.

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 35.  

Setting Description

Test parameters:

HTTP download:

Server 
profile:

You can create up to 15 user-defined server profiles that can be used for 
HTTP and FTP download and FTP upload. The profiles contain all 
parameters for HTTP and FTP download and FTP upload.

Server 

address

Entry of server address or URL of the server from which ARGUS 
downloads the file. For upload test: entry of upload destination address  
(server address) to which ARGUS sends the file. 
See page 141 for information on using the softkeys.

Download 
file name

Name of the file with the data that ARGUS downloads for tests (HTTP 
download and FTP download).  
Observe the notes for www alias addresses! (see page 152). 
If a specific port is required please enter it into the server address. 
See page 141 for information on using the softkeys.

Upload 
file name

Entry of the file name under which the file sent to the server in the FTP 
upload test is stored. 
Default: file

Upload 
file size

Sets the size of the file that ARGUS sends in FTP upload. 
Range: 0 to 1000 Mbyte 
Default: 100 MByte
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If a www alias address is entered as the "Source/destination address", ARGUS 
downloads "only" the HTML page in HTML download. ARGUS does not evaluate 
the HTML code, so that any link to a "real" www address is not considered. In this 
case, ARGUS does not indicate an error, as the HTML page of the specified 
"Source/destination address" was loaded without error. 
 
When entering the "Source" address (server address and download file name), 
be sure to observe the correct capitalisation; otherwise ARGUS will return error 
301 (Moved Permanently) or 404 (Not Found). 
 
When requesting multiple download components, ARGUS may reduce the 
number of downloads depending on the server support, which can cause 
deviations from the set parameters. This can occur e.g. as soon as the size of the 
requested file is unknown.   
 
If the download file name exceeds the maximum permissible length, you can 
work around this limit by fragmenting the address and additionally using the 
"Server" field. 
The server name may be up to 80 characters long, the file name 60 characters 
long. 
 

 

User 
name

Name of the user for the (FTTP, HTTP) file server. 
See page 141 for instructions

Password Password entry for the (FTTP, HTTP) file server (max. 40 characters). 
See page 141 for instructions

Number Number of times ARGUS downloads the file in the download test. For 
upload test: number of times ARGUS uploads the file in the upload test. 
"Zero" means infinite: the test continues until stopped manually. 
Range: 0 to 9,999 bytes (0=infinite) 
Default: 3

No. parall. 
down.

Number of packets into which the requested download is fragmented 
and simultaneously downloaded (see below).  
Range: 1 to 10  
Default: 3

Profile name Enters a name for the profile.
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Starting HTTP download (example: access mode VTU-R, already active)
Connecting the service. 
 
 
The profile shown in the display  
(profile 1 in this example) is used for HTTP 
download. 

 
 
If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 57). 
 
 
 
 
 

 

 

<Edit> A virtual line is added to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

 
e.g. select HTTP download

<Profile> Displays the available 
HTTP download profiles.

Continued on 
next page
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Mark the server profile:  
(default is indicated with ). 
 
The server profiles are also used for FTP 
download and FTP upload. 
 
 
 
 
 
 

HTTP download starts automatically. 
 
Display during HTTP download: 

<Edit> Edits the marked profile, 
see page 151 for changes to 
the individual settings.

- Current download/total number of 
downloads, in this example the first 
download attempt out of three (1/3) is 
displayed.

- Data already transferred (current / 
overall) (in this example 6 % / 2 %).

- Current net download rate  
(in this example 72,787 Mbit/s).

- Current net average download rate  
(in this example 62,434 Mbit/s).

- Bytes transferred so far  
(in this example 181,980 MB).

- Size of file to be downloaded  
(in this example 953,673 MB).

- Current and overall transferred data

- Transfer time so far in h:min:s.

- Remaining transfer time in h:min:s.

- Number of parallel downloads.

<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 236.

Cancels test.

Initialisation

HTTP download
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s 
Display of test status: 
You can observe the running test or start a 
new test here, see page 236.

 

 
Display of results: 

 
 
 
 
 
Exits results. 
 
Saves HTTP download result, see 
page 145. 
Sends trace file to PC, see page 116

<New> Selects a new single test.
<Stop> Stops HTTP download test.

Press shift:

<Stop all> Stops all active tests. 
<Finish all> Finishes all test.

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 236.

<New> Starts a new HTTP download.

- Calculated average speed of all download
(in this example 70,706 Mbit/s). 

- Average time required for a download in 
h:min:s.

- Transferred file size  
(in this example 953,673 MB).

- Maximum parallel downloads.

- Configured parallel downloads.

HTTP download result

Save result?
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14.4 FTP download 

In FTP download, ARGUS downloads data in the form of a file. ARGUS displays the 
current net download rate, the usable data of the IP packets, and following conclusion of 
test the average speed (for multiple download attempts).

No meaningful evaluations are possible for download tests with a duration of less 
than 10 seconds. Therefore, the download file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10 
seconds, ARGUS does not display any data rate or time.

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 35. See page 151 HTTP download for an explanation of the test parameters. 

Starting FTP download (example: access mode VTU-R, already active)
Connecting the service.

The profile shown in the display  
(profile 1 in this example) is used for FTP 
download.

 

If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 57). 
 
 
 
 

 

<Edit> A virtual line is added to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

Continued on 
next page
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Mark the server profile  
(default is indicated with ). 
 
The server profiles are also used for 
HTTP download and FTP upload. 
 
 
 
 

 
FTP download starts automatically. 

 
e.g. FTP download

<Profile> Displays the available 
FTP download profiles.

<Edit> Edits the marked profile, 
see page 151 for changes to 
the individual parameters.

Initialisation
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Display during FTP download: 

Display of test status: 
You can observe the running test or start a 
new test here, see page 236.

- Current download/total number of 
downloads, in this example the first 
download out of three (1/3) is displayed.

- Data already transferred so far (current 
/ overall (in this example 5 % / 1 %).

- Current net download rate  
(in this example 72,641 Mbit/s).

- Current net average download rate  
(in this example 60,534 Mbit/s).

- Bytes transferred so far  
(in this example 95,309 MB).

- Total download file size  
(in this example 952,153 MB).

- Current and overall transferred data

- Duration of test so far 
(in h:min:s).

- Remaining transfer time.

- Number of parallel downloads.

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 236.

Cancels test.

<New> Selects a new single test.
<Stop> Stops FTP download test.

FTP download
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Display after end of FTP download: 

 
 
 

 
 
Exits results. 

 
For saving results, see IP ping page 145. 
Sends trace file to PC, see page 116. 

<New> Selects a new single test.
<Stop> Stops FTP download test.

Press shift:

<Stop all> Stops all active tests. 
<Finish all> Finishes all test.

- Calculated average speed of all down-
loads (in this example 70,371 Mbit/s).

- Average time required for a download in 
h:min:s.

- Transferred file size 
(in this example 952,153 MB).

- Overall Transferred data 
(in this example 268,732 MB).

- Maximum parallel downloads.

- Configured parallel downloads.

FTP download result

Save result?
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14.5 FTP upload

In FTP upload, ARGUS sends the data of a file to a server. Among other information,  
ARGUS displays the current net upload rate, the usable data of the IP packets, and 
following conclusion of test the average net speed (for multiple download attempts).

No meaningful evaluations are possible for upload tests with a duration of less 
than 10 seconds. Therefore, the upload file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10 
seconds, ARGUS does not display any data rate or time.

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 35. See page 151 HTTP download for an explanation of the test parameters. 

Starting FTP upload (example: access mode VTU-R, already active)
Connecting the service. 

 
The profile shown in the display (in this 
example profile 1) is used for FTP upload.

If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 57). 
 
 
 
 

<Edit> A virtual line is assigned to the 
service Data.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

Continued on 
next page
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Mark the server profile  
(default is indicated with ). 
 
 
The server profiles are also used for HTTP 
download and FTP download. 
 

 
 

 
FTP upload starts automatically. 

 
e.g. FTP upload

<Profile> Displays the available FTP 
upload profiles.

<Edit> Edits the marked profile, 
see page 151 for changes to 
the individual parameters.

Initialisation
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Display during FTP upload: 

Display of test status: 
You can observe the running test or start a 
new test here, see page 236.

- Current upload/total number of uploads, 
in this example the first upload out of 
three (1/3) is displayed.

- Data already transferred (current / 
overall) (in this example 13 % / 4 %).

- Current net upload rate 
(in this example 15,030 Mbit/s).

- Current net average upload rate 
(in this example 14,935 Mbit/s).

- Bytes transferred so far 
(in this example 22,062 MB).

- Overall file size 
(in this example 100,000 MB).

- Current and overall transferred data

- Current upload time in h:min:s.

- Remaining transfer time.

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 236.

Cancels test.

<New> Selects a new single test.
<Stop> Stops FTP upload test.

Press shift:

<Stop all> Stops all active tests. 
<Finish all> Finishes all test.

FTP upload
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Display of results

 
 

 
 
 

 
 
For information on saving results, see IP 
ping page 145. 
Sends trace file to PC, see page 116.

<Test 
status>

Display of test status.

<New> Starts a new FTP upload test.

FTP upload result

Save result?
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14.6 FTP server

In FTP server mode, ARGUS behaves like a server for FTP requests. In this mode, 
ARGUS serves FTP download and FTP upload requests.  
These requests can be sent from a second terminal device (e.g. another ARGUS unit) via 
an xDSL or Ethernet access. 
This makes it possible to test end-to-end throughput and determine the maximum possible 
data rate for this access. 
 
In the following, the throughput test is explained using the Ethernet interface as an  
example. This example uses two ARGUS units. One serves as the FTP server while 
another requests the FTP download. 
 
ARGUS 1 - FTP server
 
No settings need to be configured on the ARGUS used as the FTP server. The FTP server 
test just needs to be started on the selected interface. 
 
Starting FTP server (example: Ethernet, already active)

Continued on next 
page

Connecting the service. 
 
The profile shown in the display  
(profile 1 in this example) is used for the 
FTP server. 

 

 
 
If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 57). 

<Edit> A virtual line is assigned to the 
service Data.
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Initialisation

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
ARGUS uses the IP address configured 
under "own IP address" as the destination 
address (server) for the second ARGUS 
unit. 

<Test 
status>

 

ARGUS 1 now waits for an FTP request from a second terminal device (in this example the 
second) ARGUS). 
The IP mode in this example is "static", the default IP netmask configuration is used.

 
e.g. FTP server

Displays test status without 
ending the test or starting a 
new test, see page 236.
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ARGUS 2 - FTP down/upload
 
In principle, you can adopt the same configuration for the ARGUS unit sending the FTP 
request (FTP download in this example) as in an FTP download test. 
The netmask and IP address (IP mode: static) should match the settings on ARGUS 1.
 
Starting FTP download:

Connecting the service. 
 
The profile shown in the display  
(profile 1 in this example) is used for the 
FTP server. 
 
 
 

 

Continued on 
next page

 
If no connection is established, ARGUS 
automatically connects at this point using 
the default profile (see page 57). 
 
 

<Info>

<Test>

<Stop>

<Edit> A virtual line is assigned to the 
service Data.

Duration of activation.

Opens test selection.

Deactivates the service.
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Continued on 
next page

Test selection 
 
 

 

<Profile>

 

 
 
Mark the server profile  
(default is indicated with ). 
 
 
 
 
 

<Edit>

 

 
 

See page 151 HTTP download for an 
explanation of the test parameters.

 
e.g. FTP download

Edits FTP parameters,  
see page 151.

Edits the marked profile, 
see page 151 for changes to 
the individual parameters.
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Download file name

 
 
 
 
Enter the address of ARGUS 1 in the 
server profile of ARGUS 2 as the server IP 
address, see page 165. 

<Delete>

<12>AB>

 

 
 
 
 
 
 
 
 
In this case too the download file name is 
the size of file to be downloaded. The file 
size is specified in bytes. 
Download file name: 1,000,000,000
results in a file size of: 1 GB. 
 
 

 
 
 

No meaningful evaluations are possible for download tests with a duration of less 
than 10 seconds. Therefore, the upload file should be as large as possible 
(depending on the access speed). If the duration of the test is less than 10  
seconds, ARGUS does not display any data rate or time.

 
 
 
 
 

Deletes the place in front of 
the cursor.

see page 112.
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FTP download

Server profile

Initialisation

 
 
 
 
 
 
 
 
 
 

<Edit>

 

 
FTP download starts automatically. 
 

Display during FTP download:

<Test 
status>

 

Edits the marked profile, 
see page 151 for changes to 
the individual parameters.

- Current download/total number of 
downloads, in this example the first 
download out of three (1/3) is displayed.

- Data already transferred (current / 
overall) (in this example 5 % / 1 %).

- Current net download rate  
(in this example 72,641 Mbit/s).

- Current net average download rate  
(in this example 60,534 Mbit/s).

- Bytes transferred so far 
(in this example 95,309 MB).

- Total download file size 
(in this example 952,153 GB).

- Current and overall transferred data

- Current upload time in h:min:s.

- Remaining transfer time.

- Number of parallel downloads.

Displays the test status without 
ending the test.

Cancels test.
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Display after end of FTP download:

 
 
 
 
 
 
 
Exits results display. 
 
 
 
For saving results, see IP ping page 145. 
Sends trace file to PC, see page 116. 

<New> Selects a new single test.
<Stop> Stops FTP download test.

Press shift:

<Stop all> Stops all active tests. 
<Finish all> Finishes all test.

- Calculated average speed of all 
downloads 
(in this example 70,371 Mbit/s).

- Average time required for a download in 
h:min:s.

- Transferred file size 
(in this example 952,153 MB).

- Transferred data overall 
(in this example 268,732 MB).

- Maximum parallel downloads.

- Configured parallel downloads.

Save result?

FTP download result
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14.7 Textbrowser

The text browser can display the first 50 lines of text of an HTML web page.

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 
page 35 

Starting Textbrowser:
Establishing the service 

The profile shown in the display (profile 1 
in this example) is used for the text 
browser.

<Edit>

 

If no xDSL or Ethernet connection is 
established, ARGUS automatically con-
nects at this point using the default profile 
(s. page 57). 

The service Data and the VDSL
connection are active.. 

<Info>

<Test>

<Stop>

Continued on next page.

Setting Description

Test parameter:

Textbrowser:

Settings The IP address of a destination node can be entered as either an 
IP number or a name (URL), see IP ping/IP address, see page 142 
for instructions. 
Default: www.argus.info/textbrowser/

A virtual line is allocated to the
service Data.

Duration of activation.

Opens test selection.

Deactivates the service.
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g 
 

 

Continued on next 
page

<Setting>

Select URL.
You can configure up to 20 URLs, see 
„Access name“ on page 28.

If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (s. page 57).

 
e. g. text browser 

Changes text browser 
parameters, see 
page 147.

<Desti-
nation>

Displaying the URL and the IP 
address.

<Test 
status>

Displays test status without endin
the test or starting a new test, see
page 236.

Cancels test 
Displays the test results up to this
point, with possibility of saving 
(automatic prompt).
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Display of test status: 
You can observe the running test or start 
a new test here, see page 236.

For saving results, see IP ping page 145. 
Sends trace file to PC, see page 116.

<New> Selects a new single test.
<Stop> Stops text browser.

Press shift:

<Stop 
all>

Stops all active tests. 

<Finish 
all>

Finishes all test.

Save result?
ARGUS 166 173



14 IP tests
174 ARGUS 166



15 Network scan
15 Network scan

In a network scan, ARGUS identifies and displays all hosts, services and servers in a pre-
configured subnet. The network scan can only be executed on an Ethernet interface.  
Scanning via DSL or G.fast is not possible.

The network scan requires the following parameters. 
 

Protocol-independent parameters:
The opening of test parameters is described in the chapter "Configuring accesses", see 

page 35

Mode

Network 

address

Netmask

 

When scanning a network, please observe the applicable legal and data 
protection requirements.

Setting Description

Test parameter:

Network scan:

In "Manual" mode, the network scan uses the stored network address and 
netmask. In "Automatic" mode, the instrument reads the parameters from 
the connected DHCP server. 
Default: Manual

The network address specifies the subnet to be searched for hosts and 
services.  
Range: 0.0.0.0 to 255.255.255.255 
Default: 192.168.1.0

The netmask is a part of the network address and describes the size of the 
subnet. 
Range: 0.0.0.0 to 255.255.255.255 
Default: 255.255.255.0

 

ARGUS only scans a limited number of hosts, services and servers. The subnet 
to be scanned should thus always be sized as small as possible; otherwise 
ARGUS will not show any results.
 

ARGUS still communicates with the DHCP computer even when Manual is 
selected. When the server returns an IP address that is not in the same subnet as 
the manually configured one, the test fails.
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Starting network scan (example: access mode Ethernet, already active)

Connecting the service 
 
 
 
The profile shown in the display (profile 1 
in this example) is used for network scan. 

 
If no connection is established, ARGUS 
automatically connects at this point using 
the default profile  

 

 
  

 

 
The network scan starts automatically.  

<Edit> A virtual line is added to the 
service Data. 

<Infos> Duration of activation. 
<Test> Opens test selection. 
<Stopp> Deactivates the service. 

 
e. g. Network scan

<Setting> Changes network scan 
parameters, see page 175.

Initialisation

Continued on next 
page
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n 
d 

g 
e 

e 
Network scan 

Continued on next 
page 

Display during the network scan: 

In this example, a request to the DHCP 
server is running.  

In this example, DHCP Discovery was ter-
minated, and the instrument scans for all 
available clients.

<Test 
status>

The network scan was completed. You 
can now view the results using the corre-
sponding menu options.

- Display the status of: 
- DHCP discovery 
- Clients 
- Services

- Running time in h:min:s

 

Information that is unavailable is 
grayed out.

The duration of the scan depends o
the size of the network (netmask) an
the number of hosts found.

Displays test status without endin
the test or starting a new test, se
page 236.

 

A maximum of 50 entries per test ar
saved. 
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g 
 

Netzwork scan result

Continued on 
next page

Clients

 

 
DHCP discovery: 

To access the clients, close the results of 

DHCP Discovery with  and select 

"Clients".

Identified clients
In this example, all clients in the same 
subnet are displayed. The number of 
ports for each client (IP) is also shown in 
square brackets.

<Tes 
status>

Select a client.

Selection of  
- DHCP discovery
- Clients or
- Services 
by using the cursor keys. 

- Current Gateway

- Current DHCP server

- Current DNS server

- Current netmask

- Number of detected clients

Displays test status without endin
the test or starting a new test, see
page 236.
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g 
e 
Save results?

Services

Tests results of the selected client: 

To access the services, close the results 

of clients with  and select "services".

Identified services:
Display of services present in the 
scanned network. The number of servers 
for each service found is also shown in 
square brackets. 

<Test 
status>

In this example: list of web servers in this 
network. 

Exits results 

For saving results, see IP ping page 145.

- IP address 

- MAC address

- Computer name

- NetBIOS name

- Open ports

Displays test status without endin
the test or starting a new test, se
page 236.

Select of server type.
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16 VoIP tests

ARGUS operates as a VoIP terminal device with active acoustics, enabling voice links.  
Session Initiation Protocol (SIP) is available as a VoIP signalling protocol. Calls can be 
established both with and without registrar/proxy. ARGUS can be used to establish VoIP 
connections (DSL telephony) via xDSL, G.fast and Ethernet. To assess voice quality, 
ARGUS determines and displays the MOS/R-factor and the RTP datastream. 
You can configure threeVoIP "accounts" (profiles):

Protocol-independent parameters:
ARGUS in status screen. 
 
 
 
 

 
 

 
 
 
 

<Edit> A virtual line is assigned to 
the service VoIP.

<Profile> See page 35 for profile 
settings.

<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the default profiles for 
establishing the Ethernet, G.fast or 
xDSL connection and conducting 
the VoIP test. 

ARGUS uses the marked profile as 
the default profile and switches to 
the menu Settings. 

Continued on 
next page

Services

Service VoIP
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A total of three user-defined VoIP profiles 
are available. 
 
 
 
 
 

 
Edits the marked profile. 
 
 
 
 
 

<Edit> Edits the VoIP profile.

VoIP account

Edit the marked 
parameters.
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Setting Description

VoIP account settings:

VoIP: You can create a total of three VoIP profiles. 
<Edit> Activates the profile you wish to edit.

SIP User name User name for registrar, see page 112 for instructions.

Password Password for the registrar, see page 112 for instruc-
tions.

Authentication Additional xTU-R password for legitimate authentica-
tion. 
See page 112 for instructions

Caller ID Optional entry of a user-definable text which then 
appears in the display of the called party in place of the 
caller's originating number. 
See page 112 for information on using the softkeys.

Registrar 
Server

Use registrar: select yes or no 
If an internet telephony service provider (ITSP) is used 
(in this case you dial a normal telephone number), a 
registrar must be used as well. If a VoIP telephone is 
dialled directly, e.g. via the IP address or SIP URL, no 
registrar is needed. You can edit and use an IPv4 or 
IPv6 address as well as a name for the registrar server. 
The address is edited in the same way as for the IP 
ping test, see page 141. 
Default: no

Outbound proxy/
SBC 

Use proxy  (SBC = session border controller) 
Determines whether an outbound proxy is to be used. 
Default: no

Outbound proxy/SBC: address of proxy server. The out-
bound proxy/SBC is configured in the same way as for 
the IP ping test, see page 141.

Outbound proxy/SBC port: port of proxy server. 
Range: 0 to 65535 
Default: 5060

DNS resolution You can define the type of DNS resolution here. 
Choose SRV Record or A/AAA Record.
Default: SRV Record
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SIP trunking Use trunking SIP trunk makes it possible to manage 
multiple different numbers, each with its 
own extensions, using a single access 
account. 
Default: no

CLIR The setting CLIR (calling line 
identification restriction) can be used to 
suppress the originating caller ID. 
Default: no

Own basic 
number 

The trunk number is a telephone 
number with no extension. 
Default: 4923519070 

Own exten-
sion (DDI)

DDI enables the desired access to be 
dialled directly. You can edit the 
extension using <Edit> (up to 4 
characters). 
Default: 0 

Transport  
protocol 

Determines which transport protocol is to be used. 
Choose between UDP and TCP. For the setting "TCP 
fallback", ARGUS attempts to use the TCP protocol 
instead of the UDP protocol for a data stream with large 
packets. The TLS protocol (formerly SSL) is a hybrid 
encryption protocol for secure data transmission. 
Default: TCP fallback 

SIP domain Configuration of the domain name for the "from" field in 
the SIP message (when using an ITSP). 

Listen port Port used for incoming SIP signalling.  
Range: 0 to 65535  
Default: 5060

Remote port Port used at the remote station:  
When a registrar is used (see "registrar server" setting 
on page 182), entry of the port number of the registrar/
proxy server, otherwise entry of the port number at the 
remote station. Range: 0 to 65535 
Default: 5060

User agent ID string/terminal device type is transmitted to the  
called party. 
Default: Argus166
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Reg. expire Determines the period of validity of registration with the 
registrar.  
Range: 10 - 6000 seconds 
Default: 3600 seconds

Qualify Determines whether the availability of the proxy service 
is to be continuously verified.  
Default: no

Retry-after Following a failed registration, the standard calls for a 
100 second delay before attempting to register again 
(standard). When "ignore" is set, registration is 
repeated in increasing intervals (1 second several 
times, then 2 s, 4s, etc.). 
Default: standard

Delete exist. 
registrar

The current registration is cancelled at the registrar. If 
this is set to "yes", exclusive registration of ARGUS at 
the registrar server. Otherwise inclusion in the list of 
existing registration.  
Default: yes

Phone 

settings

RTP port range SIP signalling and RTP data are transmitted via differ-
ent ports. The port range used can be adjusted for RTP, 
e.g. to match a router.  
Range: 0 to 65535 
Default:  
Start: 10000  
End: 20000 

Silence 
detection

When this setting is "on", ARGUS does not transmit 
voice packets during pauses in speech. However, this 
can cause problems in port assignment behind a NAT 
router. When the setting "not used" is selected, the 
feature "silence detection" is not communicated to the 
remote station. However, it remains set. 
Default: off
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Jitter buffer Determines whether the size of the jitter buffer is static 
or adaptive. Default: static

static: Entry of a static jitter buffer size. 
Range: 20 to 200 ms 
nominal: 60 ms

adaptive: Entry of the minimum (min) and 
maximum (max) jitter buffer size and the 
initial value (init).  
Range: 20 to 600 ms 
Default: 
min: 60 ms  
init: 60 ms  
max: 120 ms

Codecs Prepares a list of the speech codecs to be used. For 
multiple codecs, the order determines the priority.

Switches to softkey assignment.

<> The selected codec is moved down one 
place in the list.

<> The selected codec is moved up one 
place in the list.

<Insert> A display with the available voice 
codecs opens. A voice codec marked 

with  in this selection menu is 

inserted in the voice codec list (via the 
voice codec marked in the list).

<Delete> Deletes the marked codec from the list.

Adopts the codec priorities.

Supported 
Codecs

G.729 A/B, G.726-40, G.726-32,  
G.726-24, G.726-16, G.722, G.711 A law, 
G.711 μ law, G.723.1
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Phone  

settings

(continued)

DTMF 
settings

Dual-tone multi-frequency (DTMF) is a multifrequency 
dialling method. 
Mode: Sets DTMF mode 
You can choose between "Automatic", "SIP info", "RFC 
2833" and "Inband". 
Default: Automatic 
Duration: Sets the VoIP DTMF timer 
Range: 40 to 1000 ms. 
Up to 200 ms in steps of 10, up to 300 ms in steps of 
20, up to 1000 ms in steps of 100.  
Default: 80 ms

  Increases or decreases the VoIP DTMF duration.

STUN server Use 
STUN

Use STUN: select yes or no 
If a NAT router is located between ARGUS and the 
nearest remote station (gateway), STUN must be used 
so that ARGUS can determine under which IP address 
the remote station sees ARGUS. Default: no

STUN server STUN server: address of a STUN server, which must be 
in the same network (on the same level) as the remote 
station.

Rated/

threshold 

value

MOS rates value Entry of MOS setting: 
The mean opinion score (MOS) assesses the quality of 
voice data. The MOS quality scale ranges from 5 
(excellent) to 1 (bad). On the basis of the set MOS 
value, ARGUS rates the current VoIP voice link as "OK" 
(current MOS value achieves MOS setting) or "FAIL". 
Range: 1.0 to 5.0 
Default: 4.0 

The MOS value here is stated as MOSCQE 
(conversational quality estimated). The use of a specific 
codec has a significant influence on this.

Jitter threshold Determines the threshold for the jitter. 
Range: 0 to 200 ms 
Default: * (off)

value 5 4 3 2 1

Voice quality excellent good fair poor bad
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RTP loss  
threshold

Determines the threshold for the RTP loss threshold. 
Range: 0 to 100 % 
Default: * (off)

Profile 

name

Enter/modify name of edited VoIP profile.

VoIP QoS (Quality of Service)

Layer 3 

DiffServ

Differentiated services: Classification/prioritisation of IP packets (L3)

RTP  

(ToS/DSCP)

ToS Type of service 
Field for setting the priority in the IP header of the usa-
ble data (RTP), see page 142 for further details. 
Range: 0 to 0xFF 
Default: 18

DSCP Differentiated services codepoint 
Field for setting the priority in the DS field (6 bits) of the 
usable data (RTP), see page 142 for further details. 
Range: 0 to 0x3F 
Default: 00

SIP  

(ToS/DSCP)

ToS Type of service 
Field for setting the priority in the IP header of SIP data 
(signalling), see page 142 for further details. 
Range: 0 to 0xFF 
Default: 18

DCSP Differentiated services codepoint 
Field for setting the priority in the DS field (6 bits) of the 
SIP data (signalling), see page 142 for further details. 
Range: 0 to 0x3F 
Default: 00

Layer 2 

VLAN Prio

The VLAN prioritisation on layer 2 is an extension of the Ethernet header.

RTP VLAN 

Prio

VLAN prioritisation of usable data (RTP) 
Range: 0 to 7 
Default: 0

SIP VLAN 

Prio

VLAN prioritisation of SIP data (signalling) 
Range: 0 to 7 
Default: 0
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16.1 Starting VoIP telephony

(Example: VDSL access, already active)
Connecting the service. 
 
 
The profile selected for xDSL connection 
(in this example profile 1) is also used for 
VoIP telephony. 
 
 
 

If no xDSL or Ethernet connection is 
established, ARGUS automatically 
connects at this point using the default 
profile (see page 57). 
 
 
 
 
 
 

 
 
 

 
 
 

<Edit> Edits the default virtual line 
profile. 

<Info> Duration of activation, 
page 193.

<Test> Opens test selection.
<Stop> Deactivates the service.

 
e.g. select VoIP call

Continued on 
next page
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Mark the VoIP destination 
(default is indicated with ). 
 
Scroll down with the cursor, mark a blank 
line and add a new VoIP destination using 
<Edit>. 

 

 
Connecting 
 
ARGUS displays "own number" (from:  
7087) and the number of the called 
subscriber (to: 87). The called subscriber 
has not yet accepted the call: display 
shows "Connecting!" and yellow CALL 
symbol. 
 
 
 
 
The called subscriber has taken the call 
("Connected!"): ARGUS determines the 
MOS value and displays whether the set 
MOS voice quality value (see page 186) is 
reached ("OK" or "FAIL"). ARGUS also 
displays the classification of the MOS 
value according to ITU-T P.800 (in this 
example "good"), the duration of the 
connection and the currently used voice 
codec (in this example G.711 A law, see 
page 185) are also displayed.

<Edit> Edits the VoIP destination 
number.

<Detail> Displays the VoIP parameters.
<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 236.

<Volume> Opens volume control.
Continued on 
next page

Initialisation

Continued on next page, 
second screenshot
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Volume control settings: 

 
 
 
 

VoIP overview display (for transmitted and 
received packets including assessment) 

 
 

<External> Headset mode
<Internal> Earpiece mode
<OK> Adopts settings

- 
- 
- 
- 
-

Status of MOS value (FAR-MOS/MOS) 
Jitter in ms  
RTP loss rate  
VLAN (prio) in hexadecimal  
TOS (hex) in hexadecimal

The FAR-MOS value is only 
displayed when the remote station 
supports RTCP. 

Displays MOS information:

- 
- 
- 
- 
 
-

Current MOS 
Average MOS 
Min./max. MOS value 
Ideal MOS (possible MOS without 
interference, codec-dependent) 
Current and average  
R-factor according to ITU-T G.107

Back to previous display.

<Detail>

Continued on 
next page
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Display of further VoIP results: 

RTCP content
Displays the statistics returned by the 
remote station.
- Current jitter of remote station Rx (far)
- Average jitter at remote station
- Maximum and minimum jitter of 
  remote station
- Lost RTP packets at remote station
   Rx (far): total, current, average, min. 
   and max.
- Delay calculated from transmission time  
  of RTCP packets (network delay):  
  current, average, min., max.

ARGUS displays the available codecs of 
the remote station. 

Packet statistics:

- 
- 
- 
 
 
- 
 
 
 
 
- 

Received packets (Rx) 
Transmitted packets (Tx)
Error counter: 
RTP drop 
RTP error
RTP jitter Rx: 
Current jitter 
Average jitter 
Minimum jitter 
Maximum jitter 
Lost RTP packets (Rx)  
Total, current, average, min. and max.

Back to display "Outgoing call"

If the message "no data" appears, 
that means that the remote station 
does not support RTCP.

Continue to display "Outgoing call"

<MOS> Back to display "MOS info", ring 
navigation

Return to status screen without 
ending the test.Continued on 

next page
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VoIP overview display (for transmitted and 
received packets including assessment) 

VoIP overview display (for transmitted and 
received packets including assessment) 

Back to the status screen without 
stopping the test.

ARGUS in status screen.  
Another test is still running using the 
service VoIP (indicated by the green 
hammer symbol). 
 

- 
- 
- 
- 
-

Status of MOS value (FAR-MOS/MOS) 
Jitter in ms  
RTP loss rate  
VLAN (prio) in hexadecimal  
TOS (hex) in hexadecimal

- 
- 
- 
- 
-

VLAN ID
VLAN prio RIP 
VLAN prio SIP
RTP TOS in hexadecimal  
RTP TOS in hexadecimal

 
Using the cursor keys, select the 
service VoIP.

Continued on 
next page
192 ARGUS 166



16 VoIP tests
 
 
 
 
 
 
 
 

 
 
ARGUS displays the duration of the active 
VoIP service, the protocol used and the 
user name. 
 

 
 

 
 
 
Before, during and after the connection, 
ARGUS displays the registration details. 
The setting "Use register" must be set to 
"yes". 
 
 
 
 
 

<Test> Displays the overview of 
results.

<Info> or 

 

Displays the VoIP calling 
parameters.

<SIP> Display of registration details: 
status codes, registrar IP, 
registrar used, outbound proxy/
SBC and URI used and more.

<Log.> Displays the VoIP service SIP 
commands, see page 194.

Continued on 
next page
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ARGUS displays the SIP commands in 
the service VoIP.

For more information ((s. chapter G) VoIP 
SIP status codes page 327). 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
ARGUS can be called while the service 
VoIP is active. An incoming call is 
indicated by the yellow CALL symbol. The 
call can be accepted or refused.
For automatic call acceptance, you need 
to start the specific test "VoIP wait", see 
page 198. 
 

<Time> Puts a timestamp on all events.

The timestamp uses the ARGUS-
internal system time, see page 305.

<Reject> Refuses the call.
Switches to status screen.

<Accept> Accepts the call. 
Switches to ARGUS status.

Incoming call:
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Display /description
SIP log Log showing the exchanged SIP methods 

and status codes.
Register status In the "Register status" result screen, ARGUS 

displays all important registration and registrar 
information.

Overview of VoIP results

During/after registration:

During call/connection:

Display/ Description
MOS value, voice codec Current MOS value, currently used voice codec.
SIP log: Log showing the exchanged SIP methods and status 

codes.
INFO: MOS results: Threshold: indicates whether the preconfigured 

MOS threshold is complied with.
P.800: Evaluation according to ITU-T P.800
MOS value: current/average/min./max.
R-factor: current/average/min./max.

INFO: RTP results RTP packets: received/sent
RTP drop: received packets rejected by the jitter 
buffer.
RTP error: received but defective RTP packets.
RTP jitter Rx:current/average/min./max.  
(Calculated according to RFC 3550 per sec.)
RTP packet loss Rx:current/average/minimum/
maximum in percent
RTP packet loss total: 
(RTP packets not received)

INFO: RTCP results: 
 

IP jitter remote side: current/average/mini-
mum/maximum

(The contents of the RTCP pack-
ets are displayed, provided this is 
supported by the remote side!)

RTP packet loss remote side: current/average/
minimum/maximum in percent
RTP packet loss remote side Total

Network delay:current/average/maximum/mini-
mum (calculated on the basis or RTCP packets)
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16.1.1 VoIP back-to-back

ARGUS permits a VoIP call to a second terminal device, e.g. another ARGUS unit. To 
enable calling, both ARGUS instruments must be configured as follows:

Now enter the IP address of ARGUS 2 in ARGUS 1 as the target telephone number to  
initiate a VoIP call. The IP address of ARGUS 1 must be entered as the target telephone 
number in ARGUS 2. The call is connected just as for VoIP-call/VoIP-wait, see page 188.

ARGUS 1 ARGUS 2

Access, s. page 25 Ethernet IP based

Protocol, s. page 110 IP

IP version, s. page 113 IPv4

IP mode, s. page 113 Static

Own IP address, s. page 113 In example 10.0.0.1 In example 10.0.0.2

ARGUS 1 ARGUS 2
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16.2 VoIP wait

In the test "VoIP wait", ARGUS behaves like a VoIP telephone. 
The VoIP call (see page 182) and the VoIP wait parameters must be configured for the 
VoIP wait test. 

Continued on 
next page

Connecting the service. 
 
 
The profile selected for connecting the 
service (in this example profile 1) is also 
used for VoIP wait. 
 
 
 

<Edit>

 

If no xDSL, G.fast or Ethernet connection 
is established, ARGUS automatically  
connects at this point using the default 
profile (see page 57). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

<Setting>

Edits the default virtual line 
profile.

Opens call acceptance mode 
for VoIP wait.
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The test VoIP wait offers the following  
configuration options:

 - Automatic 
 - Echo test 
Default: Automatic

 
Start VoIP wait

Continued on 
next page

Initialisation

The service VoIP and the VDSL 
access are active. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ARGUS uses the user name 
entered under SIP parameters 
(see page 182) as its own 
number.

 
Select VoIP wait
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ARGUS waits for a VoIP call. 
 
 
 
 
 
 
 
 
 

<Test 
status>

 

 
ARGUS accepts the call automatically 
(see setting page 198). 
 
 
The connection parameters are the same 
as for VoIP call and are explained on 
page 189 and following. 
 
 
 
 
 
 

 
Connecting: 

The connection is established as for IP ping. However, pressing "Cancel" initially 
only disconnects (if a connection existed). ARGUS remains registered with the 
registrar (service VoIP active) and remains available for the caller (an incoming 
call can be refused or accepted). Deactivate the service VoIP to terminate regis-
tration. However, the established access remains active.

Switches to test status, see 
page 189.
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16.3 VoIP call generator

(Example: VDSL access, already active)
Connecting the service. 
 
The profile selected for connecting the 
service (in this example profile 1) is also 
used for the VoIP call generator.. 

If no xDSL, G.fast oder Ethernet 
connection is established, ARGUS 
automatically connects at this point using 
the default profile (s. page 57). 
 
 

 
 
 

 
 
 

<Edit> Edits the default virtual line 
profile.

The service VoIP is greyed out 
when the VoIP option is not set..

<Info> Duration of activation, 
page 193.

<Test> Opens test selection.
<Stop> Deactivates the service.

 
 Select VoIP call generator.

Continued on 
next page.
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Mark the VoIP destination 
(default is indicated with  ). 
 
Scroll down with the cursor, mark a blank 
line and add a new VoIP destination using 
<Edit>. 

 

 
Connecting 
 
Up to 30 consecutive VoIP calls to a 
configured VoIP destination are 
established. The connection is maintained 
until the test is stopped.
As soon as a call is refused, ARGUS stops 
establishing further calls. Existing calls 
remain connected. If the remote station 
hangs up a call, this is indicated for that 
call. The test remains active until you 
press the “Stop” softkey – even if the 
remote station has terminated all calls.
 

The number of successful calls is 
displayed. These are the calls that were 
still connected when the test was stopped. 
Calls that were refused or terminated by 
the remote station are not displayed.

 

<Edit> Edits the VoIP destination 
number.

<Stop> Deactivates the call 
generator.

<Test 
status>

Displays the test status without 
ending the test, s. page 236.

<Restart> VoIP call generator is restarted.

Initialisation

Continued on 
next page.
ARGUS 166 201



16 VoIP tests
Displays the number of successful calls.

<New>

<Finish>

<Restart>

Selects a new single test.

Saves the result.

VoIP call generator is 
restarted.
202 ARGUS 166



17 IPTV tests
17 IPTV tests 

17.1 IPTV

ARGUS requests a datastream from a server (depending on the access type, ARGUS 
replaces the set-top box ( STB) or modem plus STB) and checks the regularity of the 
incoming packets, packet loss and the switch-on/switch-over time of the program. You can 
configure three user-defined IPTV profiles (where the xDSL, G.fast or Ethernet connection 
is already established, the connection parameters, e.g. the target value, are locked):

Protocol-independent parameters
ARGUS in status screen. 
 
The IPTV-STB emulation is realised using 
the service IPTV.  
The following example illustrates the 
procedure and its special features. 
 
 

 

 

<Edit> Assign virtual lines to the 
service IPTV. 

<Profile> See page 35 for profile 
settings.

<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the preset profiles for 
establishing the Ethernet, G.fast or 
xDSL connection and conducting 
the IPTV test. 

ARGUS uses the marked profile as 
the preset profile and switches to 
the menu Settings.

Continued on 
next page

Test parameters

IPTV / IPTV passive
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A total of three user-defined IPTV profiles 
are available. 
 
 
 
 
 
 
 
 
 
 
 
Edits the marked IPTV profile. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting Description

Test parameters:

IPTV: You can create a total of three IPTV profiles. 
<Edit> Activates the profile you wish to edit.

Channel  
selection

The channel list can be used and edited in all profiles. You can store 
up to 250 channels. Using the software WINplus/WINanalyse you 
can also create a configuration conveniently using the PC and load it 
to ARGUS. 
Selecting the TV channels for the IPTV test. 
<Edit> Edits channel

Edits and modifies 
the marked 
parameters
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Multicast 

address

Specifies the multicast IP and source IP (SSM). 
Multicast IP range: 0.0.0.0. to 224.0.0.0/ 
Default: 224.0.0.0 
Source IP range: 0.0.0.0 to 0.0.0.255 
Default: 0.0.0.0

Port Specification of port. 
Range: 0 to 65535 
Default: 0

TV station Enters a TV station name for the IPTV channel.

IGMP version Version of the management protocol for joining/quitting a multicast 
group. 
Range: 2 to 3 
Default: 3

Thresholds Establishes the limit values for the IPTV test.  
When these values are exceeded during the IPTV test, the display 
shows the test result "FAIL", otherwise "OK". 
Specifying "*" deactivates the respective limit value check.

IGMP latency Sets the limit values for the latency (switch-on delay of the program). 
Range: 0 to 25,000 ms 
Default: 500 ms

Sync error Establishes the limit values for the sync error. 
Range: 0 to 10,000  
Default: 0

PCR jitter Establishes the limit values for PCR jitter. 
0 to 2000 ms 
Default: 100 ms

Error  
indication

Establishes the limit values for error indication. 
Range: 0 to 10,000 
Default: 0

CC error Establishes the limit values for CC errors. 
Range: 0 to 10,000 
Default: 0

CC error rate Establishes the limit values for the CC error rate. 
Range: 0.00 % to 100.00 % 
Default: 0.00 %
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Audio bytes Sets the target value for audio bytes. When the measurement falls 
below this threshold during the IPTV test, the display shows the test 
result "FAIL", otherwise "OK". 
Range: 0 to 6,553,600 
Default: 0

Video bytes Sets the target value for video bytes. When the measurement falls 
below this threshold during the IPTV test, the display shows the test 
result "FAIL", otherwise "OK". 
Range: 0 to 6,553,600 
Default: 0

RTP jitter Establishes the limit values for RTP jitter. 
Range: 0 to 2000 ms 
Default: 100 ms

RTP sequence 

errors

Establishes the limit values for sequence errors. 
Range: 0 to 10,000 
Default: 0

Current RTP 
loss rate

Establishes the limit values for the current RTP loss rate. 
Range: 0.00 % to 100.00 % 
Default: 0.00 %

Total RTP 
loss rate

Sets the limit values for the RTP loss rate for the entire test. 
Range: 0.00 % to 100.00 % 
Default: 5.00 %

Profile name Enters a name for the IPTV profile. 
See page 28 for details.
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IPTV QoS (Quality of Service)

Layer 3  
DiffServ

Differentiated services: classification/priorisation of IP packets (L3)

RTP  

(ToS/DSCP)

ToS Type of service 
Field for setting the priority in the IP header of the 
usable data (RTP), see page page 142 for further 
details. 
Range: 0 bis 0xFF 
Default: 18

DSCP Differentiated services codepoint 
Field for setting thepriorityin the DS field (6 Bits) of 
the usable data (RTP), see page 142 for further 
details. 
Range: 0 bis 0x3F 
Default: 00

Layer 2 VLAN 

Prio

TheVLAN priorisation on layer 2 is an extension of the Ethernet 
header..

VLAN Prio VLAN priorisation of usable data. 
Range: 0 bis 7 
Default: 0
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17.1.1 Multiple virtual lines

ARGUS can use up to 4 virtual lines for the service IPTV. The IGMP virtual lines are used 
for transmission of the IGMP protocol and virtual lines 1-3 for receiving the video/audio 
streams. 
 
Overview: selected virtual line profiles 

Adds selected VL profile for the service 
IPTV.

<Edit> Edits the selected virt. profile 
(in this example virt. profile 2), 
see page 106.

<More VLs> Opens virtual line selection for 
the service IPTV.

<Insert> Inserts further virtual profiles.
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Switches to softkey assignment. 
 

<Delete> Deletes the selected virt. profile 
(in this example profile 3) from 
the selection list.

<Insert> Inserts a further virtual profile.
<Edit> Deletes the selected virt. profile 

(in this example profile 3), see 
page 106.

<> The marked profile is moved down 
one place in the list.

<> The marked profile is moved up one 
place in the list.
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Starting IPTV

Connecting the service. 
 
The profile selected for xDSL connection 
(in this example profile 1) is also used for 
IPTV. 

 
 
 
Activating the service IPTV. 
 
 
 
 
If no xDSL connection is established, 
ARGUS automatically connects at this 
point using the default profile (see 
page 57). 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

<Edit> Assigns a virtual line is assigned 
to the service IPTV or edits it.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

<Profile> Displays the IPTV profiles,  
see page 204.

Continued on 
next page
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g 
e 
 
Marks the IPTV profile  
(default is indicated with ). 
 

 
 
 
 
 
 
 
The IPTV test starts automatically. 
 
 
 
 
 
 
 
 
During the test, ARGUS displays the 
selected IPTV channel, the duration of the 
test and the current bitrate. If the set limits 
are exceeded, the IPTV test shows "FAIL" 
in the display, otherwise "OK". 
ARGUS displays "FAIL" until the values 
fall below the threshold again.

<Edit> Edits the marked profile, see 
page 204 for changes to the 
individual parameters.

<Channel> Selects a new channel.
<Test 
status>

Displays test status without endin
the test or starting a new test, se
page 236.

<Total> Displays all IPTV statistics.

Cancels test.

Initialisation

IPTV test

Continued on 
next page
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Display:

 
 
 

 
 

 
 
 

 

 

 

- Current bitrate
- Number of packets lost during the test
- Display of packet loss rate in percent

<Detail> Switches to the IPTV details.

<Channel> Selects a new channel.
<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 236.

Cancels test.

Toggles softkey assignment.

<Channel> Selects a new channel.

The IPTV test runs until a new 
channel is selected. 

<Test 
status>

Displays test status without 
ending the test or starting a 
new test, see page 236.

<OK/FAIL> OK/FAIL overview of the IPTV 
test.

Continued on 
next page
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Display:

Stop IPTV test.

Displays how many packets were lost 
during the IPTV test and how high the loss 
rate is.  
Display of further information: 

- Current loss rate in %
- Total loss rate in %
- Sequence errors
- Latency (in ms)
- Audio bytes (in Byte)
- Video bytes (in Byte)
- Sync error
- Error indication
- PCR jitter (in ms)
- CC error
- CC error rate (in %)

- Minimum delay factor
- Maximum delay factor
- Average delay factor
- Media loss rate (MLR) during the test

<Detail> Displays IPTV test detail 
information, see page 215 
and following.

Stop IPTV

IPTV result
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Exits results. 
 
For saving results, see IP ping page 146. 
Sends trace file to PC, see page 116.

Save result?
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Overview of IPTV results

Display / Description
Bitrate, 
packet losses, packet 
loss rate

Bitrate: current bitrate 
Packet losses: number of packet losses during the test 
Packet loss rate: Displays the packet loss 

rate in percent

Info: Delay factor,  
MLR

Current: Displays the current delay factor in ms
Minimal: Displays the minimum delay factor in ms
Maximal:  Displays the maximum delay Factor in ms
Average:  Displays the average delay Factor in ms
MLR sum:  Displays the media loss rate (MLR) in percent 

Info: channel Test duration: Duration of test
Name: Displays the name of the selected channel
IP: Display of channel's IP address 
Port: Display of channel's port

IGMP latency,  
protocol, 
DSL CRC

IGMP latency:Displays the IGMP latency (switch-on time 
of program) in ms 
Protocol: Displays the selected IPTV protocols 
DSL CRC:  Display of DSL-CRC error counter

Info: Packet loss Current:  Number of current packet losses
Minimal: Number of minimum packet losses
Maximal:  Number of maximum packet losses
Average:  Number of average packet losses
Sum: Number of packets lost during the test  
<MPEG2> Switches to MPEG2 details

Info: 
Packet loss rate

Current:  Display of current packet loss rate 
Minimal: Display of minimum packet loss rate
Maximal:  Display of maximum packet loss rate 
Average:  Display of average packet loss rate

RTP, 
DSL CRC

Error: Display of RTP errors
Seq.error: Display of RTP sequence errors
DSL CRC: Display of DSL CRC error (n/f)

Info: MPEG2 bitrate Current:  Display of current MPEG bitrate 
Minimal: Display of minimum MPEG bitrate 
Maximal:  Display of maximum MPEG bitrate 
Average:  Display of average MPEG bitrate

Info: MPEG2 packets Current: Display of current MPEG packets
Minimal: Display of current MPEG packets
Maximal:  Display of maximum MPEG packets 
Average:  Display of average MPEG packets
Sum:           Sum of MPEG packets 
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Info: MPEG2 bytes Current: Number of current bytes
Minimal: Number of minimum bytes 
Maximal: Number of maximum bytes 
Average:  Number of average bytes
Sum:          Sum of bytes

Info: 
MPEG2 PCR jitter

Current: Current PCR jitter in ms 
Minimal: Minimum PCR jitter in ms 
Maximal:  Maximum PCR jitter in ms
Average:  Average PCR jitter in ms 

Info: 
MPEG2 CC errors

Current:  Number of current CC errors 
Minimal:  Number of minimum CC errors
Maximal:  Number of maximum CC errors 
Average:  Number of average CC errors
Sum:          Sum of CC errors

Info: 
MPEG2 CC error rate

Current: Number of current CC error rate 
Maximal: Number of maximum CC error rate

Error Sync, 
Indicat, 
DSL CRC

Sync:        Display of error sync
Indicat.: Display of error indication
DSL CRC:   Display of DSL CRC error(n/f) 

Info: PID bitrate Current:  Number of current PIDs 
Minimal: Number of minimum PIDs
Maximal:  Number of maximum PIDs
Average:  Number of average PIDs
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17.2 IPTV scan

ARGUS checks the availability of TV channels. Additionally, ARGUS displays the 
switchover time between TV channels. 
You can create three user-defined scan profiles. The following settings must be saved in 
the profile for the IPTV scan (when the xDSL, G.fast or Ethernet connection is already 
established, the connection parameters, e.g. target value, are locked):

Protocol-independent parameters:
ARGUS in status screen. 
 
 

 

 
 
 
 
 
 

<Edit> Assign virtual lines to the 
service IPTV.

<Profile> See page 35 for profile 
settings.

<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the default profiles for 
establishing the Ethernet or xDSL 
connection and conducting the 
IPTV scan. 

ARGUS uses the marked profile as 
the default profile and switches to 
the menu Settings. 

Continued on 
next page

Test parameters

IPTV scan
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A total of three user-defined scan profiles 
are available. 
 
 
 
 
 
 
 
 
 
Edits the scan marked profile. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edits and modifies the marked 
parameters
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IPTV scan settings 

Setting Description

Test parameters:

IPTV scan You can create a total of three scan profiles.  
<Edit>Activates the profile you wish to edit.

Channel selec-

tion

The channels list can be used and edited in all profiles. You can store 
up to 250 channels. Using the software WINplus/WINanalyse you can 
also create a configuration conveniently using the PC and load it to 
ARGUS.  
Selecting the TV channels for the IPTV scan:

ARGUS initially displays the TV channels 
already selected in the set order that was 
tested for the IPTV scan. If no channels 
have been selected yet, the list is empty.  
The list slots can be filled one after 
another. You can select up to 250 
channels.  
<Insert> Opens the list with the 
                available channels.

 

 
 
<Edit>

Marks the channel 
Channels already selected 
do not appear in the 
channel list (see channel 
selection display). 
 
Edits the marked channel, 
see page 204 and following. 
- Enter (multicast IP and 
  port number) of TV 
  channel. 
- Enter any alias name for 
  the TV channel (e.g.  
  name of broadcaster). 

Continued on 
next page
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Add the marked TV channel (in this 
example IPTV channel 4), then add the 
next channel (in this example IPTV 
channel 5). 
Once at least two channels have been 
added to the list, you can change their 
position in the list using the following 
softkeys.

<Delete> Deletes the marked TV 
channel from the list.

<Insert> Opens the channel list with 
the available channels.

 

Toggles softkey assignment.

<> The selected channel is 
moved down one place in 
the list.

<> The selected channel is 
moved up one place in the 
list.

IGMP version Version of the management protocol for joining/quitting a multicast 
group (for broadcast TV only). 
Range: 2 to 3 
Default: 3

Continued on 
next page

Accepts the channel 
selection in the order shown.
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Max. switch-

over time

Entry of max. switchover time (IPTV timeout): 
This is the time between the request and receipt of an IPTV channel.  
If the measured timeout exceeds the value set here, ARGUS rates 
this test as "FAIL".  
Range: 1 - 25 seconds 
Default: 5 seconds

Profile name Entry of a name for the IPTV scan profile, see page 28 for details.
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Starting the IPTV scan

Connecting the service. 
 
 
The profile selected for xDSL connection 
(in this example profile 1) is also used for 
IPTV. 

 
 
Activating the service IPTV. 
 
 
 
 
If no xDSL connection is established, 
ARGUS automatically connects at this 
point using the default profile (see 
page 57). 
 
 
 

 
 
 
 
 
 

 

<Edit> Assigns a virtual line to the 
service IPTV or edits it.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

<Profile> Displays the IPTV scan 
profiles, see page 218.

Initialisation
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The IPTV scan starts automatically. 
 
Displays the time needed to switch 
between channels. If a TV channel cannot 
be received within the set interval, 
ARGUS displays "FAIL". 
 

 
 
Exits results display. 
 
 

 
 
For saving results, see IP ping page 146. 
Sends trace file to PC, see page 116. 
 

 

<Test 
status>

Displays test status without 
ending the test or starting a new 
test, see page 236.

IPTV scan

Save result?
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17.3 IPTV passive

ARGUS listens for transmitted TV channels without requesting a channel. ARGUS lists the 
TV channels it detects in a list of multicast IPs and/or channel names. 

 
A second ARGUS in STB mode can be connected in place of a PC or STB.

See page 203 and following for protocol-independent parameters and test 
parameters for IPTV passive.
 
 

 

 
 
 
 

Patch cablexDSL line

Socket LAN 1 / SFP 1Socket Line

Ethernet xDSL , G.fast

G.fast or xDSL 
access

PC with VLC 
(video LAN 
client)

Set-top box  
(STB)

alternatively

Passive 

Passive 

Active 

Ethernet 
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Starting IPTV passive
Connecting the service. 
 
The profile selected for xDSL connection 
(in this example profile 1) is also used for 
IPTV passive.
 

 
 
 
 
 
 
Router mode is started. 
 
 
 

 

 
 

 
 
 
The service IPTV and the router mode are 
active and the VDSL access is 
synchronous.

IPTV passive can also be run in 
bridge mode. However, the bridge 
must be activated first.

<Info> The duration of router activity 
is displayed.

<Stop> Stops router mode.

To access the softkey <Test> in 
bridge mode, switch to the bridge 
box and activate it.  
The services are not available in 
bridge mode.

Continued on 
next page

Select the service IPTV 
using the cursor and 
activate it.

Select the router using 
the cursor and start the 
test.
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Marks the IPTV profile  
(default is indicated with ). 
 
 
 
 

 
 
 
ARGUS automatically checks whether 
IPTV streams are available and displays 
these.
 
 
In this example, one possible stream is 
displayed.

<Profile> Displays the IPTV passive 
settings, see page 204.

<Edit> Edits the marked profile, 
see page 204 for changes to 
the individual parameters.

<Refresh> Updates the channel list.
<Test  
status>

Displays test status without 
ending the test or starting a 
new test, see page 236.

<IP> Displays the multicast IP of the 
selected channel.

Initialisation

Continued on 
next page

InitialisationInitialisation

Waiting for stream
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st, 
During the test, ARGUS displays the 
selected IPTV channel, the duration of the 
test and the current bitrate. If the set limits 
are exceeded, the IPTV test shows "FAIL" 
in the display, otherwise "OK".  
ARGUS displays "FAIL" until the values 
fall below the threshold again. 

 
The IPTV result statistics are explained starting on page 213. 
 
 

<New> Starts a new IPTV test or selects 
another available channel, see 
page 226.

<Test 
status>

Displays test status without ending
the test or starting a new test, see
page 236.

Toggles softkey assignment.

<OK/FAIL> OK/FAIL overview of the IPTV te
see page 213.

Cancels test.
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17.4 Video on demand (VoD)

In VoD mode, ARGUS requests a datastream from a VoD server. Depending on the access 
type, ARGUS replaces the STB or the modem and the STB. 
VoD services are often provided using RTSP, as this control protocol additionally supports 
control functions. However, ARGUS also supports the protocols FTP, HTTP and MMS 
where needed. During the test, ARGUS monitors the regularity of the incoming packets, the 
loss of packets, packet and PCR jitter and other possible errors.  
Depending on the preset limit values, ARGUS performs an OK/FAIL assessment and 
shows important metadata regarding the received VoD stream.  
You can configure three user-defined VoD profiles (where the connection is already 
established, the connection parameters, e.g. the target value, are locked): 

Protocol-independent parameters:
ARGUS in status screen. 
 
The VoD test is performed using the 
service of that name.  
The following example illustrates the 
procedure and its special features.  
 
 
<Edit> A virtual line is assigned to 

the service VoD. 
<Profile> See page 35 for profile 

settings.
<Start> Starts the service.

Select the profile you wish to edit. 
The selected profile appears in the 
display in blue. The default profile 
is indicated with a  in the display. 
ARGUS adopts the parameters 
from the default profiles for 
establishing the Ethernet, G.fast or 
xDSL connection and conducting 
the VoD test. 

ARGUS uses the marked profile as 
the default profile and switches to 
the menu Settings.Continued on 

next page

Test parameters
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A total of three user-defined VoD profiles 
are available. 
 
 
 
 
 
 
 
 
 
Edits the scan marked VoD profile. 
 
 
 
 
 
 
 
 
 
 
 
Edits and modifies the marked 
parameters.
 

  
Setting Description

Test parameters:

VoD: You can create a total of three VoD profiles. 
<Edit>Activates the profile you wish to edit.

Type of stream Select the type of stream. You can select one of the following types: 
RTSP, HTTP, FTP, MMS 
Default: RTSP

Server address Enter the server address from which the stream is to be downloaded. 
Enter the address using the number keys. Toggle entry using the 
softkey (meaning of right softkey changes when pressed), see 
page 142.

Video on demand
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Port Specification of port. 
Range: 0 to 65535 
Default: 0

File name Name of the file to be downloaded from the server, see page 142 for 
information on using the softkeys.

RTSP type Type of control protocol: TCP or UDP. 
Default: TCP

RTSP server 

type

If the remote station is a standard-compliant VoD server, always set 
the field "RTSP server type" to "standard". If the remote station uses 
proprietary features, you can use a different setting (e.g. Kasenna). 
Default: Standard

Jitter buffer Size of jitter buffer. Ideally, enter the value from the upstream STB. 
Range: 0 to 5000 ms 
Default: 300 ms

Threshold 
values

Sets the limit values for PCR jitter and continuity error (assessment 
of picture quality). 
When these values are exceeded during the IPTV test, the display 
shows the test result "FAIL", otherwise "OK". 
PCR jitter: 
- Range: 0 to 10,000 ms 
- Default: 8 ms 
Continuity error: 
- Range: 0.0 - 100 percent. 
- Default: 0.1 %

Profile name Enter a name for the VoD profile. 
See page 28 for details.
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Starting VoD

Connecting the service. 
 
The profile selected for xDSL connection 
(in this example profile 1) is also used for 
VoD. 

 
 
Start the service VoD. 
 
 
 
 
 
If no xDSL connection is established, 
ARGUS automatically connects at this 
point using the default profile (see 
page 57). 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

<Edit> Assigns a virtual line to the 
service VoD or edits it.

<Info> Duration of activation.
<Test> Opens test selection.
<Stop> Deactivates the service.

<Profile> Displays the VoD profiles, see 
page 229.

Continued on 
next page
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t 
 
Marks the VoD profile  
(default is indicated with ). 
 

 
 
 
 
 
 
 
The VoD test starts automatically. 
 
 
 
 
 
 
 
 
During the test, ARGUS displays the 
current PCR jitter and the continuity 
errors. If the set limits are exceeded, the 
VoD test shows "FAIL" in the display, 
otherwise "OK". 
ARGUS displays "FAIL" until the values 
fall below the threshold again.

<Edit> Edits the marked profile, see 
page 204 for changes to the 
individual parameters.

<Test 
status>

Displays test status without ending
the test or starting a new test, see
page 236.

<Info> Displays the video on demand tes
statistics.

Cancels test.

Initialisation

VoD test

Continued on 
next page
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Display: 

 

Display: 

 

Display: 

- Displays the current error status
- Displays the current and maximum 

PCR jitter 

<UDP> Switches to UDP information, see 
page 234.

- Displays the current and maximum 
continuity error in %

- Display of container type

- Display of stream packets
- Display of stream bytes
- Display of stream cont. errors

Continued on 
next page
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Display: 

Display: 

Display: 

- Current stream bitrate
- Average stream bitrate
- Minimum stream bitrate
- Maximum stream bitrate

- Received packets
- Maximum packet jitter
- Current packet jitter

<Stream> Switches to stream information, 
see page 235.

- Lost RTP packets
- OSS RTP packets
- Number of errored RTP packets

Continued on 
next page
234 ARGUS 166



17 IPTV tests
Display: 

Displays the duration of the test, the result 
OK or FAIL, and the error status.  

The further test results are described 
starting on page 233.

Exits results. 
 
For saving results, see IP ping page 146.
Sends trace file to PC, see page 116.

- Video codec
- Video resolution
- Video codec name
- Audio codec
- Audio channels
- Audio sampling rate
- Audio bits/sample
- Audio bitrate
- Audio codec name
- Audio codec desc.
- Total runtime
- Author (general)
- Title
- Author (meta)
- Copyright

Stop VoD test

VoD result

Save result?
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18 Parallel tests

ARGUS permits parallel testing of different IP-based services (Data, VoIP, IPTV and Opt.) 
running on xDSL, G.fast or Ethernet interfaces.
The settings for each test are described in the respective chapters. 

The following tests can be run in parallel. Any combination of the tests listed here is  
possible. Up to ten tests can be conducted concurrently. 

Service Test Remark

Data

IP ping*1, see page 141

For theses tests, up to 10 tests can be 
conducted concurrently (incl. tests 
using the other services). 

Traceroute*1, see page 147

HTTP download, see page 151

FTP download, see page 158

FTP upload, see page 160

FTP server, see page 164 See remark for VoIP.

Textbrowser, see page 171

Network scan*2, see page 175

VoIP

VoIP call, see page 180 These tests can be combined with 
any other test. Please note that a total 
of ten simultaneous VoIP connections 
are possible.

VoIP wait, see page 198

VoIP call generator, see page 200

IPTV

IPTV, see page 203 These tests can be combined with 
any other test. Note that only one 
IPTV test can be active at any time.IPTV scan, see page 217

IPTV passive, see page 224
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Opt.

IP ping*1, see page 141

For theses tests, up to 10 tests can be 
conducted concurrently (incl. tests 
using the other services). 

Traceroute*1, see page 147

HTTP download, see page 151

FTP download, see page 158

FTP upload, see page 160

FTP server, see page 164 See remark for IPTV

Textbrowser, see page 171

Network scan*2, see page 175

VoD, see page 228 See remark for IPTV

*1 Also possible via the services VoIP, IPTV and VoD. 
*2 only Ethernet
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The possibility of parallel testing is illustrated using HTTP download and VoIP via the  
services Data and VoIP. Display and operation for further parallel tests, e.g. IPTV, is  
performed in the same way as for Data and VoIP.

 
ARGUS status screen. 
 
The VDSL VTU-R access shown in the 
example and the services Data and VoIP 
are active. 
 

 
 

Mark the server profile:  
(default is indicated with ). 

HTTP download starts automatically. 

<Info> Duration of activation

<Test> Opens test selection.

<Stop> Deactivates the service.

 
e.g. select HTTP download

<Profile> Displays the available HTTP 
download profiles, see 
page 151.

<Edit> Edits the marked profile, 
see page 151 for changes to 
the individual settings.

Initialisation
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Display during HTTP download:

Display of test status:

- Current download/total number of 
downloads, in this example the first 
download attempt out of three (1/3) is 
displayed.

- Current and overal Data transferred (in 
this example 6 % / 2 %)

- Current net download rate (in this 
example 72,787 Mbit/s)

- Current net average download rate (in 
this example 62,434 Mbit/s)

See page 154 for further result parameters.

Cancels test

- Currently selected test as well as test-
dependent result parameters, in this 
example the current net download rate, 
the current progress and the size of the 
file to be transferred. 
The display of results depends on the 
respective test. See the chapter on the 
individual test for more information on 
the result parameters.

- The current download in kbit/s is 
represented as a percentage of the 
entire downstream range.

- The current upload in kbit/s is 
represented as a percentage of the 
entire upstream range.

- Number of CRC and FEC errors in down-
and upstream

 
or

 
Switches to the test result 
parameters, in this example for HTTP
download.

<Stop> Stops the test, in this example 
HTTP download.

HTTP download

Cursor down

Test status
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ARGUS in status screen.

Mark the VoIP destination 
(default is indicated with ). 
 
Scroll down with the cursor, mark a blank 
line and add a new VoIP destination using 
<Edit>. 

 

Connecting

Opening test status

<Info> Duration of activation.

<Test> Opens test selection.

Switches to the test result 
parameters, in this example for of 
HTTP download.

 
e.g. select VoIP call

<Edit> Edits the VoIP destination 
number.

Switch to the service 
VoIP using the cursor 
keys and open test 
selection.

Initialisation
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s 
.  
t 

P 
 
 

.

 

The called subscriber has taken the call 
("Connected!"), see page 189. 

ARGUS executes an HTTP download and 
a VoIP call in parallel.

The VoIP call is stopped.

<Info> Displays the VoIP parameters.
<Volume> Opens volume control.

 When more than one test is 
executed, you can select the test
with the left and right cursor keys
For more than three tests, the tes
row expands to the right.

<New> Selects a new single test.
<Stop> Stops the test, in this example VoI

call. Depending on the test, it can
be reinitialised using <Start>. The
configuration remains unchanged

<Finish 
all>

Stops all tests.

Toggles the softkey assignment.

To start a new VoIP call test, the old
one must be cleared by pressing 

 twice.

 or Switches to the test result 
parameters, in this example from 
HTTP download.

<New> Selects a new single test.
<Stop> Stops the test.
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Concurrent tests (s. chapter 18 page 236) can also be executed automatically in an auto 
test. To to this, you can save different test scenarios in up to five auto test profiles. 
The same rules as for the individual tests apply for the settings, execution and control. 

Cursor up

Continued on 
next page

ARGUS in status screen.

Physical layer, virtual line and two of the 
services are successfully activated (in this 
example Data and VoIP).

ARGUS in test status

No test has been started yet.

<New>

<Auto 
test>

Selects a new individual test.

Opens auto test profiles.
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Continued on 
next page

ARGUS lets you preconfigure up to five 
auto test profiles.

Define a scenario. You can configure up to 
ten individual tests (see page 236).  
The number of tests (e.g. IP ping, down-
load, VoIP ...) is limited to ten; IPTV can 
be selected only once (see page 236).

In general, at least one IP ping test is 
always preconfigured.

<Change>

<Add>

Replaces IP-ping with a 
different test.

Adds a further test.
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Continued on 
next page

Cursor down

Select the desired test and confirm with

 

In addition to the IP ping test, a traceroute 
test is also started automatically  
and simultaneously via the auto test pro-
file.

 

<Delete>

The scenario is accepted and saved.

Removes the test from 
the list.
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2x

1x

Select “Name” to name the autotest.

Give the auto test a name, like “triple-play 
test” or similar.   
Use the alphanumeric keyboard.

Exit auto test setup by pressing  

twice and then start the test with .  

see page 239 for instructions. 

The individual tests are 
configured as described starting 
on page 141.
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20 Operation on a POTS access

 

The voltages on the subscriber line may not exceed 130 VDC and should be free 
of AC voltage.

20.1 Setting the POTS Interface

Use the included connection cable to connect the ARGUS (Line jack) to the POTS access 
to be tested and then switch the ARGUS on. The POTS settings are made in the chapter 5 
Configuring accesses page 25. In this example the POTS TE mode was selected:

Note: Open the Main Menu and select "Help" or press number key "1". An overview of the 
possible key combinations can be found on Page 315.

The various menus available for the 
selected type of access will be shown in 
the Main Menu.

 
The ARGUS will open the 
marked menu (in this example, 
Single tests).

 Select a menu. The selected 
menu will be marked blue in the 
display.

 
Return to the previous menu (in 
the example, the State display).

 

 
 

The ARGUS displays the voltage on the 
line when it is "on hook“ (not busy). 
Positive voltage: Polarity on a+; on b- 
(red wire is a, black wire is b) 
Negative voltage: Polarity on a-; on b+

<Setting> Opens the Settings menu for 
POTS parameters, see page 
247.

<Menu> Open the Main Menu 

<Call> For information on setting up a 
call, see page 249. 

ARGUS State Display

Main Menu
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20.2 POTS Settings

It is possible to configure the following "POTS Settings". The default settings can be 
restored at any time (see page 307). 

Setting Explanation

POTS

Dial mode Selection of the dial mode: 
DTMF or pulse dialling 
Default setting: DTMF

CLIP Mode Select the transfer procedure used to pass the call number:

FSK CLIP via FSK 
(Frequency Shift Keying) 
For Germany and some other places in Europe

DTMF CLIP via DTMF  
(Dual-tone multi-frequency) 
For Scandinavia and the Netherlands 
The ARGUS will automatically detect that a CLIP was 
sent using DTMF with the polarity reversal and will set 
itself accordingly (e.g. Netherlands).

Default setting: FSK

DTMF parameter Settings for the three parameters Level, Duration and Interval of the 
DTMF signals generated during POTS (analog) operation.

Level Setting the DTMF level: 
The level can range between -30 dB and +9 dB. 
Use the cursor keys to raise or lower the level by 3 dB. 
Range: -30 to +9 dB 
Default setting: -3 dB

Time Setting the DTMF time:  
Range: 40 to 1000 ms 
Default setting: 80 ms 
Use the cursor keys to raise or lower the setting:

In the range 
In the range 
In the range

40 - 200 ms: 
200 - 300 ms: 
300 - 1000 ms:

10 ms steps 
20 ms steps 
100 ms steps
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For information on restoring the default parameter settings, see page 309.

Interval Setting the interval between two DTMF characters: 
Range: 40 to 1000 ms 
Default setting: 80 ms 
Use the cursor keys to raise or lower the setting:

In the range 
In the range 
In the range

40 - 200 ms: 
200 - 300 ms: 
300 - 1000 ms:

10 ms steps 
20 ms steps 
100 ms steps

Defaults Restores the default settings:  
Level = -3 dB, Time = 80 ms, Interval = 80 ms

FLASH time Sets the length of a FLASH. 
This setting is needed in order to use special features of a PBX. 
Range: 40 to 1000 ms 
Default setting: 80 ms 
Use the cursor keys to raise or lower the setting:

In the range 
In the range 
In the range

40 - 200 ms: 
200 - 300 ms: 
300 - 1000 ms:

10 ms steps 
20 ms steps 
100 ms steps
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20.3 Connection on a POTS Access 
Outgoing Calls
The ARGUS sets up a connection to another terminal. If the terminal at the other end is a 
telephone, the handset integrated in the ARGUS or a headset can be used to hold a 
conversation.

For information on the ARGUS in the 
"POTS telephony" access mode, see 
page 246. 
The ARGUS - Main Menu

Simplified overlap signaling using the  key: and the ARGUS will immediately 
open the POTS telephony display. Once the call number is entered, the call will be 
setup. 

Incoming Call 
The ARGUS signals an incoming call both audibly and on the display.

 
If the access supports CLIP, the ARGUS 
will display the number of the caller (for 
information on CLIP mode, see page 
247).

<Call> 

or  
Setup the connection:  
Enter the number on the keypad. 
Each of the number's digits will be 
dialled individually. The ARGUS wil
display the number dialled. As soon
as the remote party answers, a voic
connection will be set up.

<Call 
no.>

The ARGUS will display the last 
number dialled (simplified last 
number redial) or that of the last 
caller.

<R> Generate a FLASH signal.

Scroll through the speed-dialling 
memory to select a different numbe
or enter a new one using the keypa

<Accept> or  
 

Accept call

The call number received will be 
saved in the “Last caller” memory 
location.

Single tests

Clearing the connection

or press the  key
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20.4 POTS Monitor

The POTS monitor function provides a high impedance tap (for listening-in) that does not 
influence the interface. You can listen-in on the line with the integrated handset or a 
headset without having the ARGUS send on or otherwise influence the interface.

The POTS monitor settings are made in the chapter 5 Configuring accesses page 25.

 
The ARGUS displays the voltage level on 
the line when it is “on hook” (not busy). 

 
 
 
 
Start Monitoring 
 
The ARGUS displays the voltage (when 
"off hook"), the number of the caller (if 
CLIP is supported) and the DTMF 
characters dialled by both telephone 
subscribers. 
Any received DTMF characters will be 
appended to the line, which will shift left 
for each character once it is full. An 
incoming call will be signalled 
acoustically. 

 

Press to display additional 
information, if available on the 
access

<Loud> Increase volume  
(The microphone is off.)

<Delete> Clears the display.

Stop monitoring and the 
ARGUS will open the State 
Display.
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20.5 Level Measuring on a POTS Access

The ARGUS measures the voltage level in both the normal case and when the line is 
“busy” (trunk line).

 
ARGUS Main Menu 
 
 
Start Measurement
 
The ARGUS will display the polarity of the 
2-wire POTS line (red wire "a"; black wire 
"b") as well as the "on hook" and "off 
hook" voltage levels. 
<New> To repeat the measurement

Open the Main Menu

Level measuring
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21 Copper tests

In the Access menu, ARGUS offers the menu option "Copper tests", which enables you to 
investigate the physical properties of the line. 
This chapter briefly describes how to use the various functions. It is not possible to describe 
the interpretation of the results in the customary detail here. As the results are usually  
provided in graph form, they can only be interpreted correctly in conjunction with a know-
ledge of the line being measured. ARGUS supports this using a variety of aids, such as the 
Zoom and Cursor functions.

Note:  
The Ethernet cable tests are described in chapter „22 Ethernet cable tests“ (see page 281). 
The ARGUS Copper Box is described in a separate  
Copper Box manual.
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21.1 Line scope

With the line scope, ARGUS performs a real-time analysis on the connected line. The high-
ohm line scope can e.g. be patched into an existing link between modem and DSLAM.  
You can display the results in either the time or frequency range (FFT). 

21.1.1 Starting the line scope

Continued on 
next page

The chapter "Configuring accesses", page 30, explains how to set up the access type 
"Copper tests".

 
 
 
ARGUS status display. 
Any DC voltage on the line is indicated 
here.  
 
 

<Menu>

<Start>

 

  
Select one of the Copper tests. 
- Copper box 
- Line scope 
- TDR 
 
Start the desired copper test directly by 
selecting it. 
 
In this example, the line scope.

The voltage on the line may not exceed 200 V DC or 100 Vpp AC.

Switches to main menu.

Directly accesses "Single 
tests" menu.
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Line scope status display
 
The line scope can identify a variety of 
states or occurrences on the line.  
This example shows the ADSL (Annex B) 
connection with ISDN-U interface estab-
lished between the modem and DSLAM. 
The line scope is located in direct proxim-
ity to the modem, as it is particularly effec-
tive upstream in the spectrum.  
If the upstream were significantly less than 
the downstream, it would be in direct  

proximity to DSLAM.
<Menu>

 
Finding the modem: 
In addition to the general state of the line/
connection, a variety of events can be 
detected.  
In this example, we can see the hand-
shake tones that a modem connected to 
the line sends periodically in order to 
establish a connection with the DSLAM. 
This also reveals whether or not an active 
modem is connected to the other end of 
the line.
 

In addition to the wanted signals such as the DSL spectrum or the handshake tones, the 
line scope can also detect unwanted signals such as temporary interference sources (real-
time operation) or peculiarities in noise (with respect to background noise). 
 
Connection example without probe:

 

Opens the graph function, see 
page 256
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Gain:
To ensure optimum detection of different signals, match the gain (y-axis) with the reduction 
of the frequency range shown (x-axis). ARGUS always begins with the lowest gain (-26 dB 
in the frequency range up to 3 MHz). Measuring range: -130 to +10 dBm/Hz.

 
Gain-Y: Gain settings: 
-26 dB, - 20 dB, 0 dB, 20 dB

ARGUS displays all measurement results as dBm/H
values. These values are only comparable with oth
when the resolution of the measured frequency ban
taken into account, as here the total energy of the 
frequency band is determined "per Hz". The bandw
ARGUS is measuring is indicted in the display as Δ

 

 
Frequency range:
A frequency range of from 20 kHz to 30 MHz is available for measurement; the resolution 
varies depending on the selected range.

 

The bandwidth Δf at the top right in the 
display shows which frequency range  
is being shown in the display.

 Frequency-X: Setting the 
displayed frequency range. Every 
press of the cursor key halves, 
respectively doubles the displayed 
range.

 

 
Example:

In a measuring range up to 32.768 MHz, 
up to 2048 values can be displayed, so: 
Δf = 32,768 MHz / 2048 values = 16 kHz. 
Consequently, a y-value marked by the 
cursor and displayed (in this example 16 
MHz) is the mean (in this example -133.3 
dBm/Hz) across the frequency range of 16 
MHz - Δf/2 to 16 MHz + Δf/2, or 15.992 
MHz to 16.008 MHz.
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21.1.2 Graph functions

 
 
 
 
The graph functions Zoom and Cursor 
enable detailed analyses of the graphs.

<Menu>

 

 

Press  in the status display (in the graph) to save the results and stop 

the line scope.  

The "Graph functions" menu opens:
 

Zoom (2):
The magnifying glass shown in the display 
rests on a white background.  
It has not yet been zoomed. 
When the magnifier is over a dark 
background, the graph is zoomed.

<Zoom(x)++>

<Zoom(x)--> Not yet zoomed! Reverses 
<Zoom(x)++> and resets  
magnification.

 lets you toggle the meaning of the softkeys and choose between x-axis and y-axis 

zoom, see page 64. 

Opens graph functions.

Exits the menu without changing.

You can also use this number 
key to activate the Zoom function 
within a graph. 

The function of the cursor is 
described on page 257.

Accepts the selection and returns 
to the graph.

Magnifies the middle section of
the graph (100%).
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Cursor (3):

When the Stop function  
(see page 262) is activated, you 
can move the cursor faster.

When the Cursor function is started, a 
green cursor line appears in the middle of 
the graph. 

<Cursor>

 

The values of the graph for the position 
under the cursor are displayed in the 
graph as follows:
x:

y:

 

The zoom function and the cursor function can also be combined. For example, you can 
determine a certain value using the cursor more easily when you have previously zoomed 
in on a specific range. However, the starting position of the cursor can vary.
 
Measuring range (4):

When the line scope starts, it is in the 
measuring range in the status display. You 
can set the frequency range (x) and the 
gain (y) in the measuring range. If you 
have hidden the measuring range in order 
to work with the cursor or zoom, you can 
restore it: 
 
<Menu> 

or 

You can toggle the cursor on 
and off as needed using the 
Cursor softkey after activating it 
in the menu.

 +1024 kHz (accuracy ± 1 %)

 -63.4 dBm/Hz (accuracy ± 2 dB)

You can use the left and right 
cursor keys to move the 
cursor to any position on the 
graph to measure it. 
Briefly pressing a cursor key 
causes the cursor to jump to 
by one position in the graph. 
When the cursor key is held 
down, the steps the cursor 
covers in the graph become 
progressively larger.

 
Restores measuring range.
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Total power (5):

ARGUS displays the total power. The total 
power is the sum of all individual power 
measurements (Δf)  over the entire visible 
range, in this example -299 dBm over  
2.2 MHz.

<Menu> 

or 

Probe (7):
The line scope is high-ohm. 
Input impedance: 3.6 kΩ 
Input capacitance: 30 pF 
 
However, even with the line scope you 
may also need to use a high-ohm probe 
(ARGUS Active Probe).
 
 
 

ARGUS Active Probe II: 
Input impedance: 70 kΩ 
Input capacitance: 1 pF 
Functions: Symmetry/asymmetry toggling 
 
After connecting the probe, you can switch 
it on using this menu. 
 

 
 

 
Restores total power display

To activate the probe, see 
page 265.
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Symmetry (8):  

Once the probe has been switched on and 
detected, you can switch between sym-
metric and asymmetric operation using 
Symmetry. 
In asymmetric operation, the useful signal 
is hidden so that you see only noise and 
any interference sources (see example 
illustration).

Time domain (9):

<Menu> 

or 

 

In the line scope, you can switch from the 
frequency range to the time domain. In 
this respect, the line scope operates like 
an oscilloscope that permits display of AC 
voltages from 0 to 40 Vpp with a resolution 
of 2 mVpp.  
This makes it easy to recognize different 
AC voltage signals, e.g. the square-wave 
signal of an E1 access.

      

If ARGUS detects that the connected  
signal regularly exceeds a certain thresh-
old, ARGUS tries to trigger automatically 
in response to this so as to optimally  
display the signal in the time domain.

The trigger symbol is green.  
If no signal is present or the level is too 
low, the trigger symbol is red. ARGUS 
does not trigger.

Symmetry/asymmetry toggling

 
Opens time domain

 
 
The gain and time base can be set using the horizontal and vertical cursor 
keys analogous to the frequency range.

The cursor functions are also available in the time domain for analysing the 
signal. However, there is no zoom function.
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Peak hold (min/max) (0):

The peak-hold function can be additionally 

activated using the number key .

When the peak-hold function is used, positive (blue) and negative (yellow) peaks are 
shown graphically. The result is a blue curve of maxima and a yellow curve of minima over 
time. The instantaneous values continue to be displayed in red. 
In the maximum values in particular, sporadic fliers (interference pulses) are visible and 
permit comparison between different lines (e.g. particularly clearly with the aid of a suitable 
clip-on ammeter). 

100 Ohm Input resistance (#):

Particularly when using a suitable clip-on 
ammeter, it may be necessary to adjust 
the input resistance of the line monitor 
(input impedance, see page 258). The red 

symbol indicates that the line monitor 
is operating with an input resistance of 
100 Ω..

 
A suitable clip-on ammeter is available as an accessory for ARGUS; please ask 
our Support team.
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Reference curve (*0):
The reference curve enables e.g. compar-
ison of the signal from one line with that 
from another.  
To do this, start the line scope and con-
nect it to line a. After obtaining the desired 
reference signal by setting the measuring 
range in the display, set the curve. Now 
switch to line b without closing the line 
monitor and compare the two signals.

<Menu> or

 and 

<Set>

When the reference curve is set, an 
orange line is displayed in the graph.  

<Hide>

<Set>

Restores reference 
curve function.

Set reference curve.

Hide reference curve. 

Set a new reference curve. 
ARGUS 166 261



21 Copper tests
Run/Hold
 
 
You can stop and restart a running test 
(realtime mode) at any time. 

 

 
 

 
 

Test running

Stop test

Test is stopped

Restart test
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Clipping:
Frequency range:

Time domain:

 

If the signal at the line scope input is too 
strong or the gain in the frequency range 
and time domain are displayed as too large, 
the input stage of the line scope is over-
driven. 
In this case, ARGUS displays the clipping 

symbol . 

The displayed signal is clipped both in the 
frequency range and the time domain. You 
can remedy this by reducing the gain. 

 
 
 
 
 
 
 
 

Saving test results without terminating the line scope
You can save your results of the measurement without disconnecting in the same way as 
for VDSL, see page 83.

 
See page 314 for the meanings of all symbols used in the line scope.
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21.2 Active Probe

The ARGUS Active Probe is an active, high-impedance probe that can be passively 
patched into an existing connection without interfering with it. 
 

 
The ARGUS Active Probe II is designed to be used with the ARGUS line scope. The high-
ohm line scope (input impedance 3.6 kΩ)) can also be used without the ARGUS Active 
Probe II (see page 256).

21.2.1 Active Probe II

The ARGUS Active Probe II has the following technical specifications:
 - Input impedance: 70 kΩ 
 - Input capacitance: 1 pF
 - Frequency range: 10 kHz to 30 MHz (± 1.5 dB)
 - Attenuation, symmetrical 14.5 dB 
 - 2 x 4 mm banana plug sockets (spacing 12 mm)
 - Data transmission to ARGUS via RJ45 lead (pins 4/5) 
 - Supply voltage: 5 V via ARGUS USB-host interface and USB cable

The Active Probe II can be operated in both symmetric and asymmetric mode. You can 

switch between these two operating modes using the hotkey  or via the menu. See 

page 259, line scope for an application example.
 

The Active Probe II:

In spite of the high impedance probe, it can cause transient losses of existing 
connections when it is patched in.
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21.2.2 Connecting the Active Probe II

Connect ARGUS to the Active Probe II via the Line socket and the USB-A interface (host). 
ARGUS supplies the Active Probe with a voltage of 5 V via the USB host interface. 
Connect the Active Probe to the line to be tested (in this example Active Probe II between 
modem and DSLAM) using a lead that is as short as possible (< 5 cm). 

Connection example:

 

21.2.3 Starting Active Probe II (example with line scope)

 
 
After starting a test (in this example with 
Line scope), you can open the Probe 
menu using the graph functions or the 

number key . 

Continued on 
next page

 

The connection cable and adapter supplied with the device have been 
designed to be as short as possible. The Active Probe II should be operated 
using leads that are as short as possible. To obtain optimum measurement 
results, it is important for the Active Probe to be connected in direct proximity 
to the line to be tested. Every extension of these connecting leads increases 
the input capacitance of the Active Probe, which can falsify the measurement 
results. Even the positions of the two leads in relation to each other can falsify 
the results as the lengths increase. When the Active Probe is used as 
supplied, ARGUS automatically subtracts the additional attenuation from the 
measurement results.
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 yes

 
 

 
 
Select "yes" to use the probe. 
ARGUS then switches on the supply 
voltage to the USB-A interface and auto-
matically subtracts the additional  
damping caused by the Active Probe 
from the measuring results. 
 
When the Active Probe is active and 
properly supplied from ARGUS, the 
green LED on the probe lights up. 

 
A green tick mark in the lower right of the 
display indicates during a test that the 
Active Probe is connected correctly. 
 

 
 
 
 
 
If the Active Probe is not connected  
correctly and thus not detected by 
ARGUS or intentionally deactivated via 
the Probe menu, ARGUS displays an 
exclamation point in the lower right of 
the display.

Opens the Probe menu directly.

Activation of the probe can take 
up to 10 seconds.
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Toggling symmetry/asymmetry:
 
 
See the Line scope description on 
page 259 for an example for toggling  
symmetry/asymmetry. 
 
 
 
 
 
 
 
 
 
 
Once the test is started and Active Probe 
II activated, you can toggle the probe input 
between symmetric and asymmetric  

operation using the number key . 
 
 
 
 
 

 
 
 
 
When switched to asymmetric mode, 
ARGUS displays possible interference 
sources and the line noise. The usable 
signal is hidden.

Saving test results without terminating the Line scope
You can save your results of the measurement without disconnecting in the same way as 
for VDSL, see page 83.
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21.3 TDR

The TDR function enables you to determine line lengths in realtime or localise interference 
sources. Correct interpretation of the pulses displayed by ARGUS permits e.g. detection of 
stub lines, poor contacts or short-circuits. For this purpose, ARGUS transmits a pulse on 
the connected line and displays its reflection response. 

21.3.1 TDR settings

The chapter "Configuring accesses", page 30, explains how to set up the access type 
"Copper tests". 

The line may not carry a DC voltage greater than 200 V DC and must be free 
of AC voltage components.

The result of a TDR measurement in the ARGUS display may give the 
impression of multiple interference sources on the line. It is recommended that 
you eliminate the first interference source on the line and then repeat your 
measurement. It is possible that the first interference source caused one or more 
reflections, which can greatly falsify the reflection at the second interference 
source. Often, there is no second interference source on the line.

ARGUS generates a reflection at approx. 3 m. To precisely measure short lines 
and avoid this reflection, using e.g. a 5 m long connection lead is recommended. 
The pulse continues to be displayed in the graph but using the cable ensures that 
this is not on the line.
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21.3.2 Wire types

 

 
 
Selects the wire types to be 
configured.

 
 
 

 

<Edit> Edits the wire-type parameters.

Setting Description

Wire type/VoP

Propagation 

speed

To determine the distance, the calculation must take into account a 
correction value dependent on the wire type that specifies the ratio 
of the pulse propagation speed in the cable to the speed of light in a 
vacuum (c0 = 299.792458 m/µs).  
For many cable types, the pulse time is also specified in V/2. 
Minimum: 45.0 m/μs (VoP in %: 30) 
Maximum: 149.7 m/μs (VoP in %: 99.9) 
Default: 98.9 m/μs (VoP in %: 66) 
The choice of propagation speed as VoP or V/2 is saved.

Line resistance Sets the line resistance per kilometer. 
Range: 40 Ω/km to 400 Ω/km 
Default: 80 Ω/km
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The configured cable types are also used for RC measurement and TDR  
measurement.

The default values only apply for this first cable type.

List of preconfigured default wire types: 

Capacitance Sets the capacitance (operating (mutual) capacitance) per 
kilometer. 
Range: 35 nF/km to 100 nF/km 
Default:  nF/km

Name Enter the name of the wire type. 
Default: PE 0.5 AWG24

No. Name Wire 
diameter 
(mm)

Line  
resistance 
(Ohm/km) 

Mutual 
capaci-
tance 
(nf/km)

VoP 
(%)

Note

1 PE 0.5 AWG24 0.5 80 39 66.0 Outdoor cable, Poly- 
ethylene, air filled

2 PP 0.5 AWG24 0.5 80 39 66.0 Outdoor cable, Poly- 
propylone, air filled

3 Pulp 0.4 AWG26 0.4 150 36 60.0 Outdoor cable, conductor 
with pulp jacket, air filled

4 Pulp 0.5 AWG24 0.5 80 39 67.0 Outdoor cable, conductor 
with pulp jacket, air filled

5 Pulp 0.6 AWG22 0.6 65 38 68.0 Outdoor cable, conductor 
with pulp jacket, air filled

6 PIC 0.4 AWG26 0.4 150 36 64.0 Outdoor cable, conductor 
with plastic jacket, air filled

7 PIC 0.5 AWG24 0.5 80 39 66.0 Outdoor cable, conductor 
with plastic jacket, air filled

8 PIC 0.6 AWG22 0.6 65 38 67.0 Outdoor cable, conductor 
with plastic jacket, air filled

9 PIC 0.9 AWG19 0.9 29 34 72.0 Outdoor cable, conductor 
with plastic jacket, air filled

10 Jelly 0.9 AWG19 0.9 29 34 68.0 Outdoor cable, petroleum/
jelly filled cable

11 Filled 0.4 
AWG26

0.4 150 36 58.0 Outdoor cable, filled
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21.3.3 Starting TDR

The chapter "Configuring accesses", page 30, explains how to set up the connection type 
"Copper tests".

Continued on 
next page

TDR

 
 
ARGUS status display. 
ARGUS indicates any DC voltage on the 
line.  
 

<Setting>

<Menu>

<Start>   

 

 
Select and start TDR.

No. Name Wire 
diameter 
(mm)

Line 
resistance 
(Ohm/km)

Mutual
capaci- 
tance 
(nf/km)

VoP 
(%)

Note

12 Filled 0.5 
AWG24

0.5 80 39 60.0 Outdoor cable, filled

13 Filled 0.6 
AWG22

0.6 65 38 62.0 Outdoor cable, filled

14 PTFE/Teflon 0.5 
AWG24

0.5 80 39 67.0 Outdoor cable, conductor 
with teflon jacket

15 Wire type 15 - 80 49 66.7 default, editable

16 Wire type 16 - 80 49 66.7 default, editable

17 Wire type 17 - 80 49 66.7 default, editable

18 Wire type 18 - 80 49 66.7 default, editable

19 Wire type 19 - 80 49 66.7 default, editable

20 Wire type 20 - 80 49 66.7 default, editable

Switches to the settings for the 
wire-type list, see page 269.

Switches to main menu.

Directly accesses "Single 
tests" menu.
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TDR status display:

Gain:

Range:

 
 
ARGUS displays possible interference 
sources on the copper twisted pair 
directly. 
In this example, after the input pulse 
(starting at 0 meters) we can see a second 
pulse that spikes at approx. 150 m. This 
can indicate a 150 m long line that is open 
at its end. 
 
The adjustable range, the gain and the 
graph functions permit more detailed  
analysis. 
 

 
To ensure optimum detection of pulse 
reflections, match the function for adjust-
ing the gain (y-axis) with the reduction/
enlargement of the range shown (x-axis).
ARGUS always starts with the lowest gain 
(-26 dB) at a range of 1500 meters. 

 
Gain-Y: Sets the gain 
from -26 dB, -20 dB, 0 dB, +14 dB  
+24 dB, +34 dB, +44 dB

 

 
The measurements with the TDR can take 
place in a measuring range of from 3.5 to 
6000 meters. The resolution is approx. 0.3 
% of the displayed measuring range. 

 The accuracy is approx. ±2 % of the 
measuring range. When determining 
the distance, try to determine the 
start of a pulse where possible, and 
not the relative maximum.

 

Range-X: Sets the displayed 
measuring range. Every press of 
the cursor key halves or doubles 
the displayed range.
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21.3.4 Graph functions

 
The graphic functions Zoom and Cursor 
enable detailed analyses of the graphs. 
 
 
 
 

<Menu>

Press  in the status display (in t

graph) to save the results and stop t
TDR function.

Zoom (2):

Continued on 
next page

The Graph functions menu opens.
 

The magnifying glass shown in the display 
rests on a white background.  
It has not yet been zoomed. 
When the magnifier is placed over a dark 
background, the graph is zoomed. 

<Zoom(x)++>

<Zoom(x)--> Not yet zoomed! Reverses 
<Zoom(x)++> and resets  
magnification.

 

When zooming, the y-axis always remains 
at 100 %. No y-axis zoom is available.

Opens graph functions

Exits the menu without changing.

You can also use this number 
key to activate the Zoom function 
within a graph. 

The function of the cursor is 
described on page 274.

Accepts the selection and returns 
to the graph.

Enlarges the middle section o
the graph (100%).
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You can vary the graph size from 25% to 
100% using the zoom softkeys. This 
doubles or halves the resolution. 
When concurrently using the cursor, you 
can precisely localise the reflection on the 
measured line.
 
 
 
 
 
 
 
 
When the Cursor function is started, a 
green cursor line appears in the middle of 
the graph.
<Cursor>

 

 
The values of the graph for the position 
under the cursor are displayed below the 
graph:
 
x:

 

 
The Zoom function and the Cursor function can also be combined. For example, you can 
determine a certain value using the cursor more easily when you have previously zoomed 
in on a specific area. However, the starting position of the cursor can vary.

You can toggle the cursor on 
and off as needed using the 
Cursor softkey after activating it 
in the menu.

  
+151.4 m 

Use the left and right cursor 
keys to move the cursor to any 
position on the graph to 
measure it. Briefly pressing the 
cursor key causes the cursor to 
jump to a new position in the 
graph. When the cursor key is 
held down, the steps the cursor 
covers in the graph become 
progressively larger.

Cursor (3):

When the Stop function (see 
page 277) is activated, you can move 
the cursor faster.
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Measuring range (4):  

When the TDR function starts, it is in the 
measuring range in the status display. You 
can set the range (x) and the gain (y) in 
the measuring range. If you have hidden 
the measuring range in order to work with 
the cursor or zoom, you can restore it: 

<Menu> 

or

Pulse width/height (5):  

You can configure the width and height of 
the pulse that ARGUS outputs to the line. 

 
 
 
 
 
 
 

Height: 
The pulse height sets the level of the pulse ARGUS outputs to the line in volts. The default 
value is 5 V, but can be increased to 20 V. In principle, it is recommended that you increase 
the pulse height as the distance increases.  
On short, very noisy lines as well, increasing the pulse can make the reflection stand out 
better against the noise, for a more reliable interpretation. 
 
Width: 
The pulse width sets the duration of the pulse ARGUS outputs to the line in nanoseconds 
(ns). The default value is 500 ns, but you can increase this up to 2000 ns (2 µs) depending 
on the measuring range. Just like a more powerful pulse, a longer pulse contains more 
energy, and thus is generally more suitable for use on longer lines. However, a longer pulse 
can also conceal important reflections, which can then no longer be correctly interpreted. 

 
Restores the measuring range

 

Configuring the pulse
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Wire types (6):
The absolute VoP value must always be less than 1. However, ARGUS always displays 
this in percent. In a wire with a VoP value of 0.7, a signal propagates at 70 % of the speed 
of light (c0).  
For many cable types, the pulse time is also specified in V/2: V/2 = VoP [%] * 1.5. In this 
example, the V/2 value would come to 95.5 m/µs for a VoP of 0.637 resp. 63.7 %.  
A typical patch cable has e.g. a VoP of 0.667 resp. 66.7%, which corresponds to a V/2 of 
exactly 100 m/µs.

To measure e.g. building wiring precisely, it is important to set the correct VoP 
value. You can determine the correct VoP using a reference cable of known length 
before the measurement.

Reference curve (*0):
See also the instructions on page 261 on 
using the reference curve. 

In this example, the line is open at  
143.3 m (reference value).

When the reference curve is set, an 
orange line is displayed in the graph.  
In this example, the line is terminated. 

<Hide>

<Set>

Hide reference curve.

Set a new reference curve. 
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Start/stop:
 
 
 

 

You can stop and restart a running test 
(realtime mode) at any time. 

 
 
 

 

Saving test results without terminating the TDR
You can save your results of the measurement without disconnecting in the same way as 
for VDSL, see page 83.

 
See page 314 for the meanings of all symbols used in the TDR.

Test running

Stop test

Test is stopped

Restart test
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21.3.5 Examples

The following signal forms can help you in interpreting the reflection responses that 
ARGUS displays. 
 
Examples:

 
Open cable 
The reflected pulse is positive. No proxi-
mate interference sources or the far end of 
the line can be seen.  
 
 
 
 

 
Short-circuit 
The reflected pulse is negative. No proxi-
mate interference sources or the far end of 
the line can be seen.  
 
 

 
 
 
Mismatch 
Different line cross-sections were used. 
The greater the mismatch, the greater the 
amplitude of the reflection. 
 
 
 
 
 
Poor contact point 
A poor contact between two lines distorts 
the reflection into an S-shape. The worse 
the contact, the greater the reflection.
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Stub line 
The beginning of a stub line appears in the 
form of a negative reflection, followed by a 
positive reflection corresponding to the 
length of the stub line when the end of the 
stub line is open. 
 
 
 
 
 
Loading coils 
Loading coils deployed on the line are 
optimally designed for transmitting voice 
frequencies. They do not let DSL signals 
through. The TDR function enables you to 
detect the first coil in a line. The reflection 
is positive with a long tail in the direction of 
the end of the line. The following faults 
cannot be detected. 
 
 
 
 
Capacitive network 
Like a short-circuit, the reflection from a 
capacitive network is negative.   
 
 
 
 
 
 
Moisture 
Moisture penetrating the cable has the 
same effect on the reflection as a stub 
line. However, the zone between the  
negative and positive reflection appears 
significantly noisier than for a normal stub 
line. 
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Loose/intermittent contact 
Realtime operation is extremely suitable 
for detecting intermittent contacts. The 
amplitude of the positive reflections varies 
depending on the intermittent contact  
frequency.  
 
 
 
 
 
Open shielding 
Broken or open cable shielding can be 
detected by connecting the “a“ and “b“ 
cores to ARGUS via one contact and the 
shielding to a second. The reflection looks 
like an open line. 
 
 

Correct line termination 
When the line is properly and correctly  
terminated, the pulse generated by 
ARGUS is completely absorbed. No  
further reflections are visible.
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22 Ethernet cable tests

 

The local loop must be voltage-free.

The Ethernet cable tests can only be performed on the LAN1 interface.

22.1 Configuring the Ethernet interface

Connect the local loop to the ARGUS socket "LAN1" and switch on ARGUS. The chapter 
"Configuring the local loop", page 30, explains how to set up the connection type "Ethernet 
Cable Test".

22.2 Ethernet cable test settings

You can configure the following "Ethernet parameters". You can restore the default settings 
at any time (see page 309). The following example is used to illustrate how to modify a 
parameter.

Test not yet started:  
red LED in display!
Meaning of LED image in display: 
Red LED: no test started

<Setting> Opens the Ethernet cable test 
setup, see below.

<Menu> Switches to main menu.
<Start> Starts the Ethernet cable test, 

see below.

Status screen

ETH cable tests

Settings

Copper/cable tests
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22.3 Ethernet port flash

ARGUS can identify the port currently in use on the Ethernet switch using the test "Ethernet 
port flash". To facilitate identification, the flash frequency at the switch can be set in 
ARGUS.

22.3.1 Starting Ethernet port flash

<Setting>

<Menu>

<Start>

ARGUS in the status line.

 
Select Port flash.

ETH port flash

Interval that ARGUS keeps the port active before performing a link disconnect. The  
disconnect time depends on the switch.
Range: 1 - 5 seconds 
Default: 1 s

Opens the Ethernet cable test 
settings, see page 281.

Opens the main menu.

Starts Ethernet cable test.Continued on 
next page
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22 Ethernet cable tests
 

Start port flash directly by selecting it.

The Ethernet port flash test is executed.

The test "ETH port flash" has been  
executed. 

Display:
- Indication whether the port LED is 

flashing (in example "off").
- Link speed attained.
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23 Test results

 

 

 

23 Test results

The saved test data are displayed either in the ARGUS display or on the PC. You can 
transfer the results to the PC, where the software WINplus / WINanalyse generates a 
detailed measurement log (along with other functions). 
 
ARGUS stores the test results together in 50 definable save slots. The system suggests 
"New result" as the default save name. The saved test results are also deleted when all 
configuration settings are reset. 
The functions ("View", "Rename", "Send to PC", "Delete") in the Test results menu refer to 
one test result. You must thus first select a save slot with a test result:

 
ARGUS in Main Menu 
 
When ARGUS is in the selection list for 
preconfigured accesses, you can switch to 

the abbreviated main menu with .

 
ARGUS displays the name of the stored 
result and the number of occupied slots.

When multiple test results are saved, 
ARGUS lets you sort them by name and 
time (as in this example). You can also 
sort them manually.
<Sort 
time>

Sorts test results by time.

<Sort > The marked test result is moved
up one place in the list.

<Sort > The marked test result is moved
down one place in the list.

<All> Deletes all test results or send to
PC.

Test results
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se.

, 

us 
23.1 Saving test results

You can save the result after the end of a 
test or after disconnecting a connection. 
 
 
ARGUS saves the test result in the first 
free slot. If all slots are occupied, you need 
to manually select a slot to overwrite. 
 
ARGUS automatically proposes a save 
name. The name is composed of: 
- the device type (in this example A166) 
- the serial number (in this example 02991) 
- the configured date (in this example 
  25th october 2017) 
-the adjusted time (in this example 13:14 
h) 
 
You can accept the displayed save name 
or enter a new one using the number keys. 
The right softkey changes its meaning 
when pressed, affecting your entry. You 
can enter up to 24 characters. ARGUS 
displays the number of characters used so 
far.

<Last 
name>

ARGUS suggests the last save 
name used. 

<Ab>AB> Entry begins with upper-case 
letters and continues in lower-ca

<AB>12> Entry of upper-case letters.

<12>ab> Numerical entry.

<ab>AB> Entry of lower-case letters.

Entry of special characters, e.g. @
/, -, ., *, ?, %, =, &, ! etc.

Entry of special characters  
e.g. _, :, +, # etc.

<Delete> Deletes the place in front of the 
cursor.

Moves cursor

Don't save result, return to previo
display.

Save result
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23.2 Displaying saved test results

ARGUS in Main Menu 

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .
 

 

23.3 Sending test results to a PC

You can send the test results to a PC for viewing and archiving. Connect ARGUS (ARGUS 
socket "USB-B") to the interface of your PC using the cable supplied with the device and 
start the software WINplus or WINanalyse.

ARGUS in Main Menu 

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .
 

 
 
 

Select a save slot (in this example 
selection of the first slot with the 
save name "New result").

Select a save slot (in this example 
selection of the first slot with the 
save name "New result"). 
All test results are transmitted.

Test results

New result

View

Display of test result

Test results

New result

Send test results to PC

Start data transmission to PC
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23.4 Delete test results

ARGUS in Main Menu 

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with . 
 

Deletes the test result stored in the 
selected slot. 
 
To deletes all test results, see on page 
309 “Restoring the factory settings”. 

23.5 Sending all test results to PC

ARGUS transfers all saved test results to the connected PC. Connect ARGUS to the PC 
and start ARGUS WINplus or WINanalyse.

ARGUS in Main Menu 

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .
 
 

Select a save slot (in this example 
selection of the first slot with the save
name "New result").

Test results

New result

Delete

The test result is deleted.

Test results

Send to PC

Start data transmission to PC
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23.6 Deleting all test results

ARGUS deletes all saved test results from its internal memory. 

ARGUS in Main Menu 

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .
 
 
 
 
 
 

 

Test results

Delete

Confirm the security prompt with 
<Yes>; all 50 possible test results 
are deleted.
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24 WLAN

ARGUS can be WLAN-enabled using a USB WLAN stick. ARGUS then offers WLAN as the 
management interface for an array of functions. ARGUS supports a variety of approved 
WLAN sticks, which are available as accessories. Please ask our Support team.

You only need the WLAN kit (or the ARGUS USB mini-hub) if your ARGUS only 
has one USB host interface and you wish to connect two USB devices (e.g. 
WLAN + ARGUS Copper Box). 

Always insert your USB devices in the hub first before you power up ARGUS.

24.1 Starting WLAN

Access list or any point in the menu.

ARGUS manager display

- M-interface ETH / WLAN, see page 302 
- Web server start, see page 304 
- VNC server start, see page 304 
- Update firmware, see page 295 
- LCD brightness, see page 305 
- Automatic shutdown, see page 306 
- Auto. charge, see page 313 
- Alarm bell, see page 306 
- Configuration import, see page 297 
- Test result upload (FTP), see page 300

 Switch on ARGUS

press shortly

right
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24 WLAN
You can activate/deactivate or change 

settings using the cursor key . 

The WLAN interface is now activated.  
 
See page 302 for WLAN settings such as 
SSID, password, channel, etc.

Either ETH or WLAN can be selected as the management interface; the default 
setting is WLAN. You can change this under “Device settings/Management 
interface/Interface” (see page 302). This is only possible when the management 
interface is grayed out under “Start/Management interface”; if WLAN or Interface 
is grayed out, switch off the management interface first.

The WLAN interface is now activated. ARGUS is now in access-point mode (ARGUS-AP). 
The WLAN symbol in the status line is green .

You can set up a WLAN connection with ARGUS by selecting the WLAN access with the 
name Argus166_SerialNumber on a smart phone, tablet or laptop and entering the 
password stored in ARGUS.

Electronic job management applications can also access ARGUS and pick up 
measurements using WLAN. 

24.2 Test results via WLAN
If for example a laptop has a working WLAN connection with ARGUS, you can open the 
Web server by entering the IP address of the ARGUS unit (see page 303) or myargus.info 
in your browser's address bar.

The test results with the name data.csv can be 
opened directly or saved on the laptop. You can 
also use this functionality to save, delete and 
rename measurement logs. For this, you require a 
WebDAV application/app on your PC/laptop or 

smart phone/tablet. 

The .csv file contains the connection 
parameters of the last measurement 
conducted.

The command "VNC" lets you control ARGUS 
remotely via your browser.
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24 WLAN
 
You may first need to activate the VNC server on ARGUS, see page 304.

Further information regarding the VNC server is available on request.

The ARGUS Web server has its own SSL certificate (myargus.info), which permits 
https:// access. 

You can also access ARGUS using WebDAV via myargus.info. By this means, 
you can download measurement logs in .amp format directly from ARGUS via 
Ethernet or WLAN.

24.3 WLAN in router mode

When the ARGUS WLAN interface is active, it is always connected directly with the 
ARGUS router. If you want to use ARGUS as a true WLAN access point (ARGUS-AP) and 
e.g. start a download with this device as the gateway, you must first start a DSL access 
(ADSL, VDSL, SHDSL, see page 57).

If the router (see diagram) has been 
started, both WLAN and LAN1 are  
connected to the ARGUS router.

The smartphone, tablet or laptop can use ARGUS as an access point. All applications such 
as data, VoIP or video that can be run e.g. on a smart phone can now be executed to test 
the connecting devices via ARGUS - thus replacing all customer devices. 

WLAN and LAN are not linked via an Ethernet bridge. Each requires its own  
configuration. They may not be configured identically. A test from WLAN to LAN or 
vice-versa is not possible.
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25 ARGUS settings

ARGUS can be custom-configured for special requirements. The default values are 
restored using "Reset" (see page 309).

25.1 Cloud services

ARGUS supports cloud services for communicating with its environment. These services 
enable ARGUS to share data with other systems via its test interface. ARGUS offers test 
interfaces for ADSL, VDSL, G.fast, SHDSL, Ethernet, GPON and LTE. When connected via 
these interfaces and with the data service running, ARGUS can download firmware 
updates, import a configuration and upload measurement logs.

The cloud services are deactivated by default.

At a minimum, the data service must be connected and successfully started via a 
VL using the corresponding test interface.

ARGUS always loads the country variant last used by that instrument.

The instrument only checks whether there is a different firmware on the server 
than the one it has loaded. Be aware of this if you have your own update server. 
Downgrades are possible, and can result in a loss of configuration data.

ARGUS in Main Menu. 
 

Select cloud services.

Settings

Cloud services

Continued on 
next page
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25 ARGUS settings
Select the cloud service to configure, e. g. 
Firmware update.  

Three server profiles are offered for server selection. All three profiles are  
identical, and differ only in their names:
- Server profile 1: Firmware
- Server profile 2: Configuration
- Server profile 3: Measurement log
You can also assign any name to the server profiles (Profile name) for your use, 
e.g. you can create two different profiles for importing configurations if measure-
ment log uploading is not needed. 

Only the server profile “Firmware” is preconfigured. When the server specified in 
this profile is used, ARGUS looks for a new firmware version on intec’s server. 
The ARGUS instrument logs onto the server with its serial number and IP 
address. 

Settings Description
Firmware update:

Server Configuration of the server, s. page 292. 
Update check Defines whether to automatically check for a firmware update.

Default: off
Update Starts the firmware update.
Configuration import:

Server Configuration of the server, s. page 294. 
Check Defines whether to check automatically for a new suitable 

configuration file.
Default: off

Import 
destination

Determines whether the current settings or the current and saved 
settings are to be imported.
Default: Cur. & backed up config.

Import Starts the configuration import.
Test result upload, server configuration, see page 300  
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25.1.1 

Firmware

Entry the FTP server address.  
Default: firmware.argus.info

Entry the user name. 
Default: argus

Entry the password.  
Default: update

Entry the profile name. 
Default: Firmware

Configuration

Entry the FTP server address.  
Default: */*

Entry the user name. 
Default: */*

Entry the password.  
Default: */*

Entry the profile name.   
Default: Configuration

Test result

Default 
Default: */*

Entry the user name. 
Default: */*

Entry the password.  
Default: */*

Entry the profile name. 
Default: Test result

Cloud services settings  

 
See page 314 for the meanings of all symbols used for cloud update.

Settings Description

<Edit> Activates the server profile you wish to edit.

Server FTP server 
address

User name

Password

Profile name

Update 
check

Defines whether to automatically check for a firmware 
update.
Default: off

<Edit> Activates the server profile you wish to edit.

Server FTP server 
address

User name

Password

Profile name

Check Defines whether to automatically check for a new suitable 
configuration file.
Default: off

<Edit> Activates the server profile you wish to edit.

Server FTP server 
address

User name

Password

Profile name
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25.1.2 Cloud Update

The cloud update process is explained in the following. In this example, VDSL VTU-R 
mode is configured and selected as described in chapter „5 Configuring accesses“ (see 
page 25). For details on configuring the firmware updates, see the chapter “Configuring 
ARGUS” on page 292.

Never under any circumstances import a configuration when ARGUS when is oper-
ating in battery mode. Connect ARGUS to the power adapter before importing a 
configuration.

Continued on  
next page 

Switch to Data using the 
cursor keys Data and press 
<Start> to activate the  
service. 

Starts the service. 

 
The profile shown in the display (in this 
example profile 17a) is used for the cloud 
update.

If no connection is established, ARGUS 
automatically connects at this point using 
the default profile, s. page 57.

The service Data and the VDSL 
connection are active.

 

The blue “FW” in the status line indicates 
that a firmware update is available. 

<Info> Duratio of activation.
<Test> Opens test selection.
<Stopp> Deacivates the service.

Press one after 
another 

 and 

Starts the firmware 
update
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ARGUS automatically restarts after a 
successful firmware update. 
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25.1.3 Configuration import

25.1.3.1 Automatic configuration import  

This function enables you to read out and adopt the ARGUS configuration file.

Never under any circumstances import a configuration when ARGUS when is 
operating in battery mode. Connect ARGUS to the power adapter before importing 
a configuration.

Prerequisites:

The instrument is connected to the 
interface (xDSL, G.fast, Ethernet or LTE).

The instrument must connect with the 
server, and a suitable configuration file for 
this instrument must be available. If this 
prerequisite is not met, you can only 
import a configuration manually.

If the configuration is not imported 
immediately, the instrument will display a 
corresponding message each time the 
instrument is powered up. 

Select “Configuration import”.

A new configuration is available. 

The configuration file is downloaded. 

Settings

Backup/Restore

Continued on 
next page 
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The configuration is imported. 

The instrument needs a 
few seconds before it can 
be restarted; this is 
indicated by an hourglass 
in the top right next to the 
battery indicator. 

<Restart> Restart of the device.

Once the import is successfully 
completed, restart the device.
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o 
25.1.3.2 Manual configuration import 

This function makes it possible to accept a configuration previously stored on the ARGUS 
instrument via WebDAV.

Never under any circumstances import a configuration when ARGUS is operating 
in battery mode. Connect ARGUS to the power adapter before importing a 
configuration.

Manual configuration import assumes that automatic configuration import is 
switched off, s. page 300.

Select “Configuration import”. 

The configuration is read and loaded from 
an ARGUS configuration file (*.acn) 
stored on ARGUS in the folder “acn”.

A configuration is imported.

Once a WLAN link is active and a 
WebDAV server has transferred an
acn file to ARGUS, you can load it. 
Otherwise “Adopt configuration” is 
grayed out. If ARGUS cannot find a
suitable acn file, it outputs an error 
message. 

The instrument needs a few 
seconds before it can be 
restarted; this is indicated by an
hourglass in the top right next t
the battery indicator. 

Settings

Backup / Restore

Once the import is successfully 
completed, restart the device.
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o 
25.1.4 Upload test result  

This function enables you to upload test results to an external server and download them 
again at a later date. 

Prerequisites:

The instrument is connected to the 
interface (G.fast, xDSL, Ethernet, GPON 
or LTE).

The name of the test result “New result” 
can vary; you can also assign any name 
to the test results when saving.

Select „Upload (FTP)“.

If there is no connection to the server, the 
instrument connects to the server when 
you start the upload. 

<Sort  
time>

Sorts test results by time. 

<Sort > The marked test result is moved
up one place in the list. 

<Sort > The marked test result is moved
down one place in the list. 

<All> Deletes all test results or send t
PC. 

<Profile> If the server data are not 
stored, you can enter them 
here.

Continued on next 
page
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25 ARGUS settings
The tests results are uploaded.

The upload takes a few seconds; the 
actual duration depends on the quantity 
and file size.

Following the upload, ARGUS returns to 
test results processing mode.

The upload is now complete, and the 
measurement result is on both the 
external server and ARGUS. It can now 
be deleted.
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25.2 Remote access

ARGUS offers a wide variety of remote control functions. For instance, it can connect to a 
mobile end-user device (smart phone or tablet) via the WLAN interface, and can be 
remotely controlled from the mobile device.

Settings Description

Management 

interface

Start 
management 
interface

Determines whether the management interface is used. If 
WLAN was selected as the management interface, 
ARGUS operates as a WLAN router, see below. 
Depending on the selected interface, ARGUS displays 
either a WLAN or an Ethernet symbol. 

WLAN: WLAN is not active (grey) 

             WLAN is active (green)  

Ethernet: Ethernet is selected 

Default: off

Interface 
selection

When the interface selection is greyed out, the 
management interface must first be halted (see above) 
by setting „Start management interface“ to off. Then 
restart it again. 
Selects the management interface (Ethernet or WLAN). 
Default: WLAN

WLAN If WLAN is greyed out, the management interface must 
first be halted (see above) by setting „Start management 
interface“ to off. Then restart it again.

SSID The service set identifier (SSID) is a user-
definable name with which ARGUS can be 
identified as a network. 
Your SSID can also be displayed using the 

keyboard shortcut  and  .  
Default: Argus166_SerialNumber
302 ARGUS 166



25 ARGUS settings
Password If WLAN was selected as the management 
interface (see page 302), mobile devices 
log in using a password query. 
The password (default: argus166) can also 
be displayed using the keyboard short-cut 

and  .

Channel Selects the WLAN channel on which the 
WLAN stick transmits. Channels 1 through 
11 are available for the 2.4 GHz frequency 
band, and channels 52, 56, 60 and 64 can 
be used for the 5 GHz band. 
Default: 1

DHCP 
server

Settings for the DHCP server: 
- Starting and ending IP address 
  Range: 0.0.0.0 bis 255.255.255.255 
  Default: (assignment see RFC 3330) 
  Start: 192.168.20.30 
  End: 192.168.20.40 
- Domain name, see „User name“ page 112 
  for results 
- Duration of reservation for IP addresses 
  Range: 1 bis 99999 seconds 
  Default: 240

IP 
settings

IP address ARGUS IP address 
Range: 0.0.0.0 bis 255.255.255.255 
Default: 192.168.20.1 (for issuing see  
RFC 3330)

Netmask IP netmask  
Range: 0.0.0.0 bis 255.255.255.255 
Default: 255.255.255.0 (for issuing see  
RFC 3330)  

Gateway Gateway IP address 
Range: 0.0.0.0 bis 255.255.255.255 
Default: 0.0.0.0 (for issuing see 
 RFC 3330)
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25.3 Configuring the device

Changing a device setting is described using the setting "Alarm tone" as an example.

ARGUS in Main Menu 
 
When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .
 
 
Select a setting (e.g. Alarm tone) using 
the cursor keys. 
 
The default is indicated with a  in the 
display.

Webserver Start 
Webserver

Determines whether the webserver is used. 
Default: off

Password 
protection

Determines whether a password protection is used for the 
webserver. 
Default: on

VNC server Start VNC Determines whether the VNC server is used. 
Default: off

Password 
protection

Determines whether the password protection is used. 
Default: on

VNC scaling Determines the scaling used to display the ARGUS 
screen on the PC. 
Range: Factor 1 - Factor 4 
Default: Factor 2

Mark the desired setting. The 
marked setting is highlighted in 
blue in the display. 

Return to next-higher level menu 
without saving setting change.

Settings

Device

ARGUS adopts the marked 
setting as the default. 

Off

Alarm tone
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Setting Description

Menu  

language

Select the operating language 
Default: depends on country

LCD 
brightness

Sets display contrast: 16 contrast levels are possible. You can increase or 
decrease the contrast using the cursor keys. The vertical arrow shows where
the current contrast lies in the range from low to high contrast.  

Date / time 

setting

Enter the date, time, time offset and daylight savings time via the number 
keys. Switch between the lines using the up and down cursor keys. Change 
the three following settings, from top to bottom, so that all settings take effect:

Time offset: Set the time offset (coordinated world time: UTC-12 to 
UTC+14) for your time zone here. UTC+1 is the setting for 
central Europe. 

Daylight  
savings time:

If central European time is selected, ARGUS calculates with a
total time offset of UTC +2 during the summer months. 

Date / time: To set the time manually, enter the correct time in your time 
zone using the ARGUS number keys. In automatic time set-
ting, ARGUS automatically reads the time from a preconfig-
ured time server. 
Default: 0.de.pool.ntp.org 
This can be changed to a different server. The prerequisite is 
that ARGUS can connect to the internet. Carry out e.g. a ping
test (e.g. ping www.argus.info).

The time you enter runs on the built-in ARGUS realtime clock until the power
supply is interrupted. When ARGUS is switched off and the batteries 
removed, the clock continues to run for a few days on its internal buffer. The 
time is undefined as soon as the buffer is exhausted, and must be set again.

Ring 
volume

You can set the volume of the ring tone ARGUS uses to signal an incoming 
call. 
For one thing, you can adjust the initial volume. 
- Default: Level 1 (very quiet) 
You can also adjust the end volume. 
- Default: Level 7 (very loud) 
For an incoming call, ARGUS begins with the initial volume (very quiet) and 
increases the volume with each ring until it reaches the final volume level 
(very loud).
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Alarm tone ARGUS generates alarm tones in different situations, e.g. as soon as a bit 
error occurs in BERT or ARGUS has synchronised with an xDSL access, and
when error counters reach high counts.

Short - long Successfully synchronised

Long - short Lost synchronisation 

Short - short Error counter spike (the tone relates only to the last  
second. Only one tone sounds even when multiple errors are 
displayed.)

The setting "off" suppresses all alarm tones. 
Default: off

Jingle An ARGUS jingle is played after the device powers up and initialises.  
Default: off

Power  
management

Automatic off: Sets the no-activity period after which ARGUS switches to 
power-saving mode when the power supply is not connected. When power-
saving mode is turned off entirely, ARGUS will display a warning that 
switching off power-saving mode reduces the battery time the next time it is 
powered up. You can deactivate this warning with the "X" key. <On> cancels 
deactivation. 
Default: after five minutes

llumination Sets the duration for background illumination. Background 
illumination is always on when the power supply adapter is connected. In 
battery mode, ARGUS switches off background illumination after a set time.  
Default: after 30 seconds

Software 

option

Activates a software option. You must enter an activation key via the keypad.
A variety of  options can be activated in ARGUS; each one requires entry of a
20-digit code via the number keys.This code will be provided on request.

There are also codes for resetting options. You should only 
enter these codes when you understand what they do.

Licenses Displays the open source packages, which are used in the ARGUS firmware 
and have been published under different licenses (GPL, LGPL, MIT, BSD, 
etc.), see page 330.

Company address

Entry of the customer address for the measurement log. Each configuration item permits up to
29 characters.

Company name Default: */*

Street Default: */*

ZIP/City Default: */*

Phone number Default: */*
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25.4 Backing up and restoring settings

ARGUS offers multiple functions for backing up and restoring settings. In addition to the 
actual backup/recovery of the settings configured in ARGUS, these also include the options 
of restoring the factory defaults and importing configurations to overwrite the current one.

25.4.1 Backup / Restore
With ARGUS, you can back up all settings (speed dial memory, PPP user name, PPP 
password, IP addresses, profile names, user-specific details, keypad information and 
more) and restore them if needed.
Backing up settings

ARGUS in Main Menu 
 
 
 
 
 
 

 
 
 
All settings made in ARGUS are backed 
up unchanged and can thus be restored 
later. 
 

 
 
 

Settings

Backup/restore
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25 ARGUS settings
The settings are now backed up and can 
be restored as necessary. 

Restoring settings
Select "Restore settings"

Enter the security password to 
back up or restore settings. 
You can obtain this from your 
Technical Support or directly from 
intec (see page 9).

Restores the saved test 
settings. 

If no settings have been 
backed up, this function 
has the same effect as 
"Restore factory setting", 
see page 309. 
A security password is not 
required.

Restore now?

<Yes>

and
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25.4.1.1 Restoring the factory settings

ARGUS resets all settings to the factory defaults.

The speed-dial memory, PPP user name and password, IP addresses, profile-
names, user-specific services, keypad information and all test results stored in 
ARGUS are erased.

 
 
 
 
 
 

 
All parameters are reset to the factory 
defaults. 
 
 

ARGUS jumps directly to 
the security prompt.

Enter the security password to 
delete all settings. 
You can obtain this from Technical 
Support or directly from intec (see 
page 9).

Restores the saved test 
settings.

If no settings have been backed 
up, this function has the same 
effect as "Restore factory 
defaults", see page 308.

Settings

Backup/restore

The following steps are performed 
as for "Backup settings", see 
page 307.

and

and
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26 Update via PC
26 Update via PC

You can download firmware files online free of charge at www.argus.info/service and then 
upload them to ARGUS. 
Go to the Web page www.argus.info. 
Click the menu option "Service" (highlighted in blue here) in the navigation bar. 

This opens up a product overview.
 
 
 
 
 
Select your ARGUS 
device.

Once you select your device, you are automatically taken to the firmware updates. Select 
your country-specific firmware variant. 

In the drop-down  
Service menu, click 
the option "Down-
loads". 
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26 Update via PC
When you select your variant, a browser dialogue opens that enables you to save the 
firmware to your local PC. The following steps are explained in the WINanalyse manual and 
in the update tool instructions.

Important information on updating your ARGUS firmware

- Never under any circumstances update ARGUS when it is operating in battery 
mode.

- Connect ARGUS to the power adapter before uploading the update file from the 
PC. 

- An ARGUS USB cable is required for updating (USB cable with mini-USB plug). 
- You should back up the configuration and measurement logs to a PC before 

performing an update. 
- Do not disconnect ARGUS from the PC during the update. 
- Do not switch off ARGUS during the update. 
- Be sure to observe the messages in the ARGUS display, and not just the 

instructions of the update tool on the PC. 
- The update is only complete when the update tool displays the corresponding 

message on the PC and ARGUS starts with the "normal" startup screen after 
being restarted by the update tool.

- ARGUS only powers back up when you click one of the two buttons ("Back to 
step 1" or "Exit program") at the end of the update. 

If problems occur because of a failure to follow these instructions, repeat the 
update process up to three times. Each repetition makes it possible to overwrite 
further faulty software components.

 
When connecting an ARGUS Copper Box, it can occur that ARGUS automatically 
initialises the Copper Box with the correct firmware in order to avoid compatibility 
issues. This can take a moment.
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27 Using the battery pack

Changing the battery pack
Power down ARGUS and disconnect the power adapter. Then release the knurled screw 
securing the battery pack.

Handling the battery pack 
ARGUS may only be operated using the battery pack supplied with the device; 
connecting other power supply units to the contacts of the device will damage 
ARGUS. 

- Only charge the supplied battery pack in ARGUS.

- Do not use the ARGUS battery pack in other devices.

- Active charging of the battery pack and automatic charging (on by default) may only 
be carried out in a temperature range of 0 °C to +40 °C. 

- Charge the battery pack completely at least once a month (even if the device has not 
been used for a longer period!).

- The lithium ion battery pack should be stored with a charge of  40 to 60 %. When 
storing the device for longer periods, you should refresh this charge level every six 
months. To prevent full discharge, remove the battery pack from the device for long-
term storage. 
To maximise battery life, do not store the battery long-term at temperatures above 
+50 °C.

- See the chapter Safety information (page 10) for detailed information on using and 
transporting the lithium ion battery pack safely.
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Status
ARGUS indicates the current state of the battery graphically in the display when no power 
adapter is connected. A battery symbol flashes in the display when it is down to a power 
reserve of approx. 8 minutes (depending not the operating mode). Tone errors, and in 
extreme cases malfunctions, can occur in this period. Connect the power adapter. ARGUS 
can recharge the battery completely when the power adapter is connected. The ARGUS 
power pack does not require manual discharge. A complete charging process can take up 
to approx. 6 hours.

ARGUS in Main Menu

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with . 
Connect the power adapter! 
Start the charging process. 
 
During the charging process, ARGUS 
displays the current status and the 
voltage.

 
Automatic battery charging in the background

ARGUS in Main Menu 

When ARGUS is in the selection list for 
preconfigured accesses, you can switch 

to the abbreviated main menu with .
 
ARGUS charges the battery automatically 
in the background when the mains 
adapter is connected as soon as the 
battery status falls below a threshold 
value (battery symbol in display) 
 

When ARGUS is disconnected from the power adapter before that battery is 
completely charged, ARGUS does not automatically continue charging when it is 
subsequently reconnected because the charge is no longer below the threshold.

<Charge> Starts the charging process.

Battery (status, charging)

Status

Battery (status, charging)

Automatic charging

on

ARGUS adopts this setting and switches to 
the next higher level menu.
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A) Hotkeys

Graphic functions:
After starting the xDSL interface or a test, like Line scope or TDR, you can use the following 

graphic functions in the result displays:

Hotkey xDSL trace ADSL/
VDSL Line Scope TDR

Legend - - -

- Zoom Zoom Zoom

Cursor Cursor Cursor Cursor

- - Measuring range Measuring range

- - Total power Pulse width/
height

- - - Wire type/VoP

- - Probe -

- - Symmetry -

- Setting of 
x-axis

Time/FFT -

- Min/Max Peak hold -

- - 100 Ohm input 
resistance

-

- Continue - -

- - Run/Hold Run/Hold

- - Reference curve Reference curve

- Store Store Store

Number key 1

Number key 2

Number key 3

Number key 4

Number key 5

Number key 6

Number key 7

Number key 8

Number key 9

Number key 0

Number key #

Press one after 
another 

 and 

Press one after 
another 

 and 
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Hotkey assignment
You can call important functions/tests directly using the keys of the ARGUS keypad. 
Depending on the selected access type (xDSL and Ethernet in this example), different  
hotkeys can be used:

Hotkey Service ADSL VDSL/
G.fast SHDSL ETH

ARGUS status x x x x
Hotkey help x x x x
IP ping x x x x
Traceroute x x x x
HTTP download x x x x
Test status x x x x
FTP download x x x x
QR-Code* x x x -
Copper Box x x x -
IPTV x x x x
 

Status screen
x x x x

 

VoIP call
x x x x

x x x x

Displays ARGUS-specific infor- 
mation such as ARGUS type, SW 
version, Serial number, own MAC 
addresses, SW options, user info 
(see next page).

x x x x

Number key 0
Number key 1
Number key 3
Number key 4
Number key 5
Number key 6
Number key 7

Number key 8
Number key 9

Press one after another 

 and  

Shortcut to access selection 
menu.

Press one after another 

 and 
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The ARGU info displays the ARGUS 
type, the software version, the serial 
number and more. The softkey „User 
info“ opens the entry menu, which 
you can use to store user-specific 
information.

<User info>  Entering user-specific 
                       information (see 
                       „Notices“ on page 37)

The user info can be up to 50 charac-
ters long. The entered user info is 
displayed in the ARGUS info below 
the serial number ARGUS/Copper 
Box.

<Inv:>   Entry of inventory number

The user can enter an inventory 
number.  This data is retained when 
ARGUS is reset to the factory 
defaults. 
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x x x x

x x x x

ARGUS saves the current  
measurement without stopping it. 
ARGUS automatically suggests a 
name.

x x x x

x x x x

x x x x

* You can only use this hotkey when the instrument is within the test parameters.

If a Copper Box was used on ARGUS for the last test, an additional softkey  
<Copper Box> appears, containing all information on the last connected ARGUS 
Copper Box. Once the Copper Box is started, the information page of the currently 
connected Copper Box is automatically displayed.

Press one after another 

 and 
Restores the saved test settings, 
see page 308.

Press one after another 

 and 
Resets all settings to the factory 
default, see page 309.

Press one after another 

 and 

Press one after another 

 and  Quick start of configuration import.

Press one after another 

 and  Quick start of cloud update. 
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Depending on the selected access type (ISDN, POTS and Copper tests in this example), 
different hotkeys can be used.

Hotkey Service BRI
S/T

BRI 
U

PRI POTS Cu tests
Status

x x x x x
x x x x x
x x x - -

x x x - -

x x x - -
x x x x x
x x x - -
x x x x -
x x x - -
x x L1

Status
x -

x x x x -

x x x x x

x x x x x

x x x x x

x x x x x

Opens Test Manager.

x x x - -

 

ARGUS saves the current measure-
ment without stopping it.

- - - - x

Number key 0 ARGUS status
Number key 1 Hotkey help
Number key 2 Start services test  

(not for fixed lines)
Number key 3 Test service features  

(not for fixed lines)
Number key 4 Starts an automatic test.
Number key 5 Sends test results to PC
Number key 6 Opens Test Manager
Number key 7 Opens saved numbers
Number key 9 Starts BERT

Level measurement

Connect

Press one after 
another 

 and  

Shortcut to access selection menu.

Press one after 
another 

 and 

Displays ARGUS-specific information, 
see S. 315.

Press one after 
another 

 and 

Restores the saved test settings, see 
page 308.

Press one after 
another 

 and 

Resets all settings to the factory 
default, see page 309.

Press one after 
another 

 and 

Press one after 
another 

 and 
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B) Symbols

The following symbols can  
be displayed in the ARGUS 
status line.

Symbol Colour Application Description
grey Accu This symbol shows the current battery status.

green varied This symbol means that you can use the Shift key to 
switch to the softkeys.

green varied This symbol shows that Shift is already engaged.

blue Cloud update The firmware can now be updated.

grey Cloud update The update function is active but no update can be 
found. For example due to an incorrect server path.

blue Configuration 
import

No configuration file found.

grey Configuration 
import

The configuration check is active but no configuration 
can be found. For example due to an incorrect server 
path.

grey varied Importing a configuration or executing a test.

green WLAN WLAN is active; ARGUS is currently in access point 
mode.

grey WLAN WLAN is not active.

grey Ethernet The management interface Ethernet is selected.

green Ethernet The management interface Ethernet is active.

grey Volume Signal tone deactivated.

grey Volume Signal tone activated.
ARGUS 166 319



28 Appendix
The following symbols can 
appear in the ARGUS main 
display area.

Symbol Colour Description
grey The service is not yet assigned to a virtual line.

grey This service, VL or physical layer is idle.

grey The service is unavailable.

yellow Activating the physical layer, VL or service.

yellow Physical layer, VL or service deactivated due to an unexpected occur-
rence.

yellow Deactivating.

green Synchronisation achieved (physical layer) or a VL or service was acti-
vated successfully.

green A test is currently running in this service.

red An error has occurred.

grey Preparing activation of physical layer, VL or service.

orange The Tx and Rx values are not equal in the VoIP QoS test.

green Test running.

red Test stopped.

green Active Probe is active and correctly supplied from ARGUS.
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green Graphs are zoomed.

white Graphs are not zoomed.

black Cursor is activated.

white Cursor is deactivated.

red A signal at the input (e.g. for line scope) is too high or the gain is set 
too high in the frequency range or time domain, s. page 263

The following symbols 
are displayed in this 
field.

Symbol Colour Description
green No CRC errors occurred in the final second.

red FEC errors occurred in the final second in upstream and downstream.

green / 
red

No Upstream CRC errors occurred in the final second in upstream.

red / 
green

No FEC errors occurred in the final second in downstream.

grey Retransmission configured but not active.

blue Retransmission working.

red Retransmission active.
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C) 

Negotiation err

Idle release

Time out rel

PPP: Echo req. 
error

Hanging up rel

Loopback erro

Authent. Error

PADO timeout

PADS timeout

Error message: PPP connection

ARGUS Display Description
External fault:

Cannot negotiate the network protocol for PPPD, so the remote 
site is not reachable.

Connection was terminated, since there was no activity.

Connection was terminated, since the maximum connection time 
elapsed.

Remote site did not answer echo requests so the connection has 
been terminated. (PPP connections are tested at regular intervals 
by sending echo requests to the remote site.)

Disconnected by remote site.

The setup of the PPP connection was cancelled, since a loopback 
was detected.

Authentication error: Wrong user name or password - rejected by 
remote site.

No PADO packets received.

No PADO packets received.
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D) Error message: Download test

Http redir.error

http: no response

Http serv.error

Http encod.error

Ftp open error

Ftp login error

Ftp passiv err.

Ftp rec. error

Network error

Ftp error

URL error

Socket error 2

Http Head.error

Ftp no file

Unknown address

Unknown download 
error

 

ARGUS Display Description
External fault:

Fault: Too many HTTP redirects.

No answer from HTTP server.

HTTP server has returned an error. 
(for details see the table below "HTTP Error Messages")

Due to an encoding problem, data transfer with HTTP is not 
possible.

Error when opening the FTP connection.

FTP login error. Wrong user name or password or anonymous 
login not supported.

FTP server does not support passive transmission mode.

FTP receive error.

Network error

General FTP error.

Fault: No HTTP or FTP URL specified.

Error when connecting a socket. The server's HTTP service is not 
available.

Error in the header of the requested HTTP file.

FTP download error: No such file or directory found.

Unknown host address. 
Possible cause: Error in the address entered, DNS resolution not 
working or network not accessible.

Unknown download error 
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E) HTTP status codes:

Display on 
ARGUS: 
Code No.

Meaning

100 Client should continue its request.

101 The protocol is being changed at the Client's request.

200 The Client's request has succeeded.

201 The Client's request that a new document be created was successful.

202 The Client's request has been accepted for processing.

203 The Client's request will be answered with information from a source 
other than the server.

204 The Client's request was successful. The server sends [no content] only 
the HTTP header.

205 The Client's request was successful. The server [resets content] sends a 
new HTTP body.

206 The Client's request was successful. The server sends only part of the 
requested document [partial content].

300 The request was not precise enough so multiple documents have been 
returned.

303 The requested resource has been found at a different URI and should be 
retrieved from there.

304 The requested document has not been changed in the interim.

305 The requested document must be retrieved from a proxy instead of from  
the server.

307 The requested resource has been temporarily relocated to a different 
URI [temporary redirect].

400 Syntax error in the Client's request [Client error].

401 The request requires user authentication.

402 Payment is required to process this request.

403 The Client's request has been refused. (e.g. because  
authentication failed.)

404 The requested document was not found (e.g. because of an error in the 
URL entered or while the document is no longer available).

405 The method specified by the Client in its request is not allowed by the 
server.

406 The requested document in a format that is not supported by the Client.

407 The request requires that the Client authenticate itself with a proxy.

408 The Client did not place its request within the time allowed by the server 
[Request Timeout].
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409 Due to a conflict (e.g.another request) the Client's request cannot be 
completed by the server.

410 The requested URL is [gone] no longer available on the server.

411 The Client sent data to the server without a defined Content Length.

412 The preconditions in the Client's request could not be satisfied by the 
server.

413 The Client's request has been refused by the server because the 
request entity is too large.

414 The Client sent a URL to the server that is too large  
(e.g. because of the form values contained).

415 The Client's data is not supported by the server.

416 The range (in a document) requested by the Client does not exist.

417 The server could not (or did not wish to) satisfy the Client's expectation 
given in the Expect request header field.

424 Due to a failed dependency, the requested document will not be sent by 
the server.

500 Due to an unexpected condition, the server cannot fulfill the Client's 
request (e.g. faulty configuration, missing or wrong CGI program).

501 The server does not support the function required to fulfill the Client's 
request.

502 The server received an invalid response from an upstream server or 
proxy which it accessed in attempting to fulfill the request.

503 The server is currently unable to handle the request due to a temporary 
overloading of the server.

504 The Client's request (of a gateway or proxy) did not receive a response 
within the specified time.

505 The server does not support the HTTP protocol version that was used in 
the Client's request.
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F) General Error Messages 

Prot. not supp.

Unknown error

No PPP connec.

Test aborted

Ping start error

Fault: PPP con-
nection

Unexp. PING end

 

Display on ARGUS Description
The protocol (IP, PPPoE, etc.) is not supported in the selected 
mode.

Unknown error occurred.

No PPP connection can be setup. 

Test aborted by user.

Error when starting the Ping test.

Unexpected termination of the PPP connection.

Unexpected termination of the Ping test.
326 ARGUS 166



28 Appendix
G) VoIP SIP status codes

 

SIP requests:

The six basic requests / methods:

INVITE Invite a user to a session (call - initiates a session)

ACK Acknowledge an INVITE request

BYE Terminate a session (hangup)

CANCEL Terminates the setup of a connection

REGISTER Provides data regarding subscriber availability (host name and IP address)

OPTIONS Supplies information regarding the functions supported by the other SIP 
telephone

SIP responses:

SIP responses are answers to SIP requests. There are six basic types of SIP responses 
with numerous sub-responses:

1xx Informational responses (180 indicates for example that the phone of the 
party called is ringing)

2xx Reports that the request has been successful

3xx Redirection responses

4xx Client failure responses

5xx Server failure responses

6xx Global failure responses

Display 
on 
ARGUS: 
Code No.

Meaning Explanation

100 Trying The ARGUS is attempting to setup a call.
180 Ringing The phone at the other end is ringing.
181 Call Being Forwarded The call is being forwarded.
182 Call Queued The call is in a wait loop.
183 Session Progress The call is being setup.
200 OK Everything is all right.
202 Accepted Connection has been accepted.
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300 Multiple Choices There is no unique destination address for 
the remote end. Please select one.

301 Moved Permanently Calls are being permanently forwarded.
302 Moved Temporarily Calls are being temporarily forwarded.
305 Use Proxy A proxy must be used.
380 Alternative Service Alternative service
400 Bad Request The request is not OK.
401 Unauthorized You are not authorized.
402 Payment Required Payment is required.
403 Forbidden This is not permitted.
404 Not Found The remote end was not found or does not 

exist.
405 Method Not Allowed The method (e.g. SUBSCRIBE or NOTIFY) 

is not permitted.
406 Not Acceptable The options used in the call are not 

supported.
407 Proxy Authentication Required The proxy must be authenticated.
408 Request Timeout The time for the request has been 

exceeded (timeout).
409 Conflict There is a conflict.
410 Gone The subscriber is no longer reachable here.
411 Length Required The length must be supplied.
413 Request Entity Too Large The values are too long.
414 Request URI Too Long The URI is too long. (Destination address)
415 Unsupported Media Type The codec is not supported.
416 Unsupported URI Scheme The URI scheme is not supported.  

(Destination address)
420 Bad Extension The extension is wrong.
421 Extension Required An extension is necessary.
423 Interval Too Brief There is a problem with the SIP 

parameters.  
(Register Expire is too short)

480 Temporarily Unavailable The subscriber is currently not reachable.
481 Call/Transaction Does Not Exist This connection does not exist (any longer).
482 Loop Detected A redirection loop has been detected.
483 Too Many Hops Too many redirects.
484 Address Incomplete The SIP address is incomplete or faulty.
485 Ambiguous The SIP address is not unique.
486 Busy Here The destination is busy.
487 Request Terminated The request has been terminated.
488 Not Acceptable Here The call cannot be accepted.
491 Request Pending A request is waiting.
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H) Vendor identification numbers

493 Undecipherable Decryption error.
500 Server Internal Error Internal error in the server.
501 Not Implemented The requested method (functionality) has 

not been implemented.
502 Bad Gateway The gateway is bad.
503 Service Unavailable The service is not available.
504 Server Time-Out The gateway did not respond in time.
505 Version Not Supported The SIP protocol version is not supported.
513 Message Too Large The message length is too long. Use TCP.
600 Busy Everywhere All terminals are busy at the remote end.
603 Declined The system at the remote end refused to 

accept the call.
604 Does Not Exist Anywhere This user does not exist any longer.
605 Not Acceptable SIP request not acceptable.

Abbreviation Manufacturer
ALCB Alcatel (STMicroelectronics)
ANDV Analog Devices
BDCM Broadcom
GSPN Globespan
IKNS Ikanos
IFTN Infineon
META Metanoia
STMI STMicroelectronics
TSTS Texas Instruments
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I) Software Licenses

The ARGUS firmware includes code from what are known as Open Source packages, 
which have been published under various licenses (GPL, LGPL, MIT, BSD, etc.).  
Additional information can be found – if requested in your order – on the CD-ROM included 
in the package (see Software_License.htm) or can be viewed at  
http://www.argus.info/web/download/Software_License. 
In the event that you are interested in the sources licensed under GPL or LGPL, please 
contact support@argus.info. A machine-readable copy of the source code can be obtained 
from intec Gesellschaft für Informationstechnik mbH for a minimal fee - to cover the cost of 
physically copying the code. This offer is valid for 3 years.
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J) Abbreviations
Characters

.bis Reference to SHDSL.bis (Enhanced SHDSL)
1TR6 Signalling protocol (D-channel protocol) for national ISDN of the former 

German national PPT (Bundespost)
2B1Q 2 binary 1 quaternary - line code
3PTY Three party service 
4B3T 4 binary 3 ternary - a modified monitored sum 43-code (MMS43)

Δf Bandwidth

Ω Ohm (electrical resistance)
A

A Ampere (electrical current)
A3K1H Audio 3.1 kHz
A7kHz Audio 7 kHz
AAL ATM adaptation layer
AC Alternating Current or Access Server
ADSL Asymmetric Digital Subscriber Line
Al Action indicator
AIT Application information table
AMP ARGUS measurement protocol
ANSI American National Standards Institute
Anx. Annex
AOC Advice of charge
AOC-D Advice of charge 

Charging information during the call 
AOC-E Advice of charge  

Charging information at the end of the call
APL ("Anschlusspunkt Linie") Service termination point
APN Access Point Name
ARP Access Point Name
AS Available second
ASCII American Standard Code for Information Interchange
ATM Asynchronous Transfer Mode
ATU-R ADSL Transceiver Unit 
Auto-MDI-X Automatic Medium Dependent Interface Crossing
Avg Average
AWG American Wire Gauge
AWS ("Anrufweiterschaltung") Call forwarding (1TR6)

B
BC Bearer capability
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BER 1. Basic Encoding Rules
2. Bit error rate

BERT Bit error rate test 
BGP Border Gateway Protocol
BR Bridge
BRAS Broadband access server
BRI Basic rate interface

C
C Celsius
c0 Speed of light
CALL PROC CALL PROCeeding message
CAT Conditional access table
CC Continuity counter
CCBS Completion of calls to busy subscriber
CCNR Call complete no response
CD Call deflection
CDN see also CDPN
CDPN CalleD party number 
CF Call forwarding 
CFB Call forwarding busy 
CFNR Call forwarding no reply 
CFU Call forwarding unconditional 
CGN see also CDPN
CGPN CallinG party number
CLIP 1. Calling Line Identification Presentation  

2. Clipping
CLIR Calling Line Identification Restriction
CNS CLIP-no screening
CO Central office 
Codec Coder decoder
COLP Connected Line Identification Presentation
COLR Connected Line Identification Presentation

CONN CONNect message
CONN ACK CONNect ACKnowledge message
CQE Conversational Quality Estimated
CR Call reference
CRC Cyclic redundancy check
CT Call transfer
CUG Closed user group 
CW Call waiting
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D
DAD Destination address (1TR6) 
dB Decibel
dBm/Hz Performance measurement with the reference quantity 1 mW (milliwatt) 

per hertz
DC Direct Current 
DCE Data communication equipment
DDI Direct dialling in 
DDM Digital diagnostic mode
DF Delay factor
DFU ("Datenfernübertragung") Remote data transmission
DHCP Dynamic Host Configuration Protocol
DiffServ Differentiated services
DIN Deutsches Institut für Normung - German Institute for Standardization
DISC DISConnect message
DL Download
DM ("Dienstmerkmal") Service
DMT Discrete Multitone Transmission
DNS Domain Name System
DPBO Downstream power backoff
DSCP Differentiated services codepoint
DS DownStream band
DSL Digital Subscriber Line
DSLAM Digital Subscriber Line Access Multiplexer
DSS1 Digital Subscriber Signalling System No. 1
DTE Data Terminal Equipment
DTMF Dual Tone Multi Frequency 
DTU Data Transmission Unit

E
E1 Primary Rate Interface
EAZ ("Endgeräteauswahlziffer") Local calling number (1TR6) 
EC European Community
ECT Explicit call transfer 
E-DSS1 European Digital Subscriber Signalling System Number 1
EFM Ethernet in the First Mile (see protocol IEEE 802.3ah)
EFS Error Free Seconds
EIT Event Information Table
ElektroG Elektro- und Elektronikgerätegesetz, German law governing electrical 

and electronic devices
EMC Electromagnetic compatibility
EN European standard
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EoA Ethernet over ATM
EOC Embedded operations channel
ES Errored seconds
ESHDSL Enhanced SHDSL (SHDSL.bis)
ete end-to-end 
ETH Ethernet
ETSI European Telecommunications Standards Institute

F
F Farad (unit of electrical capacitance)
Fax G3 Telefax group 3
Fax G4 Telefax group 4
FEC Forward error correction
FFT Fast Fourier transform
FSK Frequency shift keying 
FTP File Transfer Protocol
FV ("Festverbindung") leased line
FW Firmware

G
G.fast G.fast access to subscriber terminal
GB Gigabyte
Gbit/s Gigabits per second
GBG ("Geschlossene Benutzer Gruppe") Closed user group
G.hs ITU-T G.994.1 handshake procedure
GigE Gigabit Ethernet

H
h hour 
HD High definition
HDLC High-level data link control
HDSL High bit rate digital subscriber line
HEC Header error checksum
hex Hexadecimal
HLC High layer compatibility
HLOG Amplitude of transmission function per tone
HOLD Call hold 
HRX value Hypothetical reference value
HTTP Hypertext Transfer Protocol
HVT ("Hauptverteiler") Main distribution frame
Hz Hertz (measuring unit of frequency)

I
IAD Integrated access device
ID Identifier
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IEEE Institute of Electrical and Electronics Engineers
IGMP Internet Group Management Protocol
INFO INFOrmation Message
INP Impulse noise protection
IP Internet Protocol 
IPCP Internet Protocol Control Protocol
IPoA Internet Protocol over ATM
IPoE Internet Protocol over Ethernet
IPTV Internet Protocol Television
ISDN Integrated Services Digital Network 
ISO International Standards Organization
ISP Internet service provider
ITSP Internet telephony service provider
ITC Independent TC
ITU International Telecommunication Union

K
KB Kilobyte
KVZ ("Kabelverzweiger") Cable branch box
kbit/s Kilobits per second

L
L1 Layer 1 in the OSI reference model
L2 Layer 2 in the OSI reference model
L3 Layer 3 in the OSI reference model
LACP Link Aggregation Procedure for D-channels
LAN Local Area Network
LAPD Link access procedure for D-channels
LCD Liquid crystal display
LCN Logical channel number 
LCP Link Control Protocol
LED Light-emitting diode
LLC Low layer compatibility
LLPD Link Layer Discovery Protocol
LOS Loss of synchronize
LOSWS Loss of sync word seconds
LQ Line qualification
LQO Listening quality objective

M
m Meter
MAC Media Access Control
MB Megabyte
Mbit/s Megabits per second
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MCC Mobile Country Code
MCID Malicious call identification
MDF Main distribution frame (see also HVT)
MDI Media Delivery Index (RFC 4445)
min. Minute
MLR Media loss rate
MMS Microsoft Media Server Protocol
MNS Mobile Network Code
Modem Modulator-demodulator
MOS Mean opinion score (ITU-T P.800)
MPEG Moving Picture Experts Group
MSA Multiple source agreement
MTU Maximum Transmission Unit
mVpp Millivolt peak-to-peak

N
n/a not available
n/r not received
n/u not used
NAT Network address translation
NGN Next generation network
NIT Network information table
NOK Not OK 
NP Numbering plan
NSAP Network service access point
NSF Network specific facilities
NT Network termination
NTBA Network termination for ISDN basic rate access
NTR Network timing reference 

O
OAD Origination address (1TR6)
OAM Operation, Administration and Maintenance
OM Omni mode
OoS Out of Sequence
OSI Open Systems Interconnection
OUI Organizationally unique identifier 

P
P/N Part number
PABX Private automatic branch exchange
PADI PPPoE active discovery initiation
PADO PPPoE active discovery offer
PADR PPPoE active discovery request
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PADS PPPoE active discovery session confirmation
PADT PPPoE active discovery termination
PAM Pulse amplitude modulation
PAP Password Authentication Protocol
PAT Program association table
PC Personal computer
PCR Program clock reference
PD Protocol discriminator
PDU Protocol data unit
PE Polyethylene
PIC Plastic-insulated conductor
PID Packet identifier
PLR Packet loss ratio
PMT Program map tables
POTS Plain old telephone service (PSTN)
P-P Point-to-point
P-MP Point-to-multipoint
PMMS Power measurement modulation session
PMS Physical media specific
PP Polypropylene
PPP Point-to-Point Protocol
PPPoA Point-to-Point Protocol over ATM
PPPoE Point-to-Point Protocol over Ethernet
PPTP Point-to-Point Tunneling Protocol
PRI Primary rate interface
PSD Power spectral density
PSI Program specific information
PTFE Polytetrafluoroethylene
PWR Power

Q
Q in Q IEEE 802.1.ad, S-VLAN
QLN Quiet line noise
QoS Quality of service

R
RC Resistance (R) and capacitance (C)
REIN Repetitive electrical impulse noise 
REL RELease message
REL ACK RELease ACKnowledge message
REL COMPL RELease COMPLete message
RF Radio frequency
RFC Request for comments
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RJ Registered jack (standardised socket)
RoHS Restriction of Hazardous Substances
RT Router
RTCP Real-Time Control Protocol
RTP Real-Time Transport Protocol
RTSP Real-Time Streaming Protocol
Rx Received 

S
s second
S/N Serial number
SBC Session Border Controller - Outbound Proxy
SCI Sending complete indication
SDT Service description table
Segm. Segmented
SES Severely errored second
SFF Small form factor
SFP Small form factor pluggable
SHDSL Single-Pair High-speed Digital Subscriber Line
SHINE Single high impulse noise event 
SIN Service indicator (1TR6)
SIP Session Initiation Protocol
SNR Signal-to-noise ratio
SPB Shortest Path Bridging
SNRM Signal-to-Noise ratio margin
Spch Speech 
SRU SHDSL regeneration unit 
SRV Service record
SSL Secure Sockets Layer 
STB Set-top box
STU-C SHDSL Transceiver Unit - Central Office
STU-R ADSL Transceiver Unit - Remote
STUN Session Traversal Utilities for NAT
SUB Subaddressing 
SUSP SUSPend message 

T
T Trigger
TAC Type Approval Code
TAL ("Teilnehmeranschlussleitung") Subscriber line
TC 1. Trellis code 

2. Transmission convergence
TCP Transmission Control Protocol
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TC-PAM Trellis-coded pulse amplitude modulation
TDM Time division multiplex
TDR Time domain reflectometry
TDT Time and date table
TE TErminal, terminal equipment
TEI Terminal endpoint identifier
Tel31 Telephony 3.1 kHz
Tel7k Telephony 7 kHz
TLS Transport Layer Security 
TM Test manager
ToN Type of Number
ToS Type of service
TP Terminal portability 
TPID Tag Protocol Identifier
TS 1. Technical specification  

2. Transport stream
TTX Teletext
Tx Transceived 

U
UDP User Datagram Protocol
UL Upload
URI Uniform Resource Identifier
URL Uniform Resource Locator
US VDSL: Upstream band or  

SHDSL: Unavailable second
USB Universal Serial Bus
UTC Coordinated Universal Time 
UUI User-user info
UUS User-to-user signalling 

V
V Volt
V/2 Pulse propagation time
VC Virtual channel
VCC 1. Virtual channel connection 

2. Voltage at the common collector
VCI Virtual channel identifier
VC-MUX Virtual circuit multiplexing
VDSL Very High Speed Digital Subscriber Line
ViSyB Video syntax-based
ViTel Video telephony
VLAN Virtual Local Area Network
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VL Virtual line
VLC Video LAN client
VNC Virtual Network Computing 
VoD Video on demand
VoIP Voice over Internet Protocol
VoP Velocity of propagation 
VPI Virtual path identifier
Vpp Volt peak-to-peak 
VTU-R VDSL transceiver unit

W
WAN Wide Area Network
WEEE Waste Electrical and Electronic Equipment
www World Wide Web

X
xDSL Collective term for the different DSL variants
xTU-C xDSL Transceiver Unit - Central Office
xTU-R xDSL Transceiver Unit

Z
Z Apparent resistance
ZWR See SRU
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